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1. Introduction
Usage Guide and Reference Handbook for CircuitCAM version 7.5
CircuitCAM is a software application for computer aided manufacturing (CAM) of printed cir-
cuit boards (PCB). The main functionalities are:

n Importing of CAM files generated by PCB CAD systems.

n Verification and design checks of the imported data.

l Modifying the layout data for manufacturing purposes.

l Generating tool paths for NC machines, including drilling, milling, laser cutting and
structuring.

l Exporting of CAM files.
CircuitCAM is available in five different variants, optimized for different purposes:

l CircuitCAM VIEWER for viewing CAM files generated by CircuitCAM.

l CircuitCAM BASIC with all typical CAM functionalities for milling and drilling
including insulate.

l CircuitCAM STANDARD with full flexible CAM functionalities, including Laser
structuring and cutting.

l CircuitCAM PRO with all the functionalities of CircuitCAM STANDARD plus the
ability to modify and analyse big sets of data, including extensive library functionality.

l CircuitCAM Laser Plus with all the functionalities of CircuitCAM PRO in addition to
Laser Fill, Laser Insulate, Striping and Stripping.

Category Feature
Viewe-
r

Basi-
c

Stand-
ard

Pr-
o

Lase-
r
Plus

CAM files
Open x x x x x
Save - x x x x

Import
Gerber x x x x x
GerberX x x x x x
Excellon/Sieb&Meyer x x x x x
LMD x x x x x
HP-GL x x x x x
DXF x x x x x
Barco DPF - x x x x
ODB++ - x x x x

Export
Gerber - x x x x
Excellon - x x x x
LMD - x x x x
HP-GL - x x x x
G-Code - x x x x
GerberX - x x x x
HP-GL with Pen Width - x x x x
DXF - x x x x
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Category Feature
Viewe-
r

Basi-
c

Stand-
ard

Pr-
o

Lase-
r
Plus

Barco DPF - x x x x
Postscript - x x x x
List of Sub-Layout Instances - - - x x

Special
DataMatrix - x x x x
PCB DRC - x x x x
QR-Code - x x x x
Stencil DRC - - - x x

Editing
Editing of Primitives and Flashes - x x x x
Multi level Undo/Redo - x x x x
CSG (Set Operations) - x x x x
Polygon with Cutouts - x x x x
Convert to Flash & Comparison - x x x x
Draw to Flash - x x x x
Denest Flash - x x x x
Create Outline - x x x x
Step&Repeat - x x x x
Create Bounding Shape - x x x x
Shape Manipulations - x x x x
Sub-Layout instances - - - x x
Geometric Manipulation Centre (GMC) - - - x x

Tool Path
Insulation Milling - x x x x
Contour Routing - x x x x
Base Material & Fixture - x x x x
Tool compensation - x x x x
Swap & Sequence - x x x x
Sorting / path optimization - x x x x
NC Mode - x x x x
Configurable Toolpath Engine (Universal /
Laser / Milling / Drilling) - - x x x

Laser Fill - - x x x
Laser Insulate - - x x x
Scanner Fields - - x x x
SMT Stencil calculation - - - x x
SMT Stencil Frame Generator - - - x x
Striping & Stripping - - - - x

Library
Create Package - - - x x
Create Footprint - - - x x
Package Recognition - - - x x
GMC Exchange - - - x x
Apply Footprints - - - x x
Import Library - - - x x
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Figure 1. The current installed variant of CircuitCAM is displayed in the title bar.
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Installation and Registration
CircuitCAM installation provides instructions on how to prepare and install CircuitCAM.

1.1. System Requirements
First of all you have to ensure, that your machine meets the minimum system requirements to
avoid problems during installation, or in your future work with CircuitCAM.
Minimum system requirements for installing and using CircuitCAM are:

Operating Systems

n Microsoft™ Windows® XP
n Microsoft™ Windows® Vista
n Microsoft™ Windows® 7
n Microsoft™ Windows® 8
n Microsoft™ Windows® 10

Memory
512MB of RAM (1 GB recommended)

Display resolution
1024 x 768 with True Color

Hard disk
Installation requires 50MB of free disk space

1.2. Installation
Follow this routine to start your installation:

l Navigate to the installer file setup.exe on your machine.

l Double click on the file icon to begin the Setup program.

l Follow the instructions in the setup program.

Note: Use Cancel button to close the dialogue window and cancel the installation.

Installation Folder

The installation folder is the folder where CircuitCAM application is installed. By default Cir-
cuitCAM is installed under C:\Program Files\CircuitCAM7 or C:\Program Files (x86)\Ci-
rcuitCAM7 (if you are using an x64 operating system). The following sub-folders will be
created in the CircuitCAM sub-folder:

l Ape_Templates contains translation files, which are used to import aperture and tool
lists.

l Example data contains CircuitCAM input and output data files. This is the default direc-
tory in which all newly created data are stored.

l img contains images, which are used to describe predefined scripts functionality.

l Libraries contains package libraries, which are used for replacing pad shapes.

l NC contains files, which are used to prepare CAM data for concrete NC machine.

l New_Templates contains template files for CircuitCAM. To view the list of available
templates, select File -> New menu item.

(20)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

l Translations contains language localization files (for different languages user inter-
face).

You can modify those directories in the General Settings window.

Note: Stored settings directories cannot be changed.

Running CircuitCAM

To start CircuitCAM application, press on the CircuitCAM program group in the Windows®
Start menu.

Note: You can start CircuitCAM via the shortcut on your computer's desktop, or you can
navigate to the installation folder and double click on the CircuitCAM.exe.

1.3. Registration and Activation
After CircuitCAM has started, the CircuitCAM Activation Wizard pops up on the screen:

Figure 2. CircuitCAM Activation Wizard
If you have a licence ID, you have to enter it in the bottom field. Otherwise, you can only use
the Viewer variant and leave the "Licence ID" field empty.
Starting with version CircuitCAM 7.3 it is possible to use the licence in different modes: either
floating or for limited time or for unlimited time on one computer. All CircuitCAM licences are
single computer licences, which means that they can be used on one computer only. However
as long as a CircuitCAM licence is covered under a maintenance contract the licence can be
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used on more than one computer, but only on one computer at a time. Once the maintenance
period is expired the licence can only be used on one computer.
Activation of a CircuitCAM licence requires an internet connection. When CircuitCAM is able
to directly access the internet, the user can go for the so-called Online registration, that also is
required for the floating mode. Otherwise user can do the activation through a web browser on
another computer using the so-called Offline registration.

l The floating mode is the default one and allows to use the licence dynamically on dif-
ferent computers, e.g.: the licence can be used in the morning on a desktop computer
and in the afternoon on a mobile computer. The user does not need to say in advance
how long he wants to use the licence on one computer. The floating mode can only be
used with permanent internet access, because communication with the CircuitCAM
licence server is needed. After closing CircuitCAM on one computer, it may take up to
15 minutes till the licence can be used on another computer. If internet becomes unavail-
able for more than 10 minutes, CircuitCAM stops working and the user can only save
the current state in a CAM file.

l If the licence is needed on one computer for a limited time without permanent internet
access (e.g.: during travel), user can request the licence for this computer for a spec-
ified time, which may last just hours or a few days. This is enable by the mode "Until
specified time..." which requires the specification of an end time when the licence is no
longer needed on this computer. Once this mode is chosen, the time can be extended, but
not shortened. During the occupied time the licence cannot be used on another computer.
The time is entered and displayed in the local time zone which is set up by the Windows
system. Note: the time that is shown in the "About" dialog box is provided in Coor-
dinated Universal Time (UTC).

l Once the maintenance mode is expired, the user can choose the last option "For unlim-
ited or maximum licence time...". A further usage of the licence on another computer is
then no longer possible. Therefore it is recommended to use this option only as last
resource.

For the registration follow this sequence:

l Click on the User name text field and enter your full name.

l Click on the Organization text field and enter your organization name.

l Click on the Location text field and enter the address of your organization.

l Select the licence mode: Viewer, Floating, Limited time, Unlimited/maximum time.

l Click on the Licence ID field and enter the identifier key of your CircuitCAM licence
(not for Viewer).

l Click on the Next button to open the next window of the activation wizard.

1.3.1. Online Registration
The default registration method is Online registration. To select this option, your computer
must be connected to the Internet. CircuitCAM will connect to the licence server and will reg-
ister your licence automatically. This is the default and simplest way.
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Figure 3. CircuitCAM Activation Wizard, Online activation

l Click on the Online selection button (see Figure above).

l Click on the Next button to continue the activation. The new activation wizard window
appears on the screen (see Figure below).
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Figure 4. CircuitCAM Activation Wizard, to setup connection

Note: Make sure you are connected to the Internet.

l Click on the Next button to continue the activation. CircuitCAM sets up a connection to
the licence server.
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Figure 5. CircuitCAM Activation Wizard, connection to server and data transferring

Note: Do not interrupt data transferring.

The activated CircuitCAM version is identified and displayed in the wizard window (see Fig-
ure below).
After CircuitCAM was successfully registered, you can terminate the activation window by
clicking the Finish button.
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Figure 6. CircuitCAM Activation wizard, completed activation with activated CircuitCAM
version

1.3.2. Offline Registration

Note: If your computer is not connected to the Internet, you can use offline activation
method.
For the offline activation you will need a licence file licence.lic, this file should be obtained
from DCT by offline registration.
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Figure 7. CircuitCAM Activation Wizard, Offline registration, 1st step

l Click on the Offline 1st step selection button.

l Click on the Next button.
CircuitCAM will generate an HTML file. You have to transfer this file to another computer,
which is connected to the Internet. This registration will be done from that computer.
The new CircuitCAM Activation Wizard window appears (see Figure below) to select
HTML file location:
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Figure 8. CircuitCAM Activation Wizard, Offline registration, to save HTML file

l Click on the lookup button next to the text field and select the location of the HTML file
on your hard drive. After the location is determined, the path is displayed in the text
field.

l Click on the Next button. A new window of the activation wizard appears on the screen,
which displays a path to the created HTML file (see Figure below):
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Figure 9. CircuitCAM Activation Wizard, creation of HTML file

l Click on the Finish button.

l Copy the recently created HTML file and paste it to a computer, which has an active
Internet connection.

l Double click on the file to open it in the default browser (see Figure below).
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Figure 10. CircuitCAM registration page in browser window

l Fill in your information as required.

l Press on the Request licence file button to send registration data to the licence server
and request for a licence file.

l Save the activation file in a desired directory. You have done the registration on this
computer.

l Copy the file to the machine with the CircuitCAM software installed on.

l Open the Help menu and select the Activate Product menu item. The CircuitCAM
Activation Wizard page appears on the screen.

l Click on Next button to go to the offline activation page.

l Click on the Offline 2nd step selection button to activate your licence (see Figure
below).

Figure 11. CircuitCAM Activation Wizard, Offline activation, 2nd step

l Click on the Next button to continue licence activation. A new wizard window appears
(see Figure below).
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Figure 12. CircuitCAM Activation Wizard, to specify location of licence file

l Click on the lookup button next to the text field.

l Select the directory, where the licence.lic file is located.

l Click on the Next button.
The registration file is copied to the program directory and activates the software version. The
activated CircuitCAM version is identified in the wizard window.

1.4. User Settings
Users have the possibility to change the CircuitCAM user data and the location of directories
for the translation and template files. To do this, navigate to the menu; Settings ---> General
Settings. The General Settings window appears on the screen. Information, about the user,
organization and address, which was entered during registration process, can be edited in the
User Information page. Select the User Information branch in the tree on the left to activate
the particular page (see Figure below).
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Figure 13. General Settings, User Information

You can change your personal data:

l Click on the User field to edit the existing data.

l Click on the Organization field to edit the existing data.

l Click on the Location field to edit the existing data.

l Click on the arrow next to the Language field to see a list of available languages. Select
an applicable item in the drop down list.

l Click on the OK button to confirm your changes.

Note: The licence ID field is read only and can not be edited.

1.5. About dialog box
Essential info about the current licence is displayed in "About" dialog box(from main menu
"Help"->"About CircuitCAM...)"

Note:the licence information indicates on wether the licence is timely limited or unlim-
ited.
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2. Usage Guide
The purpose of this manual is to introduce the user how to use CircuitCAM for Windows™. It
explains how to import CAM files generated by PCB CAD systems, verify and check the
design of the imported data, modify the layout data for manufacturing purposes, export CAM
files.
In addition, the user can find more information about; what are the main user interface ele-
ments and be guided through the basic features of CircuitCAM via exercises.
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2.1. Import PCB Layout

2.1.1. Default Template File (default_insulate.cat)
With the installation of CircuitCAM, the default template file default_insulate.cat is installed
with the content. This contents of this file are explained on this page.
For more information how to create a template file see Create CircuitCAM template file.

Predefined Layers

When you start CircuitCAM the specified set of layers included in the template file "default_
insulate.cat" will be presented in the Layers view:

Layer name Use
Fiducial Little target registration marks
TopLayer Layout component side
BottomLayer Layout solder side
DrillPlated Holes (through plated)
DrillUnplated Holes (without plating)
BoardOutline Circuit board outline
TextTop Text for component side
TextBottom Text for solder side
CuttingOutside Contour milling outside
CuttingInside Contour milling inside
SolderMaskTop Solder resist mask component side
SolderMaskBottom Solder resist mask solder side
SolderPasteTop Solder paste component side
SolderPasteBottom Solder paste solder side
SilkScreenTop Component printing on component side
SilkScreenBottom Component printing on solder side
RuboutTop Rubout area on component side
RuboutBottom Rubout area on solder side
RuboutAllLayer Rubout area on all layers
FrameTop Frame on component side
FrameBottom Frame on solder side
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FrameAllLayer Frame on all layers
InsulateTop_Primary Primary insulation channels on the component side
InsulateTop_Small Small insulation channels on the component side
InsulateTop_Big Big insulation channels on the component side
InsulateTop_Bigger Bigger insulation channels on the component side
InsulateBottom_Primary Primary insulation channels on the solder side
InsulateBottom_Small Small insulation channels on the solder side
InsulateBottom_Big Big insulation channels on the solder side
InsulateBottom_Bigger Bigger insulation channels on the solder side
TopInsulate Tool path for insulation milling on the component side
BottomInsulate Tool path for insulation milling on the solder side
Layer2 Layout Multilayer 2
Layer3 Layout Multilayer 3
Layer4 Layout Multilayer 4
Layer5 Layout Multilayer 5

According to IEC 1182-1 and IPC D-350 the physical layer on the primary side, which is the
one in default viewing direction, is numbered as layer 1. For CircuitCAM the TopLayer is the
primary physical layer and this is displayed in normal way. The BottomLayer is the layer with
the highest physical layer number and it is displayed in mirrored way. So for machining the
BottomLayer from the bottom side the tool-paths must be mirrored.

Note: CircuitCAM provides predefined jobs for the above layers, so keep to these names
of layers.

Predefined Tools

LMD contains the list of tools, needed for milling and drilling operations.
Gerber contains the default Gerber list of tools.
HP-GL contains the default HP-GL list of tools

Predefined Jobs

Insulation jobs with up to 4 tools:

n Insulate_Top_Primary,

n Insulate_Top_Big_Primary,

n Insulate_Top_Primary_Small,

n Insulate_Top_Bigger_Big_Primary,

n Insulate_Top_Big_Primary_Small,

n Insulate_Top_Bigger_Big_Primary_Small,

n Insulate_Bottom_Primary,

n Insulate_Bottom_Big_Primary,

n Insulate_Bottom_Bigger_Big_Primary,

n Insulate_Bottom_Big_Primary_Small,

n Insulate_Bottom_Bigger_Big_Primary_Small.
Insulation jobs with up to 4 tools for defined rubout area:
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n Insulate_Top_Rubout_Primary,

n Insulate_Top_Rubout_Big_Primary,

n Insulate_Top_Rubout_Primary_Small,

n Insulate_Top_Rubout_Bigger_Big_Primary,

n Insulate_Top_Rubout_Big_Primary_Small,

n Insulate_Top_Rubout_Bigger_Big_Primary_Small,

n Insulate_Bottom_Rubout_Primary,

n Insulate_Bottom_Rubout_Big_Primary,

n Insulate_Bottom_Rubout_Bigger_Big_Primary,

n Insulate_Bottom_Rubout_Big_Primary_Small,

n Insulate_Bottom_Rubout_Bigger_Big_Primary_Small.

Predefined Libraries

The BGA-default library contains all typical BGA packages, needed for Package recognition.
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2.1.2. Tutor example
In the following sections of this manual, you will find an explanation of basic CircuitCAM func-
tions, working through examples.

"Tutor" sample circuit board

The circuit board, which will be used in exercises: double-sided PCB with conventional and
SMD components, where SMD components are located on the solder side of the circuit board
(PCB bottom face).
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Figure 14. PCB top and bottom faces

Figure 15. PCB component side on the left side (default color: red) and PCB solder side
on the right (default color: green)

Example files

The example files for the exercises you will find in the CircuitCAM installation directory (i.e.
"Program Files (x86)\CircuitCAM\"). The following files should appear:
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..\Ape_Templates\ folder
TutorApe.TXT Translation file for the aperture lists
TutorTools.TXT Translation file for the tool lists

..\ExampleData\Prototyping\ folder
Tutor.cam CAM data, CircuitCAM format. It is the result of import.
Tutor.nct Tool list for Excellon data
Tutor.whl Aperture list for Gerber data

Layers are aligned
— Tutor1.cmp Gerber data for the component side
— Tutor1.drl Excellon data
— Tutor1.sld Gerber data for the solder side

Layer has offset
— Tutor2.cmp Gerber data for the component side
— Tutor2.drl Excellon data with offset to the Gerber data
— Tutor2.sld Gerber data for the solder side

Layer is rotated
— Tutor3.cmp Gerber data for the component side
— Tutor3.drl Excellon data rotated 90 degrees against the Gerber data
— Tutor3.sld Gerber data for the solder side

Layer is mirrored
— Tutor4.cmp Gerber data for the component side
— Tutor4.drl Excellon data
— Tutor4.sld Gerber data for the solder side mirrored

Extended Gerber
— Tutor.top Extended Gerber data for the component side
— Tutor.bot Extended Gerber data for the solder side
— Tutor.drd Excellon data

2.1.3. Open sample circuit board
In this exercise, use the document based on the template file "Default". This document opens
automatically after CircuitCAM starts.
How to create a new CircuitCAM document:

l Start CircuitCAM. The "Untitled1" document is opened.

l Select in the main menu File -> Save As. The Save As dialogue window appears on
the screen.

l Enter the file name Tutor1 into the File name field.

l Click on Save button to save document as a file with a name "Tutor1.cam". The file
extension ".cam" is appended to the file name automatically.
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Note: To abort the operation and close the dialogue window, click on Cancel button or
press ESC key.

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved.

2.1.4. Import Production Data
The following steps will guide you through the import of production data, which are generated
by various CAD programs, into CircuitCAM.
In this exercise we have the following:

l Aperture and tool lists with corresponding definitions;

l Circuit board data for the Component side in Gerber format;

l Circuit board data for the Solder side in Gerber format.

l Drilling data in Excellon format.
How to import production data:

l Select in the main menu File -> Import... or click on in the Standard toolbar. The
Select files for import dialogue window appears on the screen.

Figure 16. Select files for import dialogue window

l Navigate to the folder with the example files.

l Press and hold down the CTRL key and click on files Tutor.nct, Tutor.whl, Tutor1.cmp,
Tutor1.drl and Tutor1.sld.
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Note. Gerber and Excellon files miss the extended information and therefore we need the
aperture (Tutor.whl) and tool (Tutor.nct) files . They are not standard, so we need a special
Template files (i.e. "TutorApe.txt" and "TutorTools.txt") to decode the information. For more
information see Aperture Template Editor.

l Click on Open button.
The Import dialogue window appears on the screen.

Figure 17. Import dialogue window: 1-list of imported files; 2-Graphic, Text and Aper-
tures panels; 3-Attribute panel

CircuitCAM analysed the selected files and sorted the file list (1) into the following order:

1. Aperture list

2. Gerber files

3. Tools list

4. Excellon file.

Aperture List

How to assign translation file for aperture list:
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l Select Tutor.whl in the File Name of the Import window (1st section).

l Click on the Layer/Template field and select a translation file for the aperture list Tuto-
rApe.TXT.

Figure 18. Select translation file for aperture list
How to check the translation results:

l Click on the Text tab to activate the panel. You can see that the aperture D10 is defined
as a circle with a diameter 0.2 mm (see Figure below).

l Inspect all apertures, if the conversation results are correct.

Figure 19. Text panel with translation results

Assignments for Gerber Files

How to assign layers for Gerber files:

l Select Tutor1.cmp file in the File Name field. This file contains the data for the com-
ponent side of the circuit board.
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Figure 20. Gerber file content, circuit board component side

l Click on the Layer/Template field an select TopLayer in the drop down list. The com-
ponent side of the circuit board is assigned to the TopLayer (see Figure below).
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Figure 21. Component side is defined as TopLayer

l Select Tutor1.sld in the File Name field. This Gerber file contains the data for the
solder side of the circuit board.
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Figure 22. Gerber file content, circuit board solder side (mirror presentation)

l Click on the Layer/Template field an select BottomLayer in the drop down list. The
solder side of the circuit board is assigned to the BottomLayer (see Figure below).
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Figure 23. Solder side is defined as BottomLayer

Note. You can import data without defining the layer. The file name will be treated as a
layer name. You can assign layers after the import is completed.

Tool List

How to assign translation file for a tool list:
l Select Tutor.nct file in the File Name field. The file contains the list of tools, which are
displayed in the Apertures panel (2nd section). The tool list contains three tools.
Check, if the individual diameter of each tool satisfy your requirements. In our example,
diameters are too large (see Apertures panel, column a). That means, that not correct
translation file for the tool list is used.
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Figure 24. Contents of tool list in Apertures panel

l Click on the Layer/Template field and select a translation file for the tool list Tutor-
Tools.TXT. Now the selected translation file produces the desired results.
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Figure 25. Selected translation file and tool list with parameters in Apertures panel

Assignments for Excellon Files (drills)

How to assign layer to Excellon file:

l Select Tutor1.drl in the File Name field. The translation result is previewed in the
Graphic panel.
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Figure 26. Graphic view content of selected Excellon file

l Click on the Layer/Template field an select DrillPlated in the drop down list. The
holes of Excellon file are assigned to the DrillPlated layer.

Figure 27. Select DrillPlated layer

Note: In our example the circuit board is two-sided, thus holes are plated through. In case
of single-sided board, the DrillUnplated layer should be used.
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Note: In some cases the formatting parameters for holes can be not correct (see Figure
below): holes overlap and the dimensions (red square), which appear in the Format/Size field
do not correspond to the ones for Gerber files (green square).

Figure 28. Overlapping holes in Graphic view
To fix dimensions, the dimensions on the graphic should be multiplied by approximately 10. To
change the dimension size by 10, move the decimal place.
How to change format parameters for Excellon file:

l Click on the arrow next to the decimal places field under the Digits in the Format
panel.

l Select the value 2. The dimensions of the graphic are changed and holes do not overlap.
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Figure 29. Graphic view with correct format parameters

All changes are made in the Import dialogue window.

l Click on OK button to import selected files.
CircuitCAM displays imported product data.

(50)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Figure 30. CircuitCAM displays imported product data

Save your data! (under Tutor1.cam name).
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2.1.5. Import Extended Gerber Data
To import Extended Gerber files, you do not need to specify aperture/tools list or template file.
All needed information is included in the Extended Gerber file.
In our example we will introduce, how to import the following Extended Gerber format files:

n Tutor.top

n Tutor.bot

n Tutor.drd

Note: Open a new document.
How to import Extended Gerber production data:

n Select in the main menu File -> Import or click on in the Standard toolbar. The
Select files for import dialogue window appears on the screen.

n Navigate to the folder with the example files.

n Press and hold down the CTRL key and click on files Tutor.top, Tutor.bot, Tutor.drd.
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Note: You can see, that we do not specify any additional aperture/tool lists, because the
needed lists are already included in the Extended Gerber files.

l Click on Open button. The Import dialogue window appears on the screen.

Figure 31. Import dialogue window with Extended Gerber files list
Now let's assign layers

l Select Tutor.bot file in the list to assign layer for a solder side of the circuit board.

l Click on the Layer/Template field an select BottomLayer in the drop down list.

l Select Tutor.top file in the list to assign layer for a component side of the circuit board.

l Click on the Layer/Template field an select TopLayer in the drop down list.

l Select Tutor.drd file in the list to assign layer for drills.

l Click on the Layer/Template field an select DrillPlated in the drop down list.
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Figure 32. Import dialogue window with graphic view of drill file content

l In the Format panel, Digits layout, set n value to 3 to set a right size for drill data.
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Figure 33. Import dialogue window with prepared Extended Gerber data for import

l Click on the OK button.
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Figure 34. CircuitCAM window with imported Extended Gerber production data

Note: You can save the document (i.e.: under Tutor6.cam name).
Close the current file, because we will not use these data in further examples.
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2.1.6. Save Data
To save modified production data:

l Select in the main menu File -> Save. In case the first save action, the Save as dia-
logue window appears on the screen.

l Specify the name into the File name field and click on Save button.
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2.2. Prepare PCB Layout

2.2.1. Change Order of Layers
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After product data are imported to CircuitCAM, they are located on the specified layers. In
case the order of layers does not satisfy your requirements (i.e.:, some layers are not visible),
you may change the order of layers.

Figure 35. Objects of active DrillPlated layer are not visible in Graphic view

To change the order of layers:

l Press with a mouse on the layer name in the Layers panel.

l Hold and drag the layer to the desired position (up or down). In our example drag up.
While dragging, the red line indicates where the layer could be placed.

Figure 36. Dragging of DrillPlated layer over TopLayer

l Release the mouse button, when the layer is in the desired position. The order of the
selected layer is changed (see Order cell). Components of the selected layer appear in
the Graphic view.
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Figure 37. Components of DrillPlated layer are displayed in Graphic view (light blue
color)

You can also change the order of the selected layer by using tool bar buttons:

l Press on button to turn the Order Arrangement Mode On.

l Use arrow buttons Move up and Move down to locate the selected layer.
To make the selected layer on the very top of the list - double click on the Order cell.
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2.2.2. Move Layer
The production data presented in the previous example, represents an ideal case.
Usually production data not match because of different data origins.
CircuitCAM helps you to correct production data according your needs.
Lets' import not ideally matching production data and try to correct them:

n Open a new document, based on default_insulate.cat template file, i.e.: select in the
main menu File -> New -> default.

n Import the following production data from the "..\ExampleData\Prototyping\" sub-
directory:

n Tutor2.cmp

n Tutor2.sld

n Tutor2.drl

n Tutor.whl

n Tutor.nct
For "Tutor.nct" file Layer / Template transition file must be changed into "ToturTools.TXT".
This file will load the new aperture tool size.
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Figure 38. Layer / Template is changed to ToturTools.TXT for changing aperture tool
size.

Imported production data appear in CircuitCAM window.

Note: Save data under "Tutor5.cam" file name.
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Figure 39. Circuit board graphic view
In this example Excellon data do not coincide with Gerber data.

How to make layers coincide, move to correct position:

n Click on Match up Layers button in the Layer tool bar.

Note: You have to select a significant object, which is present on both layers. A sig-
nificant object may be a drill hole (1) and the associated pad (2). Both graphic objects have a
centre coordinate, which clearly defines a position.

Figure 40. Moving layer

l Click on the lower hole on the DrillPlated layer (1) to select it.

l Move mouse to another selection point . You can see the line, which stretches from the
previously selected point (1).

l Click on the upper pad on the TopLayer (2) to select it.
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The layer DrillPlated moves to the correct position. The layers DrillPlated and TopLayer coin-
cide now.
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2.2.3. Rotate Layer
In this example we will show, how to correct data, when the Excellon file includes data,
which are an offset against Gerber data and rotated by 90°.

n Open a new document, based on the "default_insulate.cat" template file. Select in the
main menu FILE -> New -> default_insulate.

n Import the following production data from the "..\ExampleData\Prototyping\" sub-
directory:

n Tutor3.cmp

n Tutor3.sld

n Tutor3.drl

n Tutor.whl

n Tutor.nct
For "Tutor.nct" file Layer / Template transition file must be changed into "Totur-
Tools.TXT". This file will load the new aperture tool size.
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Figure 41. Layer / Template is changed to ToturTools.TXT for changing
aperture tool size.

Imported production data appear in CircuitCAM window. To correct data, we have to rotate the
DrillPlated layer holes and match up with a TopLayer.

Note: Save data under "Tutor7.cam" file name.

Figure 42. Circuit board graphic view
How to rotate layer:
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Note: A selected object always rotates around the anchor point.

n Click on the drill hole at the bottom right to set an anchor point.

Figure 43. Select hole (set anchor point)
The selected drill hole is a reference point around which the layer should be rotated. The
active layer DrillPlated is highlighted in the Layers panel.

n Click on the Select Layer button in the Select toolbar to select all objects on the Drill-
Plated layer.

Figure 44. Active layer in Layers view and Select Layer button in Select tool bar

n Click on the 270° button in Rotate Relative to rotate the currently selected layer by 270°
anticlockwise.

(62)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Figure 45. Rotate layer 270° around anchor point
The Excellon data is aligned in the same way as Gerber data, but still has an offset.

Figure 46. Rotated layer

n Use the Match up Layers button to coincide DrillPlated and TopLayer, as described
in the previous example.
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2.2.4. Move Board Outline to Separate Layer
In our sample circuit board TUTOR, the outline of the circuit board is located on the solder
and component side (electrical layer). It is advisable to place the circuit board outline on a sep-
arate mechanical layer.
Let's select the circuit board outline on the component side (TopLayer) and move it to the
BoardOutline layer.
How to select circuit board outline on the TopLayer:

l Double click on the Selectable cell of the TopLayer entry. All layers, except the
TopLayer, are made Not Selectable. It will be easier to select the outline of the cir-
cuit board on the TopLayer in the Graphic view.

Figure 47. All layer, excluding TopLayer, are reset to Not selectable mode
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l Click on the upper left corner of the circuit board outline in the Graphic view.

Figure 48. Graphic view with selected circuit board outline

Note: Always click on the corner of the object to select it. Otherwise the nearby object
can be selected.

How to move circuit board outline to separate layer:

l Right click with a mouse on the BoardOutline layer name in the Layers panel. The con-
texts sensitive menu appears on the screen.

l Select the Move to Layer menu item. After the mouse button is released, the selected
circuit board outline is moved from the TopLayer to the BoardOutline layer.

Figure 49. Move to Layer context sensitive menu
Let's remove the circuit board outline from the BottomLayer (solder side).
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How to remove circuit board outline from the solder side:

l Double click on the Selectable cell of the BottomLayer entry in the Layers panel. The
BottomLayer is made selectable and rest of layers are switched to Not selectable mode.

l Select the circuit board outline on the BottomLayer in the Graphic view.

l Right click with a mouse and select Remove item in the appeared context sensitive
menu.

l Click on All Visible and Selectable button in the toolbar of the Layers panel to make
all layers Selectable.
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2.2.5. Place Objects on Separate Layers
CircuitCAM does not distinguish between text objects and conductor tracks when they are
present on the same layer. We advise you to move text objects to the separate layers.
How to select text objects on component side:

l First of all double click on the Visible cell of the TopLayer entry in the Layer view.
Only the component side of the board is visible in theGraphic view.

Figure 50. TopLayer the only visible layer in Layers list and component side in graphic
view

l Check, if the Plus Selection mode is switched On. If not, click on Plus Selection
button in the Select toolbar.

l To select text objects in Graphic view, use the area selection. Point with a mouse on
one corner of the supposed rectangle, which surrounds the text objects. Hold and drag to
the opposite corner of this supposed rectangle. Release the mouse button. Select another
group of text objects.
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Figure 51. Select text objects on TopLayer
Let's move selected text objects on the component side to the TextTop layer.

How to place text objects on separate layers:

l Right click on the TextTop layer in the Layers panel. The context sensitive menu
appears on the screen.

l Select the Move to Layer item. The text objects are moved from the TopLayer to the
TextTop layer.

l Press on the Visible cell in front of the TextTop layer name to make this layer visible in
the Graphic view.

Figure 52. Text objects on TextTop layer are presented in Graphic view
Let's move text objects from the BottomLayer to TextBottom layer:
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l Double click on the Visible cell of the BottomLayer entry in the Layer view. Only the
solder side of the board is visible in the Graphic view.

Figure 53. Bottom layer components in Graphic view

l Select text objects in the Graphic view.

l Right click on the TextBottom layer name in the Layers panel. The context sensitive
menu appears on the screen.

l SelectMove to Layer item. The text objects are moved from the BottomLayer to the
TextBottom layer.

l Press on the Visible cell in front of the TextBottom layer name to make this layer visible
in the Graphic view.

Figure 54. Text objects on TextBottom layer are presented in Graphic view

l Click on the All Visible and Selectable button in the Layers panel tool bar. All cir-
cuit board components appear in the Graphic view.
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Figure 55. Circuit board presentation in Graphic view
Move fastening holes from an electrical layer (i.e. "TopLayer") to a mechanical layer (i.e.
"DrillUnplated").

Figure 56. Fastening holes on DrillUnplated layer (dark blue color in Graphic view)

Note: Save your data under the Tutor2.cam name.
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2.3. Edit SMT Stencils

2.3.1. GMC Tutorial

2.3.2. Package Library Tutorial

2.3.3. Create Package Tutorial

2.4. Generating NC Data

2.4.1. Create Milling Contour
In this example, we will introduce how to use the contour generator, and insert breakout tabs to
the printed circuit board milling contour. In addition we will explain, how to change a milling
direction and sequence.
How to create milling contour:
Lets examine how to calculate the milling contour for the circuit board.

n Select in the main menu File -> Open.
n Select the Tutor1.cam file.

n Select an outline of the circle board in the Graphic view. In our example the circuit
board outline is located in the BoardOutline layer.

Figure 57. Selected circuit board outline in Graphic view and highlighted BoardOutline
layer in Layers panel

l Select in the main menu Tool Path -> Contour Routing. The Contour Routing dia-
logue window appear son the screen.
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Figure 58. Contour routing dialogue window

l The Outside selection button is selected, which defines the milling area.

l The source of the milling contour is the Current selection.

Note: In case you want to change the source layer, click the Layer selection but-
ton and select an applicable layer in the list box.

l The destination layer CuttingOutside is pre-selected in the Destination Layer list box.
Turn the Clear option On.

l Specify the used tool for milling in the Tool path layout:

l Click the "..." button next to the Tool field. The Tools dialogue window appears
on the screen.

l Expand the LMD branch and select the tool End Mill 2.0 mm (79 mil) under the
MillingTools branch.

l Click on OK.

l You can define the location and size of breakout tabs in the Breakout layout. We will
skip this for now and later we will introduce how to create breakout tabs in an appli-
cable places.

l Click on the OK button to generate the milling contour. After the calculation is com-
pleted, the milling contour is displayed in the Graphic view.
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Figure 59. Milling contour in Graphic view

Note: The circuit board will be milled out of the board with the current milling contour.

Insert Breakout Tabs

How to insert breakout tabs in milling contour:

l Select the contour on the CuttingOutside layer in the Graphic view.

Figure 60. Contour selected in Graphic view

l Set an anchor point using + and - keys or click with a mouse on an applicable
marker point to set an anchor point.
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Figure 61. Setting anchor point

l Select in the main menu Tool Path -> Create Gap or use keyboard keys Ctrl + G.

Note: The size of a breakout tab can be changed in the General Settings ---> Diverse
page, Breakout Tab field.

l Repeat the previous steps to insert breakout tabs at particular positions (see figure
below).

Figure 62. Positions of anchor point for breakout tabs
You can see the milling contour with breakout tabs in the Graphic view. The circuit board is
connected to the board material via breakout tabs.

Figure 63. Contour with breakout tabs

After you have generated a milling contour and inserted breakout tabs, you can define a milling
sequence and direction.

(72)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Change Milling Direction and Sequence

How to change milling direction and sequence:

l Select a closed path with a left mouse button in the Graphic view. The sequence
number of the selected path is displayed in the status bar.

Figure 64. Sequence number of selected path in Status bar

l Select in the main menu Tool Path -> Swap. The sub menu appears on the screen.

l Select the Move to First menu item to define the selected path to be cut first.

Note: To cut the selected path last, select the Move to Last menu item. To move the
selected path one step forwards/backwards, select the Move to Next/Prev menu item.
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2.4.2. Create Base Material and Fixture Holes

2.4.3. Create Rubout Area
A rubout area is a zone where the isolation channels around conductor tracks and pads are
milled, and also all residual copper between the conductor tracks and pads is removed from the
circuit board.
How to create rubout area:

l Open Tutor2.cam document file.

l Select in the main menu Insert -> Rubout Area. The submenu appears on the screen
with available values: Bottom Layer, Top Layer and All Layers.

l Select the Top Layer menu item to create a rectangular rubout area on the RuboutTop
layer.

l Click in the Graphic view are to set the start point for a rectangle.

l Move the cursor down and to the right.

l Click again to set the end point for the rectangle.

l Press Esc key to switch Off insert mode.
The rubout area is defined on the RuboutTop layer in the Graphic view.
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Figure 65. Defined rubout rectangle area in Graphic view

Note: You can insert a different shape for the rubout area (polygon, circle, closed path)
on the rubout layer via the Insert toolbar.
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2.4.4. Insulate Milling Tutorial

2.4.5. Customize Insulation and Rubout Job
CircuitCAM presents a list of pre-configured jobs in the Jobs view.
Let's examine how to calculate insulation channels and remove residual copper from the rubout
area.
In the previous example we created a rubout are in the Tutor2.cam document. Let's proceed the
work.

How to run Insulate and Rubout job:

l Click on the Jobs tab to open the Jobs view.

l Expand the Scripts tree branch.

l Select with your mouse the Insulate_ Top_Rubout_Bigger_Big_Primary job.

l Click on the Run button in the toolbar of the Jobs view.
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Figure 66. Jobs view, Run selected job

l The Run job dialogue window appears on the screen to set parameters for the job.

Figure 67. Run job dialogue window

l Click on the "..." button next to the tool bigger field. The Tools dialogue window
appears on the screen to select an applicable tool. The currently selected tool is high-
lighted in the tree. Click on the Cancel button to close the window.

Note: You can select tool big and tool primary in the same way.
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Figure 68. Tools dialogue window

l Click on the "..." button next to the layer source field. The Layers dialogue window
appears on the screen to select an applicable source layer. The currently selected
TopLayer is highlighted in the list. Click on the Cancel button to close the window.

Note: You can select layer rubout and layer destination in the same way.
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Figure 69. Layers dialogue window

l Click on the "..." button next to the layer rubout field. The Layers dialogue window
appears on the screen to select an applicable source layer. The currently selected Rub-
outTop layer is highlighted in the list. Click on the Cancel button to close the window.

Note: You can remove the layer from the layer rubout field. In this case, the rub-
out function is excluded from the job.

l Click on the Run button on the bottom of the Run job dialogue window. The insulation
is done for a whole graphical object and the rubout are is cleared.

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
(77)



CircuitCAM 7.5

Figure 70. Insulation and rubout job result in Graphic view
To view results, use the Zoom Window function, change the presentation of the layer.

l Click on the Zoom Window button in the Zoom toolbar.
l Draw with a mouse a rectangle in the Graphic view. The selected window is zoomed in
the Graphic view.

Figure 71. Zoomed window in Graphic view
Let's change the insulation channel, made by a primary tool to be of the True Width and
Filled. The current presentation is Line Only and Outline:

l Click on the Layers tab to open the Layers view.

l Select TopInsulate_Primary layer.

l Set True Width and Fill options On.

Figure 72. TopInsulate_Primary layer insulation channels of true width and filled (yellow
color)
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2.4.6. Laser Fill Tutorial
This functionality ensures that the defined area is completely exposed by a laser beam with a
given diameter. In all cases a laser path, called "primary outline" is put along the outline of the
area. Then the remaining area is then ISO filled by horizontal or vertical laser paths, these
paths are either hatching or concentric.

Figure 73. Laser Fill run job dialogue

Laser Fill job parameters

n Layer source: Specifies the layer where the graphical objects will be etched out of
copper.

n Layer destination: The output layer where the fill lines are applied. This layer name
will be combined to create two new layers; "xxx_FillO" and "xxx_FillX"

n Overlap percentage: Specifies the overlap between two fill lines, the value is a per-
centage of the beam diameter.

n Resolution for polygon package: Specifies the grid to be used.
n Fill mode: Specifies the strategy to be used in filling, either, "0: x-parallel", "1: y-par-
allel", or, "2: concentric".
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n Beam diameter: Specifies the diameter of the laser beam to be used.
n Primary outline: If this box is checked, creates an outline path.
n Small area: If a fill area is smaller than the number specified here, concentric fill will
be applied.

n Remaining area with midline: If this box is checked, midlines will be generated for the
unfilled remaining areas.

n Overlap percentage min: Specifies the overlap between two filling lines. It is used
only with the concentric fill mode. This value is a percentage from the beam diameter.

Example

Figure 74. Running the Laser Fill script with default parameters

In the figure above is the results of Laser Fill script with the default parameters, the Fill Mode
is set to 0, which means x-parallel fill lines.
The Laser Beam Diameter is set to 0.03 mm, and the Overlap Percentage is set to 20%, thus
the spacing between fill lines is 0.024 mm (0.03 minus 20% overlap).
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Figure 75. Running the Laser Fill script; with Y-Parallel Lines

Figure 76. Running the Laser Fill script; with Concentric Lines
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2.4.7. Laser Insulate Tutorial
CircuitCAM provides functionality to generate insulation paths using laser beams.
this functionality is intended to remove material outside of specified areas, the specified areas
may either be insulated from the surrounding material, or the surrounding material may be com-
pletely removed.
In all cases a primary insulation channel is created around the specified material, taking into
account the diameter of the laser beam generated, additional insulation channels can be gen-
erated with a specified overlap value, the remaining area is removed by horizontal or vertical
hatching lines.
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Figure 77. Laser Insulate run job dialogue

Laser Insulate job parameters

n Layer source: Specifies the layer to be insulated. The selected layer must exist and can
not be empty.

n Primary insulate strategy: Specifies the strategy to be followed in the insulation proc-
ess, either "0 - Simple", "1 - Simple with midline", or "2 - Independent oversize".

n Inner isolation: If this box is checked, an inner isolation channel is created.
n Beam diameter: Specifies the diameter of the laser beam to be used.
n Under etching: Specifies an additional distance between the first insulation channel
and the border of area.

n Number of channels: Specifies the number of insulation channels. This number of chan-
nels is generated in addition with the primary insulation channel.

n Overlap: Specifies the overlap between insulation channels, in case of using only one
insulation channel, the overlap value has no effect.

n Resolution for polygon package: Specifies the grid to be used.
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n Layer fill: The graphical objects on this selected layer will be filled.
n Fill lines distance: Specifies the distance between x, y, or, x+y filling lines.
n Fill distance to border: Specifies the distance from the border of the area to the outline
closed curve.

n Fill Strategy: Specifies the strategy to be used in filling, either, "0: x-parallel", "1: y-par-
allel", or, "2: x+y-parallel".

n Fill oversize/undersize: Specifies the overlap between the outline, and start/end points
of hatch lines.

n Layer rubout: Graphical objects on this layer will define additional areas to be cleared
by the isolation process.

n Rubout line distance: Specifies the distance between x, y, or, x+y hatch lines.
n Rubout distance to border: Specifies the distance from the border of the area to the
start/end points of hatch lines. If the value is set to zero, the hatch lines start and end on
the border of the area.

n Rubout strategy: Specifies the strategy to be used in creating the rubout area, either,
"x-parallel", "y-parallel", or, "x+y-parallel".

n Layer destination: Specifies the main layer for isolation tracks, rubout, and filling
lines. Additional layers are created in the same name with different endings to clarify
various isolation layers.

Examples

Figure 78. Laser Insulate Script with default values
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Figure 79. Laser Insulate Script with inner isolation flag on
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Figure 80. Laser Insulation Script with a defined layer fill
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Figure 81. Laser Insulate Script with a defined layer rubout
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2.4.8. SMT Stencils Tutorial

2.5. Processing NC Data

2.5.1. Export Production Data
How to export to Gerber:

l Select in the main CircuitCAM menu File -> Export -> Gerber:

l Select GerberXTop to export production data to the file with an extension
".TOP".
Or

l Select GerberXBottom to export production data to the file with an extension
".BOT".

CircuitCAM message window appears on the screen, where the destination path of the
exported file is presented.
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Figure 82. CircuitCAM message window with destination file path
How to export to Excellon:

l Select in the main CircuitCAM menu File -> Export -> Excellon -> Excellon. Pro-
duction data are exported to the file with an extension ".DRL".
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2.5.2. NC Mode Tutorial

2.5.3. Close CircuitCAM

How to exit CircuitCAM:

n Press on the keyboard shortcut ALT + F4.
Or

n Select in the main CircuitCAM menu FILE -> EXIT.
Or

n Click with a mouse on the Close button on the top right corner of the application win-
dow.
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2.6. Others

2.6.1. Create CircuitCAMTemplate File
In this example we will show how to create a template file with user-specific settings (aper-
ture and tool list, layer name and color and etc.) and change the default template in settings.

How to create template file:

n Select in the main menu File -> Recent Files -> Tutor1.cam.

Note: In case the Tutor1.cam file is currently opened, skip this step.
n Ensure that all layers in the Layers panel are selectable. In case some of them are not
selectable, click on the All Visible and Selectable button in the toolbar.
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n Select in the main menu Select -> All to select all graphical objects.
n Press Delete to delete the selected objects.

n Select in the main menu File -> Save As. The Save As dialogue window appears on
the screen:

l Navigate to the New_Template directory.

l Select Template (*.cat) in the File Type combo box.

l Enter Tutor1 into the File Name text field.

l Click on Save button to save the template file and close the Save As dialogue win-
dow.

n Select in the main menu File -> New. The sub-menu appears on the screen, with the
included Tutor1 template file.

How to change default template:

l Select in the main menu Settings -> General Settings. The General Settings window
appears on the screen.

l Click on the Directories branch of the tree on the left side of the window. The Direc-
tories panel is opened on the right side of the page.

Figure 83. General settings window, Directories panel

l Click on the look up button next to the Default Template Name field. The Select new
template dialogue window appears on the screen.

l Select the file path for a new default template, e.g. "Tutor1.cat".

l Click Open button.
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l Click Cancel button to continue using of the default_insulate.cat as the default tem-
plate.
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2.6.2. Using Import Assignments
To automate the import of production data, you can specify import assignments for production
data with specified file extensions, e.g. "drl", "sld" and "cmp". After you define which file
extension represents a particular type of production data, assign a layer and an aperture/tool
list, you no longer need to specify this information in the future for the import purposes.

Note: if all production data files selected for import are covered by import assignments,
import dialog box will not be shown. Otherwise

How to define import assignments:

n Click on New button in the Standard tool bar to open a new document based on a
default template.

n Select in the main menu Settings -> General Settings. The General Settings window
appears on the screen.

n Click on Import Assignment branch of the tree on the left side of the window. The
Import Assignment panel is opened on the right side of the window.

Figure 84. General Settings window, Import Assignment panel
In our example we use the double sided circuit board. We have to import an aperture list, tool
list, two Gerber files for the conductor tracks and a file of holes.
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Please find below the table with the corresponding extensions and assignments.
File Spec-
ification

Aperture/Tool
List File Type Layer/Template

Aperture list *.whl Apertures Aperture/tool
list TutorApe.txt

Tool list *.nct Tools Aperture/tool
list TutorTools.txt

Excellon data *.drl Tools Excellon DrillPlated
Gerber data, Component
side *.cmp Apertures Gerber TopLayer

Gerber data, Solder side *.sld Apertures Gerber BottomLayer

n Click on Add button in the Import Assignment panel. A new empty row appears in the
Import Assignment table.

Let's create the import assignment for an aperture list:

n Enter "*.whl" in the File Name cell.

n Open the Type list and select "Aperture Select".

n Open the Layer/Template list and select "TutorApe.txt".

n Click on the Aperture/Tool list cell and enter the name "Apertures".

Figure 85. Assignment for aperture list
Let's create the import assignment for a tool list:

n Click on Add button.

n Enter "*.nct" in the File Name cell.

n Open the Type list and select "Aperture Select".
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n Open the Layer/Template list and select "TutorTools.txt".

n Click on the Aperture/Tool list cell and enter the name "Tools".
Create the import assignment for Gerber file, which contains layout data for the component
side of the circuit board:

n Click on Add button.

n Enter "*.cmp" in the File Name cell.

n Open the Type list and select "Gerber".

n Open the Layer/Template list and select "TopLayer".

n Click on the Aperture/Tool list cell and enter the name "Apertures".
Create the import assignment for Gerber file, which contains layout data for the solder side of
the circuit board:

n Click on Add button.

n Enter "*.sld" in the File Name cell.

n Open the Type list and select "Gerber".

n Open the Layer/Template list and select "BottomLayer".

n Click on the Aperture/Tool list cell and enter the name "Apertures".
Create the import assignment for Excellon file:

l Click on Add button.

l Enter "*.drl" in the File Name cell.

l Open the Type list and select "Excellon".

l Open the Layer/Template list and select "DrillPlated". The holes in the Excellon file
should be through plated.

l Click on the Aperture/Tool list cell and enter the name "Tools".
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Figure 86. Import assignment DrillPlated

n Click on Save to template file check box to save import settings in the specified tem-
plate file.

n Click on the lookup button next to the field below. The Select new template dialogue
window appears on the screen.

n Define the path to the template file (i.e. "tutor.cat)

n Click Open button to confirm changes and close the dialogue window.

n Uncheck the Save to template file option, because will save the import settings in the
current template file "default_insulate.cat".

n Click OK button to save import settings to the current template and close the General
Settings window.
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3. Reference Manual

3.1. Main User Interface
CircuitCAM is a so called single document interface application. This means that within one
frame window only one CAM document is displayed. To handle several CAM documents simul-
taneously, several CircuitCAM instances must be opened from the Windows® system, each
instance with its own frame windows. Copying data from one instance to another is possible.

Figure 87. CircuitCAM frame window

The main CircuitCAM frame window contains:

l Menu bar

l Several Toolbars

l Status bar

l none, one, or several view windows.
Within the main working area, the following non-modal views may show up, depending on
whether they are made active or hidden via their menu settings:

l Graphic View

l List View

l Layers

l Tools

l Jobs

l Layouts

l Libraries

l Properties

l Preview
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l Quick Access

l Message Log

l Set Cursor

l Set Anchor

l Geometry Manipulation Centre (GMC)

Except for the Graphic view, all these views are either in the dockable or floating state, see
View arrangement. At most one of these views is active at a time, indicated by its title bar.
In contrast to the non-modal views listed above on which the user can work in parallel, the Cir-
cuitCAM dialogues are modal. After opening a dialogue it has to be closed, typically by OK or
Cancel, before the user can proceed using other CircuitCAM functionalities.

The main CircuitCAM dialogues are:

l File menu

l Import

l Printing and Printer Calibration

l Statistics

l Design Rule Check

l Insert menu

l Insert Text / Barcode

l Insert Data Matrix

l Base Material / Fixture Holes

l SMT Stencil Frame Generator
l Library menu

l Create Package
l Package Recognition
l GMC Exchange
l Import Libraries

l Tool path menu

l Laser Scanner Fields

l Contour Routing

l Tool Compensation

l Modify menu

l Size Modification

l Step and Repeat

l Create Bounding Shape

l Create Outline of Shape

l Perfect Shape

l Perfect Shape Tolerance

l Pitch of two Pads

l Settings menu
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l Customize

l General Settings

l Help menu

l CircuitCAM Activation Wizard

l About CircuitCAM
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3.1.1. Menu

CircuitCAM user interface includes a menu bar on the top section of the window. Point with
the mouse on an applicable menu item as in the picture below:

Figure 88. CircuitCAMMenu bar
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3.1.1.1 File
The File menu is the most important starting point to create new, and open existing documents,
save, import, export and print documents.

Ico-
n Function Hotkey Description Further

Info.

New Ctrl + N

Creates a new CAM document with the name
"Untitled N" (N = 1,2,3...), that is based on a spec-
ified template file or the default template file. Typ-
ically the template files contains no graphic
objects, but only layers, tools, etc.

See New

Open Ctrl + O Opens an existing document (*.CAM or *.CAT). See Open

Synchronize Updates the current CAM document according to a
template file.

See Syn-
chronize

Background Selects and displays background data.

Close Alt + F4

Closes the current active document if there are no
changes made since the last document save. If the
document was modified, CircuitCAM prompts to
save or to discard the changes.

Import Imports files into the current document. See Import
Export Exports the production data. See Export

Save Ctrl + S
Saves the current document using the existing file
name. In case of a new Untitled N document, See Save
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Ico-
n Function Hotkey Description Further

Info.
when pressing Save the Save As menu is acti-
vated.

Save As
Saves the current document in a different location,
and/or with a different file name and/or a different
file format.

see Save
as

Save As Tem-
plate Saves the current document as CAT template file.

Print Ctrl + P Prints the active document. The CAM file name is
printed on top of the page.

See Print-
ing

Print Preview Displays the active document on the screen, as it
would appear printed.

Print Setup
Selects a printer, a printer connection and printing
options. For more information see your Windows®
documentation.

Printer Cal-
ibration

Allows you to correct the aspect ratio of the
printer in X and Y directions to achieve higher
accuracy.

See Printer
Calibration

Recent files Displays a list of your most recently accessed
files, this list displays the last opened ten files.

Exit Quit CircuitCAM with a prompt to save or discard
any unsaved changes.
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3.1.1.2 Edit
The Edit menu offers the following commands:

Ico-
n Function Hotkey Description Further Info.

Undo Ctrl + Z

Undoes the last three manipulations.
There is a possibility to change the
depth of Undo in General Settings
dialogue, General panel.

Redo Ctrl + Y Reverses the actions of the last Undo
operations.

Cut Ctrl + X Moves the selected objects to the
standard clipboard.

Copy Ctrl + C Copies the selected objects to the
standard clipboard.

Copy As
EMF in

Copies Colored orMonochromatic
graphics from CircuitCAM to be used
in other Windows® applications. The
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Ico-
n Function Hotkey Description Further Info.

Enhanced Metafile format is used.

Paste Ctrl + V Inserts the object(s) from the clip-
board.

Remove Delete Deletes all selected objects.

Procedure:
l Select the objects
you want to
delete.

l Start the Delete
operation (menu
or keyboard).

l All selected
objects are
deleted. Thus no
further objects are
then selected.

Move
Selected Space

All objects in a selected group can be
moved together. The relative positions
and orientations between the objects
are not changed. In this operation, the
position of the active marker is reset,
i.e.: all objects are moved by the
same distance. This distance is
obtained from the difference between
the old and the new positions of the
active marker.

Procedure:
l Select the objects
you want to move.

l Start the Move
operation (menu
or keyboard).

l The selected
objects follow the
mouse movements
virtually.

l Set a new position
for the active
marker by clicking
the left mouse but-
ton.

The operation can be
interrupted with the Can-
cel.
The new position is on
the selected cursor grid.
All objects stay selected.

Duplicate
Selected

Ctrl +
Space

The Duplicate operation is very sim-
ilar to the Move operation, only here
a new copy is made instead of moving
the original object.

Rotate Rel-
ative

See Rotation and mirroring function
(relative mode) on page Rotation and
Mirroring.

Set Flash
Rotation
Value

See Rotation and mirroring function
(absolute mode) on page Rotation and
Mirroring.

Set Cursor Ctrl +
Shift + C

This function simulates a left mouse
click at the entered co-ordinates. It See Set Cursor
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Ico-
n Function Hotkey Description Further Info.

also activates the Set Cursor panel,
in case it is not visible on the screen.

Set Cursor to
Zero

Ctrl +
Shift + 0

Simulates a left mouse click at posi-
tion (0,0).

Set Anchor
Point

Ctrl +
Shift + A

This function allows setting the
anchor point to any other co-ordi-
nates. It also activates the Set
Anchor window, in case it is not vis-
ible on the screen.

See Set Anchor Point

Anchor to
Centre Point

Ctrl +
Shift + Z

Calculates a bounding box of all
selected objects and sets the anchor
point to the centre of this bounding
box.

The function is based on
resolution of Polygon
Package.

Anchor to
Mass Point

Ctrl +
Shift + M

Calculates a mass point of all
selected objects and sets the anchor
point to this point.

The function is based on
resolution of Polygon
Package.

Set Zero
Point

Ctrl +
Shift + N

A zero point (X/Y coordinate 0/0) can
be set within the graphic or outside
the layout. Set Zero Point function
makes the current anchor point the
new zero point (Origin point). So, all
graphic objects in all layers are
moved according new zero point. The
relative position of graphic objects to
each other stays unchanged.

Move Layer
to Zero

Ctrl +
Shift + L

The Move Layer to Zero function
works in a similar way the Set Zero
Point function does, but it sets the cur-
rent anchor point to the new zero
point (Origin point) only for one layer
of graphic objects. The layer must be
selected from the list of layers on the
Layers list view.

Match up
Layers

To execute this function: press the but-
ton, select a flash (source layer and
its point) by a mouse click, move the
cursor to another flash in the des-
tination layer (a rubber band shows
the road from the first point). This
option works on flashes only (the
nearest flash is selected).
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3.1.1.3 Select
Many operations, such as move, delete etc..., work only on selected objects. A single or group
selection can be used. For more information on the selection status, see Selection of graphic
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objects.
CircuitCAM has a number of functions and switches to influence the way in which objects are
selected, and to determine what kinds of graphical objects may or may not be selected.

Ico-
n Function Hotkey Description Further

Info.

Layer

Selects the entire active layer. The active layer is
either selected from the Layers panel or by select-
ing a graphical object included in it. The layer
must be visible and selectable. In case the
Plus/Minus selection mode is set, the layer is
added/removed to/from the existing selections.

Aper-
ture/Tool

Selects all graphical objects which are created
with the same active aperture or tool. The selec-
tion is only made from the visible and selectable
layers. The active aperture or tool list is selected
from the Tools panel or by selecting a graphical
object. In case the Plus/Minus selection mode is
set, the tools are added/removed to/from the exist-
ing selections.

All Ctrl + A
Selects all graphical objects on all layers. The
selection is only made from the visible and select-
able layers.

Invert Selec-
tion

Inverts the current selection: deselects the selected
objects and selects unselected objects.

Path Enables/disables selection of paths.

Polygon Enables/disables selection of polygons.

Circle Enables/disables selection of circles.

Rectangle Enables/disables selection of rectangles.

Pad/Hole Enables/disables selection of flashes.
Sublayout Enables/disables selection of sub-layouts.

Size Limit

Enables/disables selection of objects that are
bigger or smaller than a given value.
This limit is applied on the bounding box of the
objects (the bigger value in either X or Y direc-
tion) and works in combination with the current
selection filters.
The limit value is typed into the edit field

Figure 89. Selection size limit dialogue window
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Ico-
n Function Hotkey Description Further

Info.
The state (condition) is set from the combo box
and can be: <, <=, >, >=, =.
The size limit is used only when the Enable check
box is ON.

New Resets all previous selections in the event of a
new selection (default setting).

Plus Adds a new selection to the existing selection.

Minus Removes an existing item from the current selec-
tion.

Sequence

This operation changes the selection of objects.
Properties of the selected object (type, current posi-
tion) are shown in the Status Bar.
Function has four operations:

1. select the next object in the group; Ctrl +
Shift + Right

2. select the previous object in the group;
Ctrl + Shift + Left

3. select the first object in the group; Ctrl +
Shift + Up

4. select the last object in the group. Ctrl +
Shift + Down

See
Sequence,
Hotkeys

Pitch Searches and selects the graphical objects, which
have the same pitch, spacing and area. See Pitch
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3.1.1.4 Insert
Inserts a new graphic object directly to the currently active layer.

Ico-
n Function Description Further

Info.

Rubout Area

Inserts a new rubout area.

Top layer creates a rubout area on the top side of the
circuit board;

Bottom layer creates a rubout area on the bottom
side of the circuit board;

All layers – on both sides.

See Rubout
Area

Open Path Inserts a new path that consists of one or more lines or
arcs segments.

See Open
Path

Closed Path Inserts a new path. The Closed Path function is very sim- See Closed
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Ico-
n Function Description Further

Info.
ilar to Open Path function except that the last path point
will be joined to the start point. In the drawing procedure
the Open Path function must be changed to the Closed
Path function.

Path

Polygon Inserts a new polygon which is a filled area defined by an
outline. See Polygon

Rectangle Inserts a new rectangle. The new created shape is a filled
area defined by an outline.

See Rec-
tangle

Dynamic
Radius Circle

Inserts a circle which you can control its radius moving
your mouse cursor. The new created shape is a filled area
defined by an outline.

See Centre
method on
page Circle.

Fixed Diameter
Circle

Inserts a circle with a predefined fixed diameter. The new
created shape is a filled area defined by an outline.

See Centre
+ Radius
method on
page Circle.

Circle in
Closed Path

Inserts a closed path circle with a fixed diameter. The
new created shape is a closed path outline.

See Circle
in closed
path method
on page Cir-
cle.

Point on Arc Inserts a new arc, where an additional point on the arc
determines the circle sector. Only active while drawing. See Arc

Centre Point
Arc

Inserts a new arc, where the circle sector is determined
by defining the Centre point of the circle. Only active
while drawing.

See Arc

Pad Inserts a new pad (flash). See Pad

Fiducial

Simplifies the process to insert fiducials: the new feature
allows creating fiducials with just two mouse clicks. One
click on the menu Insert ---> Fiducial, and another click
on the graphic screen to place the fiducial.
The diameter can be set in the Diverse panel of the Gen-
eral Settings. The fiducial will always be placed on the
Fiducial layer. If such layer does not exist, the layer will
be created.

Arbitrary Hole

Inserts a new drill hole. This function is very similar to
the insert Circle function except that the drill hole is only
executed on one of the following layers only:

Plated - the drill hole drawing is executed on the Drill-
Plated layer

Unplated - the drill hole drawing is executed on the
DrillUnplated layer

Insert Text

Inserts a new text:

Top... - inserts a text on the TextTop layer.
Bottom... - inserts a text on the TextBottom layer.

See Text
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Ico-
n Function Description Further

Info.
Active layer... - inserts a text on the currently active

layer.

Data matrix Inserts a Data Matrix barcode. See Data-
Matrix

QR Code Inserts a Quick Response Code (QR). See QR
Code

Insert Sub-
layout

Inserts a sub-layout (selected instance) in the current
active layout.

Base material /
fixture holes Inserts a base material with or without fixture holes. See Base

material

Stencil Frame
Generator Inserts a new Stencil Frame job

See "SMT
Stencil
Frame Gen-
erator"

Cutout

Inserts a new polygon Cutout. The polygon Cutout con-
sists at least of two figures. The first figure is always an
outer figure (boundary), all others figures are inner figures
(cutouts).

See Polygon
with Cutouts

Copper pouringThe function is rather similar to function for creating of aPolygon with Cutouts.

See Copper
PouringNote
This func-
tion is only
available in
CircuitCAM
variants
STAND-
ARD and
PRO.

Line mode 45°
Aligns the segments and arc segments so that the mouse
cursor only moves by an angle of 45 degrees and incre-
ments. Only active while drawing.

See Line
Drawing
Modes

Line mode 90°
Aligns the segments so that the mouse cursor only moves
by an angle of 90 degrees and increments. Only active
while drawing.

See Line
Drawing
Modes

Select inserted
object

If this option is on, the inserted(pasted) objects are
selected in addition to the previous selected ones. If this
option is off the inserted(pasted) objects are not selected
or active.
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3.1.1.5 Modify
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Ico-
n Function Hotkey Description Further

Info.
Curve; A set of single object manipulation operations, including the fol-
lowing:

Add
Point/Seg-
ment

Ctrl + T
Creates and places a new point at the current
anchor point position. A new segment is connected
to the selected path with line segments.

See Add
Point/Seg-
ment

Cut Point/Seg-
ment Ctrl + U Splits a path into two segments at the anchor point.

See Cut
Point/Seg-
ment

Delete
Point/Seg-
ment

Ctrl + D Deletes a point or a line segment at the current
anchor point.

See Delete
Point/Seg-
ment

Move
Point/Seg-
ment

Ctrl + M Moves a point or a line segment at the current
anchor point position.

See Move
Point/Seg-
ment

Create or
Move Arc Ctrl + E Converts a line segment into an arc at the current

anchor point position.

See Create
or Move
Arc

Combine Ctrl + B Combines selected paths to a single path. See Com-
bine

Close Ctrl +
Shift + Q The selected open path becomes a closed path. See Close

Path to Poly-
gon

Ctrl +
Shift + P

Converts the selected open path to a polygon. The
path gets a new line segment to connect start and
end points.

See Path to
Polygon

Combine to
Polygon Ctrl + K Combines selected paths and converts them to a

polygon.

See Com-
bine to
Polygon

Convert to
Polygon

Ctrl +
Shift + Y

Converts any selected object to a polygon. Over-
lapping objects are converted to a single polygon.

See Con-
vert to
Polygon

Convert to
Closed Out-
line Path

Ctrl +
Shift + W

Converts selected object to a closed path. Separate
outlines will be generated for overlapping objects.

See Con-
vert to
Closed Out-
line Path

Denest all
Cutouts

Ctrl +
Shift + I

Converts all negative cutouts for the selected poly-
gon to positive objects.

See
Denest
Polygon
Cutout

Denest single
Cutout Shift + J Converts a single selected negative cutout to a pos-

itive object.

See
Denest
Polygon
Cutout
Hole

Convert to
Circle

Ctrl +
Shift + K

Converts the selected object to a circle with the
same area.

See Con-
vert to Cir-
cle

Draw to
Flash

Ctrl +
Shift + D

Converts selected objects to flashes. Overlapping
objects are converted into a single flash.

See Draw
to Flash
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Ico-
n Function Hotkey Description Further

Info.

Convert to
One Flash

Ctrl +
Shift + H Converts selected objects into a single flash.

See Con-
vert to One
Flash

Convert to
Instance

Converts selected objects into a single instance/lay-
out.

See Con-
vert to
Instance

Exchange With Flash; and it includes the following:

Compare
Shape

Ctrl +
Shift + S

Compares all objects with a shape of the selected
flash. Replaces identical to the selected flash
objects with a flash. The original objects are
deleted and all new objects are made as selected.

See Com-
pare Shape

Compare
Bounding Box

Ctrl +
Shift + B

Compares all objects with a bounding box of the
selected flash. The original objects are deleted and
all new objects are made as selected.

See Com-
pare
Bounding
Box

Compare Out-
line

Ctrl +
Shift + T

Compares all objects with an outline of the
selected flash. The original objects are deleted and
all new objects are made as selected.

See Com-
pare Out-
line

Denest
Flashes/In-
stances

Ctrl +
Shift + E

Selected flashes/instances are replaced in a
graphic window with their origin shapes (circle,
rectangle, path and so on).

Note1

Undo Foot-
print Occur-

rences
Selected footprint occurrences are restored in a
graphic window with their origin shapes. Note2

Size Mod-
ification

Ctrl +
Shift + U Implements size manipulations on selected objects.

see Size
manip-
ulations
dialogue
window
Note3

Step and
Repeat

Ctrl +
Shift + R

Repeats selected objects in a right-up direction,
according to the settings in the dialogue window.

See Step
and Repeat

Create Bound-
ing Shape

Ctrl +
Shift + G

Creates a circular bounding shape one per each
group of overlapped graphic objects.

See Create
Bounding
Shape

Create Out-
line

Ctrl +
Shift + O

Generates an outline on the edge of each object
located on the Source layer.

See Create
Outline

Perfect Shape Ctrl +
Shift + V

Checks selected objects on a perfect rectangle, a
rounded rectangle, a bevelled rectangle, a circle
and an oval according to the given tolerance. If
yes, converts the perfect shapes into flashes of
mentioned types.

See Per-
fect Shape

1: This function is only available in the CircuitCAM variants STANDARD and PRO.
2: This function is only available in the CircuitCAM PRO variant.
3: This function is only available in the CircuitCAM PRO variant.
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Ico-
n Function Hotkey Description Further

Info.

Boolean Operations; and it includes the following:
Union Performs the set operation; Union See Union

Difference Performs the set operation; Difference See Dif-
ference

Intersection Performs the set operation; Intersection See Inter-
section

XOR Performs the set operation; XOR See XOR

Paths on
Area Trim paths, leaving portions on a selected area. See Paths

on Area
Paths off
Area Trim paths, leaving portions off a selected area. See Paths

off Area

Item edit

Enabled only while graphically editing an aperture,
tool, or layout. The graphical editing of this aper-
ture, tool, or layout can be ended by either saving
the changes or discarding them.

see also
Tool Prop-
erties,
Libraries,
Active con-
fig-item.

Geometry
Manipulation

Centre
(GMC)

Perform various operations to change geometry of
pads. There is a possibility to apply automatic
exchange on the same pads. See Overview

Note1
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3.1.1.6 Tool Path

Ico-
n Function Hotkey Description Further

Info.
Laser
Scanner Generates a mesh of laser scanners.

Contour Rout-
ing

Calculates and creates an inner or outer milling
contour.

See Con-
tour Rout-
ing
Note2

Create gap Ctrl + G Adds a gap at the active marker point. See Create
Gap

Tool Com-
pensation Generates an offset tool path for the selected path.

See Tool
Com-
pensation

1: This function is only available in the CircuitCAM PRO variant.
2: This function is not available in the CircuitCAM VIEWER variant.
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Ico-
n Function Hotkey Description Further

Info.

Swap

Changes the order of object/group of objects.
Move to next:         Ctrl + J
Move to previous: Ctrl + I
Move to first: Ctrl + F
Move to last: Ctrl + L

See Swap

Reverse Ctrl + R Reverses the selected open path.

Connect to
NC Server

Connects to an NC server, whether local or remote
server.

NC Continue Continue in NC mode without discarding the pre-
vious changes.

NC Normal Starts a new NC session with normal orientation.
NC Mirror-X Starts a new NC session mirrored on X-axis.
NC Mirror-Y Starts a new NC session mirrored on Y-axis.

End NC Exits NC mode.
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3.1.1.7 Library

Ico-
n Function Hotkey Description Further

Info.

Create Pack-
age

Allows the user to create a new package. The cre-
ation dialogue is very similar to Create Package
from Selection, but the user himself specifies main
package parameters - columns, rows and pitch.

Create Pack-
age from
Selection

Allows the user to create a new package from
selected pads.

See Create
Package
from selec-
tion

Create Foot-
print from
Selection

Allows the user to create a new footprint from
selected pads.
If more than one footprint library exists in spec-
ified library directory, the dialogue box with a list
of all available footprint libraries will be dis-
played. If no libraries exist in the specified library
directory, a user will be prompted to create a new
footprint library.
User needs to specify the Name for new footprint:
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Ico-
n Function Hotkey Description Further

Info.

Figure 90. Layout Properties dialogue window
This must be done carefully, because the applying
of footprints for recognized packages are based on
names checking.

Package Rec-
ognition

Starts automatic recognition of packages according
to the selected package library.

See Pack-
age Auto
Rec-
ognition

GMC
Exchange

All enabled GMC shapes from GMC libraries are
used for GMC Exchange. After the command is
invoked, CircuitCAM starts a comparison process
(similar as a mechanism, described in Geometry
Manipulation Centre - see Compare): the original
shape is compared with objects, placed in the lay-
ers, specified in the list.

Apply foot-
prints

All enabled footprints in Libraries view are used
for apply footprints functionality.
All layouts in the current CAM document are
scanned. For each Package layout enabled foot-
prints are checked. When footprint or footprints
are found, the apply for corresponding Package lay-
out is performed.

See Apply
footprint

Import
libraries

CircuitCAM has a new internal data format for
GMC libraries. If a user wants to use earlier
created library, he will need to import (convert)
them into a new format.
The selected library(-ies) are copied into the
libraries directory according to General settings. If
libraries are in the old GMC format (pair of config
items for original and modified shape), they are
automatically converted into the new format (lay-
out, "OriginalObj" and "ModifiedObj" layers).
An extension of the converted file becomes "cam-
gmc" (old library type was "gmc"), but a name of
the library remains the same.
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3.1.1.8 Analysis

Ico-
n Function Hotkey Description Further

Info.

Measure Ctrl +
Shift+ X

Calculates a distance between the last selected
Anchor Point and the current cursor position.

See Meas-
ure

Pitch of Two
Pads

Calculates the distance between the two centre
points of two selected areas (pads).

See Pitch
of Two
Pads

Area of
Selected
Objects

Calculates an area of selected objects.
See Area
of selected
objects

Design Rule Check, which includes:

Stencil DRC Checks the stencil patterns according to the
IPC7527 guidelines.

See Stencil
Design
Rule
Check

PCB DRC

Tests the minimal distance of graphic objects of
one layer or within two different layers.
CircuitCAM supports the design rule check to test
for a minimum distance. The following types of
design rules are supported: 

l Intra Min Spacing: Tests the minimal dis-
tance of graphic objects within one layer.

l Inter Min Spacing: Tests the minimal dis-
tance of graphic objects within two dif-
ferent layers.

After performing these design rule checks, the vio-
lations of these rules are displayed as graphic
object on the result layer.

See PCB
Design
Rule
Check

Statistics Shows statistics about the current document. See Sta-
tistics

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved.

3.1.1.9 Settings
The Settings menu allows a user to customize display units, display/cursor grids, select a coor-
dinate mode, and modify CircuitCAM features and options.
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Ico-
n Function Hotkey Description Further

Info.
Absolute
Coordinates

Displays the mouse position in absolute coor-
dinates.

Relative Coor-
dinates

Displays the mouse position in coordinates relative
to the Anchor Point.

Cartesian
Coordinates

Displays the mouse position in Cartesian coor-
dinates.

Polar Coor-
dinates Displays the mouse position in polar coordinates.

Big Cursor

Switches to big cursor; two perpendicular lines on
the graphic area.
The cursor type can be set in the General Settings
dialogue window (Display panel).

Measurement
Units

Changes the measurement units from the prede-
fined list of units. The default value can be set in
the General Settings dialogue window (General
panel).

Decimal
Places

Changes the number of decimal places that a unit
is measured in. The default value can be set in the
General Settings dialogue window (General
panel).

Show Grid Shows/hides the grid on the graphic window.

Grid Spacing
Changes the spacing between grid lines from the
predefined list of values. This option only works
when the grid is visible.

Snap to Grid

Turns on and off the snap to grid feature. The snap
to grid feature explains as follows: When you
draw, resize, or move a shape or an object, it will
align or "snap to" the nearest point in the grid,
even if the grid is not visible. If your shape or
object does not move where you want, turn off the
snap to grid option or choose a smaller scale grid.

Cursor Grid
Spacing

Selects grid spacing for the positioning of the
graphical objects, this option only works when the
Snap to Grid feature is enabled.

Customize

Allows the user to modify menu options, the layout
of toolbars, view and change the keyboard short-
cuts mapping, menu settings, and general pref-
erences.

See Cus-
tomize

General Set-
tings

Shows and allows changing of the main user and
document related preferences of CircuitCAM.

See Gen-
eral Set-
tings
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3.1.1.10 View
Controls how large or small the graphical representation appears on your screen. Allows show-
ing/hiding of toolbars. Setting layers' properties. Showing/hiding various functions and indi-
cations windows.

Ico-
n Function Hotkey Description Further

Info.

Zoom Win-
dow

Alt +
draw box
with
mouse

Allows user to draw a rectangle around a specific
area you wish to zoom into.

Zoom In

Page Up
or

Mouse
Wheel Up

The graphical representation is shown enlarged by
a factor of 2 around the screen centre point.
By using keyboard function Page Up the current
cursor position is used instead of the screen centre
point. If the mouse cursor is outside the graphic
view area, the last recorded mouse position will be
used as zooming point.

Note1

Zoom Out

Page
Down
or

Mouse
Wheel
Down

The graphical representation is shown reduced by
a factor of 2 around the screen centre point.
By using keyboard function Page Down the current
cursor position is used instead of the screen centre
point. If the mouse cursor is outside the graphic
view area, the last recorded mouse position will be
used as zooming point.

Note2

Zoom scale The graphical representation is shown zoomed by
a predefined scale factor.

Zoom
selected

Zooms in/out so that all selected graphical objects
fits the screen. If no objects are selected, the func-
tion is disabled.

Overview Home All graphical objects are shown fitting the screen.

Previous Insert The previous view is returned. Up to twenty views
are saved.

Refresh F5

The graphical representation is completely
redrawn again. This function is sometimes needed
after deleting or other manipulations are made, to
obtain a clear graphical representation once again.

Toolbars
CircuitCAM has a number of toolbars, which alto-
gether include associated functions. Click on the
toolbar you wish to display or hide.

See Tool-
bars

1: The initial zoom-in point is the screen centre point  and is valid until the mouse is
moved. After the mouse cursor is moved, it will be considered the centre point of
zooming. So, before moving the mouse, the user can press the PageUp key several times
until the desired zoom level is reached.
2: The initial zoom-out point is the screen centre point and is valid until the mouse is
moved. After the mouse cursor is moved, it will be considered the centre point of
zooming. So, before moving the mouse, the user can press the PageDown key several
times until the desired zoom level is reached.
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Ico-
n Function Hotkey Description Further

Info.

Status Bar
The status bar at the bottom of the application win-
dow displays information regarding the object or
function selected.

See Status
bar

Full Screen
Ctrl +
Shift +
Enter

Resizes the graphic representation of view mode
to fit the full monitor size. To cancel the full
screen mode, click on the Full screen button on the
top-left corner of the window or use the keyboard
combination.

Message Log

Activates Message Log panel, which is dedicated
to view and handle various log/report messages
generated by CircuitCAM after/while performing
various operations.

See Mes-
sage Log

Layers Activates the Layers panel which displays a list of
the layers. See Layers

Tools Activates the Tools panel which displays a list of
available tools. See Tools

Jobs Activates the Jobs panel which a list of available
jobs. See Jobs

Layouts Activates the Layouts panel which displays a list
of available layouts.

See Lay-
outs

Libraries

Activates the Libraries panel, displaying a list of
libraries according to Settings ---> General Set-
tings ---> Directories ---> Library Directory set-
tings.

See
Libraries

Properties Ctrl + Q Displays properties of the selected items. See Prop-
erties

Preview Opens the Preview window, which is an overview
of your whole graphical design.

See Pre-
view

Quick Access Activates the Quick Access view which enables
immediate access to a particular job. See Jobs

Layer
Objects

Activates the Layers Objects view which displays
a list of the object on specified layer.

NC Views Within this sub-menu helper panels in NC mode
can switched ON or OFF.

Camera Activates the Camera panel which displays view
of the attached camera.

Auto Hide All Enables Auto hide to all enabled/visible panels in
CircuitCAM window.
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3.1.1.11 Documents
The Documents menu allows to switch between currently opened CAM documents. It is
dynamical menu. Items are appended in case new CAM document is opened and items are
removed in case CAM document is closed.
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3.1.1.12 Help

Ico-
n Function Hotkey Description Further

Info.

Help Topics F1

Opens an online Help index and a table of contents for
CircuitCAM.
To use context-sensitive Help call the special cursor
type , which provides context-sensitive help for
many CircuitCAM 's interface elements. This cursor

type can be called with Shift + F1 or the button
from the Main toolbar.

Activate
Product

Opens the CircuitCAM Activation wizard dialogue
window, where the user information is presented.See wizard dialogue window

Figure 91. CircuitCAM Activation Wizard window

About Cir-
cuitCAM

Displays the version number of CircuitCAM and our
contact information.
This window also displays the personal information of
the registered owner.
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3.1.2. Toolbars
CircuitCAM has a number of toolbars which include buttons with associated functions. The
showing/hiding of a toolbar is managed throughout the Toolbars submenu of the View menu.
A user can move a toolbar to any applicable place of the window by using the mouse.

To move a toolbar:

l Place the mouse pointer on the area between the buttons on the toolbar or on the title bar
of a floating toolbar.

l Drag the toolbar to a new position with the left mouse button pressed. The toolbar will
automatically be docked at the edge of the window if you drag the toolbar to the edge of
the application window.

3.1.2.1 Standard
The Standard toolbar provides standard functions such as open, save, print and list boxes for
tool lists and apertures/tools. Almost all of these functions can be called from the File and Edit
menu as well.

Figure 92. Standard toolbar

New Create a new document. See
New

Import Import production data into the active document. SeeImport

Open Open an existing document. See
Open

Save Save the active document. See
Save

Cut Cut the selection and put it into the Clipboard.

Copy Copy the selection and put it into the Clipboard.

Paste Insert the Clipboard contents.

Print Print the active document. See
Printing

Print preview Display full pages.

Undo

Undo the last actions.
Maximum number of actions is defined in: Gen-
eral: Undo Depth in Settings -> General Set-
tings menu.

Redo Reverts the previously undone action.
Active configuration (tool list)
indicates the active configuration/tool list of the
active config-item/aperture/tool.
Active config-item/aperture/tool
indicates the active config-item / aperture / tool
that is either the one of the selected graphic
object, or that is used to create new graphic
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object. In the case that several graphical objects
are selected based on different config-items the
field is empty, when changing the active config-
item, the actual selected graphic objects are
changed for this.

Note: By clicking right mouse button on
the active config-item Aperture/Tool Properties
dialogue will appear. See also Aperture/Tool
Properties

3.1.2.2 Zoom
The Zoom toolbar provides the buttons to zoom in/out the graphic view and to set the layer
properties. All functions can be called from the View menu as well.

Figure 93. Zoom toolbar

Zoom window Fits the selected area to the screen.

Zoom out Reduces the visible drawing by the increments of 50%

Zoom scale Zoom the drawing to a predefined scale factor.

Zoom in Enlarges the visible drawing by the increments of 200%

Overview Fit the drawing to the screen.

Zoom selected Fit selected objects to the screen.

Refresh
Refresh all views.

3.1.2.3 Select
The Select toolbar provides buttons to select graphical objects. All functions can be called
from the Select menu as well.

Figure 94. Select toolbar

Select
Layer Select all objects of the active layer. See Select layer

Select
Aperture/Tool

Select all flashes with the same aper-
tures/tools on all layers. See Select aperture/tool

Select All Select all graphical objects on all layers. See Select all

Invert
Selection

Select all not selected graphical objects
and deselect previously selected objects.

See Invert Selection

Select
Path

Paths may be selected if this function is
enabled (framed menu icon means ena-
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ble).

CTRL + click on a button ena-
bles selection of a particular object
type. 

SHIFT + click on a button ena-
bles selection of all object types.

Select Poly-
gon

Polygons may be selected if this function
is enabled (framed menu icon means ena-
ble)

Select Cir-
cle

Circles may be selected if this function
is enabled (framed menu icon means ena-
ble)

Select Rec-
tangle

Rectangles may be selected if this func-
tion is enabled (framed menu icon means
enable)

Select
Pad/Hole

Pads/Holes may be selected if this func-
tion is enabled (framed menu icon means
enable)

Select Sub-
layout

Sub-layouts may be selected if this func-
tion is enabled (framed menu icon).

Size
Limit... Restrict size for selected objects. See Select

New Selec-
tion

Reset previous selections in the event of
a new selection.

Add to
Selection

Add a new selection to the selection
group.

Remove
from Selection

Remove an existing selection from the
group.

3.1.2.4 Insert
The Insert toolbar provides buttons used to add graphical objects. All functions can be called
from the Insert menu as well.

Figure 95. Insert toolbar

Insert
Open
Path

Insert a new open path that consists of one or more lines or
arcs segments. See Open Path

Insert
Closed
Path

Insert a new closed path (the last path point will be joined to
the start point).

Insert
Polygon

Insert a new polygon that is a filled area, defined by an outline. See Polygon

Insert
Rectangle

Insert a new rectangle. See Rectangle

Insert
Pad

Insert a new pad (flash). See Pad

Insert
Circle

Insert a circle with a fixed diameter. See Centre +
Radius method
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on page Circle.

Insert
Circle

Insert a circle dynamically defining radius.
See Centre
method on page
Circle.

Insert
Circle

Insert a closed path circle with a fixed diameter.

See Circle in
closed path
method on page
Circle.

Insert
Arc

Insert a new arc, where the circle sector is determined by defin-
ing the centre point of the circle. See Arc

Insert
Arc

Insert a new arc, where an additional point on the arc deter-
mines the circle sector. See Arc

Insert
Text Insert a new text. See Text

Insert
Data
Matrix

Inserts a Data Matrix barcode. See DataMatrix

Insert
QR

Inserts a Quick Response Code (QR). See QR Code

Insert
Sublayout

Inserts a sub-layout (selected instance) in the current active lay-
out.

Line
Mode 45°

Aligns the segments and arc segments so that the mouse cursor
only moves by an angle of 45 degrees and increments. Only
active while drawing.

See Line Draw-
ing Modes

Line
Mode 90°

Aligns the segments so that the mouse cursor only moves by an
angle of 90 degrees and increments. Only active while draw-
ing.

See Line Draw-
ing Modes

Select
inserted
object

If this option is on, the inserted(pasted) objects are selected in
addition to the previous selected ones. If this option is off the
inserted(pasted) objects are not selected or active.

3.1.2.5 Layer
The Layer toolbar presents buttons to customize the display for layers.

Figure 96. Layer toolbar

Layers Show the Layers list. See
Layers

Active Layer
Select a layer to activate.

Move Layer to
Zero

Move an active layer to zero.

Match up Layers
When this button is enabled (framed icon means enabled),
select a flash (source layer and its point) by a mouse click,
move the cursor to another flash in the destination layer
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(rubber band shows the road from the first point). This option
works on flashes only (the nearest flash is selected).

3.1.2.6 Grid / Unit
The Grid/Unit toolbar provides buttons to customize; the coordinates, grid, cursor grid and
measurement units. All functions can be called from the Edit, Modify and Display menu as
well.

Figure 97. Unit / Grid toolbar

Set Zero
Point

Set Zero Point

Absolute
Coordinates

Mouse position in absolute coor-
dinates.

Relative
Coordinates

Mouse position in coordinates
relative to the Anchor Point..

Cartesian
Coordinates

Mouse position in Cartesian
coordinates.

Polar
Coordinates

Mouse position in polar coor-
dinates.

Measurement Unit
Select a measurement unit.

Decimal
Places

Change the number of decimal
places that a unit is measured in.

Toggle
Grid

Show/hide the grid on the
graphic window.

Grid Spacing
Change the spacing between
grid lines.

The field with the drop down list is acti-
vated after the Toggle Grid button is
pressed.

Snap to
Grid

Turn on and off the snap to grid
feature.

Cursor Grid Spacing
Select grid spacing for the posi-
tioning of the graphical objects.

The field with the drop down list is acti-
vated after the Snap to Grid button is
pressed.

Move
Point/Segment

Move Point/Segment. See Move Point/Segment

Add
Point/Segment

Add or Append. See Add Point/Segment

Cut
Point/Segment

Cut into segments. See Cut Point/Segment

Delete
Point/Segment

Delete Point/Segment. See Delete Point/Segment
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Create
Move Arc

Create or Move Arc. See Create or Move Arc

3.1.2.7 Relative Rotations
The Relative Rotations toolbar provides buttons to rotate and mirror the selected objects
around the anchor point. All functions can be called from the Edit menu as well.

Figure 98. Relative Rotations toolbar

Value Enter an angle for a relative rotation.

90° Rotation angle 90°

180° Rotation angle 180°

270° Rotation angle 270°

Mirror horizontal
Mirror vertical

3.1.2.8 Flash Rotations
The Flash Rotations toolbar provides buttons to rotate and mirror selected objects around its
(0,0) points (location of flashes is not changed). All functions can be called from the Edit menu
as well.

Figure 99. Flash Rotations toolbar

Value Enter an angle for a flash rotation.

0° Rotation angle 0°

90° Rotation angle 90°

180° Rotation angle 180°

270° Rotation angle 270°

Mirror horizontal
Mirror horizontal + 90°
Mirror vertical
Mirror vertical + 90°

3.1.2.9 Full Screen
The Full screen toolbar consists of one button, which switches on or off full screen mode
(opens the graphic representation view to the full monitor size).
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Figure 100. Full screen toolbar

3.1.2.10 GMC
Buttons used to perform various operations to change geometry of pads.

Figure 101. GMC toolbar

GMC
Open the Geometry Manipulations Centre (More details; Geome-
try Manipulation Centre).

Button is activated
if some objects are
placed on Sol-
derPasteTop_Mark
layer.

To
Mark

Move selected objects from the SolderPasteTop_Work layer to the
SolderPasteTop_Mark layer (only elements on the _Mark layer
can be edited by the Geometry Manipulation Centre).

To
Work

Move selected objects from the SolderPasteTop_Mark layer to the
SolderPasteTop_Work layer.

To
Mark

Move selected objects from the SolderPasteTop_Modified layer to
the SolderPasteTop_Mark layer.

To
Ready

Move all objects from the SolderPasteTop_Mark and Sol-
derPasteTop_Modified layers to the SolderPasteTop_Ready layer.

To
Work

Move selected objects from the SolderPasteTop_Ready layer to
the SolderPasteTop_Work layer.

Init

Copy all objects from SolderPasteTop layer to the Sol-
derPasteTop_Work layer. All configurations used in the design are
copied to a new configuration named oldname_Work. If Ger-
berDefault was used in the design, a new configuration Ger-
berDefault_Work is created.

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved.

3.1.3. Status Bar
The status bar at the bottom of the application window, displays information regarding an
object or a function selected.

Figure 102. Status bar
The status bar is divided into four information areas:

1. Textual information:

l what is selected (nothing/a few objects/open path/closed path/ rectangle and etc.);
if only one object is selected, the current position of the object (numbering) is
shown at the beginning (#22);
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l in case of a path, the additional format (total_number_of_points:current_number,
Segment_type) and the path width are shown.

2. Number of selected objects;

3. Current coordinates of the cursor;

4. Coordinates of the anchor point .

Note: Double click on this area to copy coordinates of the anchor point to Clipboard.

A user can change visibility of the status bar by selecting the Status bar entry from the Tool-
bars sub-menu of the View menu.
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3.1.4. View arrangement
A user has a possibility to change the layout of views in CircuitCAM according his needs:

l Dock view to editing frame,

l Move view outside the CircuitCAM window,

l Auto-hide views,

l Reset layout of views.

3.1.4.1 Dock View
View can be fastened to one side of CircuitCAM frame or to a location in the editing frame.

l Click with a mouse on a view title.

l Drag the view into the middle of CircuitCAM window. The guiding arrows appear on
the screen.

l To position the view, move it over the guide arrows. The destination is as shaded.

Figure 103. Guiding arrows and shaded designation area

l Release the mouse button, when the view is at the desired place.
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3.1.4.2 Move View Outside CircuitCAMWindow
l Click with a mouse on a view title.

l Drag the view outside the CircuitCAM window.

l Release the mouse button.

Note: To return the view back to the initial position, double click on the title of the view.

3.1.4.3 Auto-hide View
When a view is auto-hidden, its name and icon are displayed on a tab at the edge of the Cir-
cuitCAM frame.

l Select a view to auto-hide.

l Select the Autohide item in the view menu or press the button with a pushpin icon.

Figure 104. Auto Hide item in view menu and pushpin button
Tab of auto-hidden view is displayed at the edge of the CircuitCAM frame. To use the window
again, move the mouse pointer over the tab so that it slides back into view.

Figure 105. Tabs of hidden views
To turn off auto-hide mode, perform the steps listed above.

3.1.4.4 Reset Layout
To reset views to the default location, select the Settings menu, General Settings -> Reset to
Defaults the click the checkbox of Docking Panes.
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3.1.5. Message Log
The Message Log window displays various log/report messages generated by CircuitCAM
after performing various operations. The text of the message log can be selected (Ctrl + point

on the line with a mouse), copied ( button), removed ( button) and saved ( button).
The message log window:

l Shows a log of functions such as import of the data;

For the import example shown below, the log indicates the path of the imported file and the file
type (e.g. Gerber, Excellon, G-Code,...etc), also shows the used layers, configuration and
tool/aperture list, together with the number and length of usages of each tool.

Figure 106. Message log view, import log

l Shows a log of production data export;
For the export example shown below, the log indicates the used layers, phases, objects, number
of objects, their perimeter, moves, tool usage ,the number of tools used, flashes, paths, seg-
ments and length and at the bottom of the log export directory, job type and execution time are
stated.
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Figure 107. Message Log view, export log

n Displays characteristics/errors of others CircuitCAM functions (e.g., time which was
used for import);

n Displays error messages of many others CircuitCAM functions.
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3.1.6. General Settings
The General Settings dialogue window allows the user to change main user and document
related preferences of CircuitCAM. This dialogue window can be called from the Settings
menu.
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Figure 108. General Settings dialogue window

3.1.6.1 User Related
The User related section allows the user to customize CircuitCAM software.

General Panel

l Undo Depth: configures the size of the command stack to return an object to the state it
was in before the last action.

l Measurement Unit: defines the measurement units from the predefined list of units
(drop down list).

.
Figure 109. Measurement unit drop down list

l Decimal places: specifies a number of decimal places that a unit is measured in (use up
and down arrows next to the field to increase and decrease numbers).

l Hide trailing zeroes: if On, trailing zeroes are hidden.

Display Panel

Helps to customize display settings:
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Figure 110. Display panel

l Show arc centre point markers: if On, the arc centre point marker appears on the
screen after the arc is selected.

l Background of the graphic area can be set to Black orWhite by setting On a particular
check box.

l Big Cursor: if On, the mouse cursor appears as two perpendicular lines on the graphic
area.

l Centre cursor position when zooming: if On, the zoom centre is a cursor position.

Directories Panel

Helps to customize folders for template, translation files:
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Figure 111. Directories panel

l Aperture Template Directory (*.txt): for the aperture template (translation).

l Library Directory (*.gmc): for the library directory for GMC, Library exchange and
Package recognition.

l Frame Directory (*.cam): for the Frame Generator Graphic from File mode.

l New Template Directory (*.cat): for the CircuitCAM template CAT files.

l Default Template Name: The default template is used when CircuitCAM is started
with no specified CAM document. In this case the document is named "Untitled N" (N
= 1,2,3...) and based on the default template. Also when creating a new CAM document
without specifying a template file the default template is used. During installation the
default template is set to default_insulate.cat. User can specify another template file as
needed.

User Information Panel

Allows a user to personalize CircuitCAM software.
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Figure 112. User Information panel

l User: Specifies the user details (first name, last name).

l Organization: Specifies details of the user's organization.

l Location: Specifies a location of the organization.

l Enabling Number (Licence ID): Contains the enabling number, which is entered
together with the serial number, during the installation process.

l Language: Specifies a language for CircuitCAM software. User can either select one of
already existing languages from the list or adapt CircuitCAM to his vernacular. For more
details see Language support.

Default Configuration

Default configurations/tool list are needed during export, in the case that no specific con-
figuration/tool list is defined, see export task under "create new aperture/tool list". The infor-
mation provided in the default configurations is identical to the information under tool list
properties. The default properties are defined for each format independently.
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Figure 113. Default Configuration dialogue window

Gerber Import Panel

When CircuitCAM is started, Gerber Import options are taken from the registry. Every time
during opening a new document (File -> New), the Gerber Import options are read from the
corresponding CAT file (if these options are already in this CAT file). The user can change
these options either in the General Settings/Gerber Import by writing them into the CAT file
or in the Import dialogue window without writing these updates into CAT file. In both cases the
current values will be saved into the registry while closing CircuitCAM.

(128)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Figure 114. General Import panel

l Use layer name (LN): if Off, always use the layer names from LN commands (despite
the fact it was used only once);

l Use layer polarity (LPC): a possibility to ignore LPC/LPD commands.

l Rotate square: On = old mode, when aperture is rotated during a drawing process; Off
= path is drawn as a polygon and its width depends on a rotation angle (the aperture
always remains in the zero rotation).

l Step and Repeat to flash (SR): if On, repeated group is Special flash; Off - is similar
to the denested flash.

l Rotate AM-Octagon during GERBER import: if On, an octagon is rotated by 22.5
degrees to compare with others Aperture Macro (AM) primitives of type Polygon. It
means that AM octagon is converted into Aperture Definition (AD) regular octagon.

l AM rotate absolute: if Off, CircuitCAM rotates every AM primitive around the point
0/0. If On, CircuitCAM rotates every AM primitive around its reference point according
to this table (primitive Reference point): 2/20 - start point, 21 - centre point, 22 - lower
left point, 4 - start point, 5,6 and 7 - centre point.

l Set 360 interpolation as default (G75): with Off the quadrant circular interpolation is
used.

Excellon Import Panel

This panel allows a user to modify import parameters for Excellon file and save modifications
in the current template file.

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
(129)



CircuitCAM 7.5

Figure 115. Excellon Import panel

l Pattern to Macro (M25):

l Fiducial Diameter (M12):

l Pin Hole Diameter (M11):

Predefined Pitches Panel

Figure 116. Predefined pitches panel

The combo box, that lists some pre-defined values of typical pitches. Some default values are
presented in the list, but a user can enter own pitches as well.

Recognition Panel

This panel helps to control the applying of footprints after package recognition procedure.

Figure 117. Recognition panel
Apply footprints after package recognition: if ON, CircuitCAM will perform apply foot-
prints after each package is recognised.
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Diverse Panel

Allows specification of the following parameters:

Figure 118. Diverse panel

l Breakout Tab: for the Create Gap function.

l Fiducial Diameter.

3.1.6.2 Document Related
The Document Related section helps to customize document parameters. If the option Save to
default template file (default_insulate.cat) is set On, the modified settings will be saved to the
selected template file.

Accuracy Panel

This panel helps to change the calculation parameters:

Figure 119. Accuracy panel
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l Resolution of Polygon Package.

l Tolerance 'Compare shape/BBox/Outline' [abs]: for the Compare Shape, Compare
Bounding Box and Compare Outline functions.

l Tolerance 'Draw to Flash' [%]: for the Compare Outline and Draw to Flash functions.

l Tolerance 'Perfect Shape' [%]: for any testing on perfect shape function (Shape
Manipulations, Draw to Flash, Convert selected shapes to polygons in GMC) .

l Angle for Compare: specifies either current compare angle (when flag Use angle in
steps is Off) or rotation step (when Use angle in steps is On).

l Package Recognition Pitch Tolerance: for Package Recognition function.

l Save to template file : By default the generated file will be saved to the default tem-
plate in the Directory panel that was created. (when flag Save to template file is On it
will save to another *.CAM file) .

Export Strategy Panel

The panel allows specifying of a sorting strategy for a different type of packages during export.
The following sorting types are available: XParallel, YParallel, XMeander, YMeander, Spi-
ralInward, SpiralOutward, Local (sort shortest distance, but within the footprintOccurrence)
and Global.

Figure 120. Export Strategy panel

l Category: specifies the type of a package.

l Strategy: specifies the sorting types.

l Add: a button to add a new table entry.

l Remove: a button to remove the selected table entry.

(132)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Colors Panel

The panel allows modifying of colors for selected and not selected objects.

Figure 121. Colors panel

l Defaults: a button to restore colors to defaults.

Import Assignment Panel

If the production data are used with the specified file extensions, e.g.: drl, sld, cmp, Cir-
cuitCAM provides a possibility to add an import assignment to automate and simplify the
import.
These import assignments can also be effectively used by the script task "Import"(see "Script
Tasks") inside script job named "Default"(for details check "Batch and Background
Processing").
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Figure 122. Import Assignment panel

l Add button: creates an auto row in the table, where new entries can be made.

l File Name: specifies a name or an extension of the file to be imported. See table below,
how the import assignment should work (* - any character (one or many), ? - any char-
acter (one)):
File name File-spec show Import Dialogue
aaa.gbx *.gbx No
aaa.gbx ???.gbx No
aaa.gbx aaa.gbx No
aaa.gbx aaaa.gbx Yes
aaa.gbx bbb.gbx Yes
aaa.gbx aba.gbx Yes
aaa.gbx ?a?.gbx No
aaa.gbx ?b?.gbx Yes
aaa.gbx ????.gbx Yes
aaa.gbx a*.* No
aaa.gbx a*.gb? No
aaa.gbx a*.g* No
aaa.gbx a*.g? Yes
aaa.gbx .gbx Yes
aaa.gbx *.?bx No
aaa.gbx aaa.gbr Yes

l Type: specifies a type of the file.

l Layer/Template: specifies the matching layer or template for the specified file.

l Aperture/Tool List: specifies a name of the list to store the apertures or tools in Cir-
cuitCAM.

l An incorrect or redundant import assignment can be removed from the table by using
Remove button.
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3.1.6.3 Reset to Defaults
This panel allows a user to reset modified settings to CircuitCAM defaults.

Figure 123. Reset to Defaults panel
The following settings can be updated, if the option is set On:

l User Settings.

l Document Settings.

l Dialogues.

l Toolbars and Main Menu.

l Docking Panes.

l Lists.

l Keyboard assignments
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3.1.7. Customize
The Customize dialogue window helps a user to modify menu options, toolbars layout, the key-
board mapping, menu settings, and general preferences. The Close button quits the cus-
tomizing.
To open the Customize dialogue window right click on any toolbar and choose Customize
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3.1.7.1 Toolbars

Figure 124. Customize dialogue window, Toolbars panel

l Toolbars: a list of available toolbars. If flag is set On, the particular toolbar appears on
the CircuitCAM main window.

l New button: invokes the New Toolbar dialogue window to create a new toolbar:

Figure 125. New Toolbar dialogue window

l A name of the toolbar should be entered into Toolbar name field. After the OK is
pressed, the new toolbar appears in the Toolbars list.

l Rename button: invokes the Rename Toolbar dialogue window to rename the selected
toolbar:

Figure 126. Rename Toolbar dialogue window

l A new name of the select toolbar should be specified into the Toolbar name field. The
changes are confirmed with the OK button.
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l Delete button: removes the selected toolbar.

l Reset... button: resets the default toolbar settings to the selected toolbar.

Note: For a predefined toolbars, such as Standard, Layer and etc., Rename and
Delete buttons are disabled. The modifications can be applied only for the user created tool-
bars.

3.1.7.2 Commands
A new command can be added to the existing toolbar, menu or submenu.

Figure 127. Customize dialogue window, Commands panel

l Categories: a list of the available categories.

l Commands: a list of available commands for the selected Category.
To add a command to a toolbar/menu: select a category and drag the command out of the dia-
logue window to the preferable toolbar.

3.1.7.3 Keyboard
Allows a user to create, modify and load from the file a set of function key assignments for A-
Z, 1-9, F1-F12 and their combinations with Alt, Shift, Ctrl, Alt+Shift, Alt+Ctrl, Shift+Ctrl
and Alt+Shift+Ctrl. Created keyboard shortcuts are not case sensitive, e.g.: Characters 'a' or
'A' are the same 'A'. Created shortcuts are stored in XML files. The Keyboard panel has fol-
lowing controls:
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Figure 128. Customize dialogue window, Keyboard panel

l Category: a list of the available categories.

l Commands: a list of commands for which the shortcut can be created.

l Key assignments: shows already assigned shortcuts for the selected Command.

l Press new shortcut key: Click Assign to add the definition from the Press new short-
cut key field to the Key assignments field.

l Description: displays a brief description of the currently selected command.

l Assign button: assigns the new shortcut. It automatically appears in the Key assign-
ments list.

l Remove button: removes the selected shortcut. Select a key assignment from Key
assignments field and click Remove to delete it.

l Reset All button: loads the default shortcut file.

3.1.7.4 Options
The Options panel has the following controls:
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Figure 129. Customize dialogue window, Options panel
Personalized Menus and Toolbars group

l Always show full menus: If On, full menus are displayed.

l Show full menus after a short delay: If On, the selection of the commands is displayed
in menus. However, after a short delay, the full menu appears.

l Reset menu and toolbar usage data: Restores the default set of visible commands on
the menus. A click on the button does not undo any customizations you have done.

l Large icons: If On, enlarges the icons on the screen to make them easier to see or to
access.

l Show Screen Tips on toolbars: If On, displays a short help text when you place the
mouse pointer over a toolbar button.

l Show shortcut keys in Screen Tips: If On, the possible keyboard shortcut is displayed
in addition to the short help text.

l Use the Menu Animations drop-down menu to select the type of menu animations. The
available options are 'System default', 'Random', 'None', 'Unfold', 'Slide', and 'Fade'.
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3.1.8. Online Help
CircuitCAM provides a context sensitive help and an online help.
The context-sensitive help can be called directly with F1.
The online help is presented in a separate window, where you can find a Help content and a
Help index to find an applicable topic or term quickly.
To invoke the online help, select in the main menu Help ---> Help Topics.
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Figure 130. Help -> Help Topics menu
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3.1.9. Preview / World View
The preview displays either the graphics of the selected tool in the Tools view, or the selected
library item in the Libraries view, if these views have the focus. Otherwise it displays the
world view of the current layout.
The Preview window is set Default to appear in the bottom right corner of the window, to
switch Preview on/off select in the main menu View -> Preview.

Note: The same window is used for world view and preview. All depends on the cur-
rently focused context.
By clicking on the mouse in the preview area, world view window will focus on the clicked
area, if the mouse is still clicked on and dragged all over the preview the main view will move
and be dragged as the preview area.

Figure 131. World view of Graphic view
For example, the preview of a tool is visible if the tool is focused in the Tools view.
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Figure 132. Preview of Tool
This Preview window can be used to explore libraries content as well. The Preview window
will display graphical content of a library, if the library item in Library view is focused.

Figure 133. Preview of Library content (BGA package)
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3.1.10. Handling of Esc Key
The Esc key can be used for cancelling or interrupting operations executed in CircuitCAM.
Additionally, the Esc key is used to bring the focus back to the Graphic view. Depending on
what is currently selected, escape works in a multistage process; so several Esc key presses
might be needed. In case that a graphical object is currently created or edited, alternatively the
right mouse button can be used to end this operation.

Example 1

The focus is in the Layers view. There are more than one selected layer in the Layers view
and a graphic object (i.e.: path) is selected in the Graphic view.
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Figure 134. Selected layers in Layers view, highlighted path in Graphic view
1st Esc: All layers are deselected in the Layers view, except the focused one (i.e. "Bot-
tomLayer").
2nd Esc: Focus switches from the Layers view to the Graphic view.
3rd Esc: The path is unselected in the Graphic view.

Example 2

The focus is in the Layers view. There is one selected layer in the Layers view and a graphic
object (i.e.: path) is selected in the Graphic view.
1st Esc: Focus switches from the Layers view to the Graphic view.
2nd Esc: The path is unselected in the Graphic view.
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3.2. CAM and CAT Document Handling
CircuitCAM documents are stored in files that are based on the CircuitCAM format with the
file-name extension "*.cam"; we also call them CAM documents. The same file format is also
used for:

n Template files with the file-name extension "*.cat" and stored in the "New_Templates"
installation directory.

n Library files with a file-name extension in the form "*.cat-xxx" where "xxx" indicates
the type of library, e.g.: "*.cat-pkg" for the package library. These files are stored in the
"Libraries" installation directory.

When starting CircuitCAM without any file specification, or when using the New submenu, a
new CAM document is created with the name "Untitled N", where N is the sequenced number
of the document (1, 2, 3 ...).
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The document name is always displayed in the title bar. If an asterisk "*" is displayed in the
title bar after the name of the document, this means that there are unsaved changes in the cur-
rent document/project.

CAM and CAT documents can be handled through various operations:

n New,

n Open,

n Save,

n Print,

n Synchronize,

n Libraries.

Note: It is recommended to frequently save your modified documents, especially after
major modifications or before taking a break from work.
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3.2.1. Open
Opens an existing CircuitCAM document/project/footprint/package or library.
You can open your documents in one of the following ways;

n By selecting Open from the File menu.
n Pressing the keyboard shortcut Ctrl + O.
n Clicking the open icon in your standard toolbar.
or

n By double clicking an existing CAM file through your file browser.
After doing any of the first three steps, a browsing window will appear allowing you to browse
in your computer choosing the file to open.
The "Files of type" filter controls which file formats to be shown; CAM files, templates,
GMC libraries, footprints, packages, or all files *.*. By default, the filter is set to show all
files that are compatible with CircuitCAM file formats.

Figure 135. Open file dialogue

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
(143)



CircuitCAM 7.5

Note: You can see a list of your recently opened files and documents in the Recent Files
submenu under the File menu.
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3.2.2. Synchronize

With synchronize, the currently displayed CAM document is modified in such a way that it
becomes compatible with the selected CAT (template) file. This is done by copying layers,
tools and jobs from the selected template file to the currently active document.
In addition the selected CAT file is stored as the Underlying CAT File of this document.
The CAM document can either be synchronized with one of the default template files, or it can
be synchronized with a user created template.

Note: To add new template file(s) to CircuitCAM, please follow the following pro-
cedures:
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n Using the file browser navigate to the place of the new template file.

n Make a copy of the new template file and paste it in the New_Templates in the main
CircuitCAM installation directory, this folder contains all the template files that Cir-
cuitCAM uses.
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3.2.3. New
CircuitCAM offers two ways of creating a new document:

1. Use the document based on the default template file "default_insulate.cat" which is
selected automatically in CircuitCAM when the program starts.

2. Create a new document by selecting a pre-configured template file from the New sub-
menu under the File menu.

If there are no *.CAT files an internal empty template is used.

Note: New documents are always named "Untitled" followed by sequenced numbers for
multiple documents.

You can create new documents in one of the following ways;
n by selecting New from the File menu.
n pressing the keyboard shortcut Ctrl + N.
n clicking the open icon in your standard toolbar.

Note: Pressing the keyboard shortcut Ctrl + N or clicking in the toolbar, will start a
new document using the default template file.

New Templates

CircuitCAM allows users to create a template file with user-specific settings, which are com-
parable to "format templates" files in a word processor.
Template files allow the users to save time and implement standards more effectively. Com-
monly-used lists may be saved as a template. For example, if the same aperture list and tool
list are used frequently, the user can create a template file that contains both lists. All current
settings, such as names and colors of the layers, are also saved in this template file. This tem-
plate may be used as the basis for other circuit board designs. Thus, there is no longer a need
to import these lists again and again.
CircuitCAM template files have the same build and internal format as CAM, but they have the
extension "CAT" so that they can be distinguished from each other.

To create a new template file;

n Create and/or select the wanted jobs, scripts, tools, layers, colors....etc

n Under the File menu, select Save As, and from the filter menu, select Template (*.cat),
the desired template name is entered.
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Note: The saved templates can be synchronized into any other CAM document, see Syn-
chronize.

For more information see CAT.
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3.2.4. Import
One of the CircuitCAM functionalities is the importing of production data (apertures, circuit
board or drilling data). To perform this, select Import from the File menu. The Select files
for import dialogue window is displayed.

Figure 136. Select files for import... dialogue window
After the selection is made (one or multiple files) and the Open button is clicked, the following
Import dialogue window is displayed.
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Figure 137. Import dialogue window

l Import: if is selected, import is enabled; if is selected, import is disabled (the
import state can be changed by clicking on the icon).

l File Name: indicates the name of the file to be imported.

l File-Type: specifies the type of the file. The file is recognized by CircuitCAM and its
type is set automatically. In case the file was not recognized, or the user wants to
change its file type, the selection of the file type can be done manually from the type
list. Aperture/Tool auto is shown if an aperture or tool list was recognized and just one
matching template was found. If more than one matching template was found - Aper-
ture/Tool select appears in the cell.

Note:: In case of IEC-1182/IPC-35x file type, the file is automatically imported without
showing the import dialogue window. The IecDefault configuration is used.

l Aperture/Tool List: if the file was recognized as an aperture or tool list, Aper-
ture/Tool List shows the name of the list to store the apertures or tools in
CircuitCAM. By default a file name is used as an aperture or tool list name. 
If the file was recognized as a data format, Aperture/Tool List shows a name of the list
to be used to import the data file.

l Layer/Template: shows the first matching template, if the file was recognized as an
aperture or tool list. Another template can be selected from the list box, if the first one
does not fully match. Templates are sorted by decreasing number of recognized
apertures. 
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If the file was recognized as a data format, Layer/Template shows the layer name to
store the data in CircuitCAM. The layer can be selected from the list box, according to
the content of the file. By default the file name is used as the layer name.

l Format/Size: if the file was recognized as a list of an aperture or a tool list, it shows
the format settings. If the file was recognized as a data format, max dimensions are
shown.

Graphic Panel

Shows the resulting graphical view, which depends on the currently selected parameters.

Text Panel

Presents the textual file contents.

Apertures Panel

Provides a list of apertures (tools) of the configuration, which was selected in Aperture/Tool
List list box.

Figure 138. Apertures panel

l Name: specifies the shape and the name of an aperture.

l Mode: specifies the using mode of an aperture.

l a, b, c, ..., j: these fields describe dimensions of the shape. E.g.:, a value means dia-
meter of a circle or width of a rectangle/oval; b – height of a rectangle; c – a bevel or
a radius for a bevel/rounded rectangle.

For more detailed description, please refer Tools section.

Format Panel

The Format panel contains the following information:

l Size X,Y: indicates the size (bounding box) of the imported board.

l Values: coordinates can be in an absolute or relative (incremental) form.
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l Unit: shows a unit (mm or inch), which is used to represent coordinates of all graph-
ical objects, drawn by using tools in the current configuration.

l Decimal position group: since the decimal point for coordinate values is usually not
given in the Gerber/Excellon/Sieb&Meyer format. The position of the decimal point
has to be determined by other methods. For this purpose, the m.n digits, and the selec-
tion from the decimal group are combined.

Note: For different File-Types this group has different fields. For NC_Drill an additional
Decimal Point field is provided, HP-GL and Barco types have no Digits m.n and Decimal
position groups at all. DXF type has a new DXF –Import: Field Circles flag to fill an
imported circle (otherwise the circle is assumed as a circle in Closed-path, i.e.:, a contour with
zero path Width).

l Digits m.n: these values are used if no decimal point format is set. "m" indicates the
number of digits before the decimal point and "n" the number of digits after the dec-
imal point.

Gerber Options Panel

The Gerber Options panel gives possibility to set some input options for Gerber and GerberX
formats (for other format types the button is invisible): 

Figure 139. Gerber Options panel

1. Use layer name (LN): if On, the names of the layer from LN commands will be used
always (despite that it was used only once);

2. Use layer polarity (LPC): a possibility to ignore LPC/LPD commands.

3. Rotate square: if On = aperture is rotated during drawing; if Off = a path is drawn as
a polygon and its width depends on a rotation angle - the aperture always remains in a
zero rotation.

4. Step and Repeat to flash (SR): if On, the repeated group is Special flash; if Off - is
similar to the denested flash.

5. Rotate AM-Octagon during GERBER import: if On, an octagon is rotated by 22.5
degrees to compare with others Aperture Macro (AM) primitives of type Polygon. It
means that AM octagon is converted into Aperture Definition (AD) regular octagon.

6. AM rotate absolute: if Off, CircuitCAM rotates every AM primitive around the point
0/0. If On, CircuitCAM rotates every AM primitive around its reference point
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according to this table (primitive Reference point): 2/20 - start point, 21 - centre point,
22 - lower left point, 4 - start point, 5,6 and 7 - centre point.

7. Set 360 interpolation as default (G75): with Off the quadrant circular interpolation is
used.

Note: Default values after CircuitCAM installation are: Use layer polarity (LPC) = On,
Rotate square = On and Rotate AM-Octagon during GERBER import = On. Others flags are in
Off state.

The Apply for all imported Gerber files option enables a user to set the
selected options to all imported Gerber files.

Attributes Panel

 The Attribute panel shows a shape and a size of an aperture/tool:

Figure 140. Attribute panel

l Type: specifies a shape of an aperture/tool.

l IEC61182: specifies a shape from the special shape library.

l a, b, c, ..., j: specifies dimension values of the aperture/tool.

l Preview: shows a graphical view of the selected type and explains the meaning of
fields (a/b/c/…/i/j) for this type.

l OK button runs an import operation. It is disabled if at least one obligatory assignment is
not done.

This dialogue window has one interesting feature – it allows direct editing of any aperture
while importing an aperture/tool list, and UNDEFINED (with icon in Apertures panel) aper-
ture while importing data file, in the Attribute panel.
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3.2.5. Saving your data.
CircuitCAM allows the user to save documents and projects in binary formatted files. These
files will store all the CAM data inside them.

Save

Saves the current document using the existing file name. In case of a new "UntitledN" doc-
ument, when pressing Save the Save As menu is activated instead.

Save As

This function, in contrast to Save, allows the user to define a file name, type and directory. The
standard Windows Save As dialogue window appears, in which the user can choose the appro-
priate data for the saved file. The data can be saved in all formats supported by CircuitCAM;
CAM files, templates, GMC libraries, footprints, packages, or all files *.*.

Figure 141. Save As dialogue window

Note: If an asterisk "*" is displayed in the title bar after the name of the document, this
means that there are unsaved changes in the current document/project.
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Figure 142. If the CAM document contains any unsaved changes, an asterisk "*" appears
next to the document name

Note: For .CAM document properties see Properties.
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3.2.6. Export
Allows the user to export production data into files in the common CAM formats Gerber, Excel-
lon, HP-GL and others.
Export is organized by Export Jobs that are a collection of Export Tasks. Export jobs have a
name and are stored in the local CAM file, so that they can be re-executed at any time. Default
export jobs are provided in the CAT files. An Export Task specifies a certain layer that to be
exported by using a specific configuration/tool list. User can create or modify Export jobs or
export tasks.
To see the available export jobs in the local CAM file, select Export from the File menu and
select an export job from one of these groups:
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Figure 143. Export menu content
When executing an Export Job, a statistic overview of the used config-items/tools and further
information is recorded in the Message Log.
When exporting in the basic Gerber format, an aperture file is needed in addition to the Gerber
file because the Gerber file is not able to contain the size and shape of the used apertures. An
aperture file is generated in the same directory of the Gerber file and the same file name with
an additional extension ".rep", See Example of Aperture List after Gerber File Export.

Note: The VIEWER variant of CircuitCAM does not allow any export jobs.

Further details on Export:

l Export Job
l Export Task
l Export Layout Instance
l Example of Aperture List after Gerber File Export
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3.2.7. Export Layout Instance
With export layouts instance a customizable ASCII file is created, which lists all layout
instances of the current layout; typically the main layout of the current document. The gen-
erated ASCII file is organized in such a way that it can be imported into typical spreadsheet
applications, such as Microsoft Office, Open Office or Google Doc. The ASCII file consists
of a header, that contains CAM file, user, organization, time and licence information. This is
followed by one line for each layout instance, consisting of the name of the layout instance, the
name of the layout, its category and group, the coordinates and rotations.

Note: This capability is available with CircuitCAM PRO only.
The Layout instances export job has additional Settings button to specify/modify export for-
mat:
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Figure 144. Layout instances export format dialogue window
The configurable format for each layout occurrence:
%x - Value of the x coordinate of the layout occurrence,
%y - Value of the y coordinate of the layout occurrence,
%r - Rotation in degrees,
%o - Name of the layout occurrence,
%d - Name of the layout definition,
%c - Name of the category of the layout definition,
%g - Name of the of lowest level group that contains the layout definition.
The default configuration string for layout occurrences is:
"%x, %y, %r, %o, %d, %c, %g"

In addition, a user may specify a multi-header format for a file:
%f - Name of the CAM-file,
%F - Name of the CAM-file including full path,
%u - Name of CircuitCAM user,
%o - Name of CircuitCAM organization,
%l - CircuitCAM licence id,
%t - Timestamp in YYYY-MM-DD HH:MM.SS ISO standard (ISO 8601).

The default configuration for the header is:
"# File = %F
# User = "%u", Organization = "%o", Time = %d
# Licence = %l"

The export file example with default form settings:
# Instances file generated by CircuitCAM 6.3.0.1304
# File = D:\Footprint recognition\Sample1.cam
# User = RA, Organization = KTU, Time = 2011-01-26 12:07:09
# Licence = 11223344
179.55, 128.299, 0.00, I1, BGA80P14x14-179/1(1).1, SolderPasteTop, BGA
222.271, 167.545, 0.00, I2, BGA80P14x14-179/1(1).2, SolderPasteTop, BGA
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226.507, 115.887, 90.00, I3, BGA80P14x14-179/1(1).3, SolderPasteTop, BGA
133.555, 133.1, 0.00, I11, BGA127P1x5-5/1(1).2, SolderPasteTop, LPCC
140.246, 112.684, 0.00, I12, BGA127P1x5-5/1(1).3, SolderPasteTop, LPCC
140.255, 133.1, 180.00, I13, BGA127P1x5-5/1(1).4, SolderPasteTop, LPCC

Detected format errors are listed in the Message Log window. For example:
ERROR in Export instances - Wrong (not supported) format %q.
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3.2.8. Example of Aperture List after Gerber File
Export
When exporting in the simple Gerber file format, an additional aperture file is needed that con-
tains the size and shapes of the used aperture, because this information is not included in the
Gerber file itself, below you can see an example of such a file.

Note: For other file format such as GerberX and Excellon the size and shape of the aper-
ture/tool is provided in the files and so no extra files is needed.
Example: aperture file "Tutor.gbr.rep", generated together with Gerber file "Tutor.gbr" In this
case the export job had only one export task:
# APERTURE LIST

# for the GERBER file C:\Program Files (x86)\Ci-
rcuitCAM7\ExampleData\Prototyping\Tutor.gbr

# Generated by CircuitCAM 7.1.2.2106

Export task : BottomLayer

Aperture unit : inch

Mode : Absolute

Unit : inch

Format : 2.4

Zeroes : Trailing Zeroes present

# Shape D-code Width Height Usage

Circle 12 0.011811 Both

Circle 11 0.039370 Both

Circle 13 0.043307 Both

Circle 15 0.051181 Both

Circle 14 0.059055 Both

Circle 16 0.062992 Both

Rectangle 19 0.098425 0.023622 Flash
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Export task : TopLayer

Aperture unit : inch

Mode : Absolute

Unit : inch

Format : 2.4

Zeroes : Trailing Zeroes present

# Shape D-code Width Height Usage

Circle 12 0.011811 Both

Circle 13 0.043307 Both

Circle 15 0.051181 Both

Circle 14 0.059055 Both

Circle 16 0.062992 Both
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3.2.9. Print
CircuitCAM has printing related functions in the File menu, such as Print Setup, Print and
Print Preview. The Print Setup and Print functions are standard Windows functions and
their dialogue-boxes are described in Windows documentation. To display a document (either
graphic or list window) as it should look when printed, select Print Preview function:
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Figure 145. CircuitCAM Graphic view
Print Preview has a menu with following functions:

n Print: prints the document.

n Next/Previous/Two pages: page selection modes.

n Zoom In/Zoom Out: a picture is shown enlarged /reduced by a factor of 2 around its
centre. To Zoom In around the specified point, use the special marker (magnifying
glass).

n Settings: provides a possibility to change the size, colors and the view mode of the dis-
played picture:

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
(157)



CircuitCAM 7.5

Figure 146. Settings dialogue window

n Enable Colors: if On, a picture keeps its original colors on the white background.
Otherwise only the black color for the foreground is used.

n Inverse: if On, the black color is used for the background and the white color for the
foreground. This option can be set On after the Enable Colors option is set Off.

n Autorotate: if On, a Portrait or a Landscape orientation is automatically selected to
refuse a free space.

n Mirror Y: if On, transforms a graphical image into vertically reversed form.

n Overview: all objects are displayed fitting the screen.

n Screen Display: only objects on the screen are displayed.

n 1:1: if On, the graphical object is displayed in its original size.

n Best fit according paper size: if On , the graphical object is resized to fit the win-
dow.

n Manual: user can scale the displayed picture by a new scale factor.

n One Page: always displays only one page (despite the Scale value).

n According to scaling: if the Scale value does not allow fitting a picture in one page,
the picture is split into the necessary amount of pieces-pages (see picture below). To
control an overlap of the picture, enter a value into the Overlap box. The default value
is 0 mm.

n Print file name: if On, the current file name is displayed on the top left corner of the
page.
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n Add full path to the file name: if On, the full path of the current file is displayed on
the top left corner of the page. The file name is added only if the Print file name is
On.

n Print scale factor: if On, the current scale factor is displayed on the bottom left
corner of the page.

n Use the Next and Previous buttons to walk throughout multiple pages.

Figure 147. Print preview of graphic on multiple pages

n By using the Next and Previous buttons a user can walk throughout multiple pages.

Printer Calibration

The printer calibration allows you to correct the aspect ratio of a printer in X and Y direction
to achieve higher accuracy. Due to low accuracy of common laser printers, objects printed on
an A4 sheet can appear up to 2 mm bigger or smaller as defined in data, the size might be dif-
ferent in width and height direction.To ensure a 1:1 print, CircuitCAM can compensate these
tolerances.
Printer Calibration is a multi-step process:

1. A big rectangle is printed with correction factors 1 in both X and Y directions.

2. The printed rectangle is measured with a ruler.

3. The measured values are entered in the Printer Calibration dialogue and Correction
factors will be calculated automatically from them.

4. For verification the big rectangle is printed again and measured. It should now have the
specified size.
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5. Now the normal printing function can be used. It will use the specified correction fac-
tors.

The dialogue window before the calibration:

Figure 148. Printer Calibration dialogue window

Rectangle size X
Defines the X dimension of the rectangle to be printed for the calibration. This value will be
used, when the option Use calibration is set Off or the X Correction factor is set to 1.
In case the option Use calibration is set On and the X Correction factor is not 1, Cir-
cuitCAM will use the corrected size while printing the rectangle.

Rectangle size Y
Defines the Y dimension of the rectangle to be printed for the calibration. This value will be
used when the option Use calibration is set Off or the Y Correction factor is set to 1.
In case the option Use calibration is set On and the Y Correction factor is not 1, Cir-
cuitCAM will use the corrected size while printing the rectangle.

Printed size X
Shows the X dimension of the printed rectangle without the calibration.

Printed size Y
Shows the Y dimension of the printed rectangle without the calibration.

Correction factor X
The factor will be used to scale images to be printed in X direction.
The value is updated when a new Rectangle size X or the Printed size X is entered. On the
other hand, when this value is changed, the Printed size X is updated.

Correction factor Y
The factor will be used to scale images to be printed in Y direction.
The value is updated when a new Rectangle size Y or Printed size Y is entered. On the other
hand, when this value is changed, the Printed size Y is updated.

Use calibration
Defines whether the correction factors will be used during printing. Correction factors will be
used to print the calibration rectangle as well.
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Print
Prints the calibration rectangle. If option Use calibration is On, the rectangle will be scaled by
the correction factors.
The calibration rectangle will be printed in an outline mode in a black color with a zero line
width in the centre of the page. In addition, a text will be printed on the top of the page:

n If the calibration is used: “Calibrated 250 x 180 mm”.

n If the calibration is not used: “Not calibrated 250 x 180 mm”.
The numbers depend on the Rectangle size values, and the unit depends on the Unit setting in
the General Settings.

OK
Closes the dialogue window and saves the values in the registry.

Cancel
Closes the dialogue window and ignores the changes.

How to process the calibration

1. Switch Off the Use Calibration check box.

2. Enter Rectangle Size values to get a rectangle which covers almost the entire page.

3. Click on Print button.

4. Measure the printed rectangle and enter the values into the Printed size fields.

5. Switch On the Use Calibration check box.

6. Click OK button to close the dialogue box and to save the correction values.

Figure 149. Printer Calibration dialogue window, Use Calibration check box

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved.

3.2.10. Read Out
In addition to "Properties view" which displays properties of a single selected object, and, "Sta-
tistics" which displays properties of all objects in a layout, the following analysis or readout
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operations are available for the graphics view;

n Measure.

n Pitch of Two Pads.

n Area of Selected Objects.

Measure

The Measure function calculates the distance between the last selected Anchor Point and the
current cursor position, and displays it simultaneously in Cartesian and Polar coordinates in the
status bar, to the left of the indication of the selected object (see image).

Figure 150. Status bar with Cartesian and polar coordinates
In the graphic window the distance is shown with a virtual line, starting from the anchor point
and ending with the current mouse position. As long as the Measure function is active, each
left mouse click restarts the measure calculation.
For taking precise measurements, it is needed that the mouse snaps to specific points on the tar-
get object. To achieve this, while the measure function is active, holding down the shift button
and clicking on an object will display all the marker points of the object. When clicking the
mouse button while the shift button is pressed does not restart the measurement. When moving
the mouse over a marker point, the cursor will snap to the exact position of this point.

Note: The Cancel operation (from context sensitive menu) or ESC button interrupts the
Measure function.

The Measure function is accessible by any of the following means:

n Going to the menu; Analysis---> Measure.

n Right click context menu;Measure.

n Keyboard shortcut; Ctrl + Shift + X.

Pitch of Two Pads

This function calculates the distance between the centre points of two selected areas (pads).
An area can consist either of one object (flash, path, rectangle, etc.) or of a few connected
(overlapped) objects on the same level. Different areas can belong to different layers as well 

Note: An area, which consists only of the undefined-flash or zero-radius circle, is
excluded, because of its PP polygon is zero. Such selection prohibits the pitch operation (a mes-
sage comes up).
If a number of selected areas is not 2, a message is shown as well.
The result of the operation is shown on the screen in a message like this:
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Figure 151. Pitch of two pads
Distance X: The change of the value on X-axis between the two centre points.
Distance Y: The change of the value on Y-axis between the two centre points.
Pitch: Is the distance between the two centre points of the areas.
Angle: Shows the angle between the line going through the centre points of the two selected
objects, and the X-axis.
Distance between facing edges: This is the distance between the opposite sides of the two
pads.

This dialogue allows the user to see the pitch and the space by just one click.
After pressing on the Select button, the Selection by Pitch dialogue window comes up (see
Pitch in Select menu).

Area of Selected Objects

Procedure:

l Select an object or a group of objects.

l Select in the main menu Analysis -> Area of Selected Objects.
The result of operation is shown in the screen as a message:

Figure 152. Selected Object message window for area
The Area text field in read-only mode shows an area of selected objects.
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3.2.11. Statistics
The Statistics window displays the number of tools and layouts in a document, either the cur-
rent CAM file or the selected library. Entries are summed up based on type (package, land,
etc.), category (BGA, PLCC, etc.). The Statistics dialogue for the current document is invoked
via File -> Statistics. The Statistics dialogue for a library file is invoked through the context
sensitive menu item Statistics in the Libraries view.
The results are displayed as dialogue box.

Figure 153. Statistics window
There is a possibility to copy statistic results to clipboard by selecting the lines of interest and
pressing Ctrl + C.
A user can group the entries in the Statistics dialogue according type, category and etc., by
dragging a desired column header onto the upper part of the dialogue window.
In the below example it is shown the initial view of the Statistics dialogue.

(164)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Figure 154. Statistics dialogue for BGA-default library

l Press with a mouse on the Object type column header, hold and drag onto the area
above the table. Two red arrows guides where the selection can be dropped.

l Release the mouse button. The column name appears on the top section of the dialogue.
The entries are grouped by the object type in the Statistics dialogue.
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Figure 155. Statistics entries grouped by Object type

l Press with a mouse on the Type column header, hold and drag onto the area above the
table.

l Release the mouse button. Types appears under Object type , showing the sequence of
grouping. The entries are grouped in the Statistics dialogue accordingly.

Note: The sequence of the grouping can be changed by moving column names. The sort-
ing in the table can be changed by clicking on the Column name.
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Figure 156. Statistics entries grouped by Object type and Type
To remove a grouping, drag a column name back onto the table column header.
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3.2.12. Batch and Background Processing

CircuitCAM can be started without or with additional program(command-line) parameters.

Parameters for the CircuitCAM can be specified:
a) by dragging files onto CircuitCAM icon.
b) specifying file names as command-line parameters.

Parameters can be:
a) CAM file name
b) CAT file
c) production data file names (like Gerber, GerberX, Excellon data file names) and etc.

If argument is CAM file name, the file is opened and the contend is displayed in CircuitCAM,
e.g.:
"C:\Program Files (x86)\CircuitCAM7\CircuitCam.exe" d:\Projects\tests\Tutor.cam
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If parameter is CAT file name, a new CAM document based on specified CAT files is created
(only in RAM, not saved).

Note: the additional flag/option "/cat" must be specified, otherwise CAT file will be
opened as CAM file.
Here goes the example how to use flag "/cat":
"C:\Program Files (x86)\CircuitCAM7\CircuitCam.exe" /cat d:\Projects\tests\test1.cat

If parameters are production data file names, CircuitCAM will check if default CAT file has
script job named "Default" and if jobs exists - it will be executed (more details how this can be
achieved - see below), e.g.:
"C:\Program Files (x86)\CircuitCAM7\CircuitCam.exe" d:\Projects\tests\Tutor.boa
d:\Projects\tests\Tutor.BOT

"Default" script job

"Default" is fixed name for a script job and this name gives special status for script job.
"Default" script job is automatically executed when CircuitCAM is started with additional
parameters(not CAM or CAT file name as additional parameters, but with production data file
names), e.g.:
"C:\Program Files (x86)\CircuitCAM7\CircuitCam.exe" d:\Projects\tests\Tutor.boa
d:\Projects\tests\Tutor.BOT

In general "Default" is regular script job which might:
- contain various script tasks such as "Import" and etc. (see "Script tasks")
- call other jobs such as insulate, counter-routing and export.

"Default" script job might have the parameter "Background processing" ON and in this case
no GUI will show up and CircuitCAM will terminate when execution of the job finished (see
other script job settings "Scripts (Batch Jobs)").

Note:production data files can be specified parameters for the CircuitCAM and these
might be automatically imported if the "Default" script job contains an "Import" script task.

The example content of "Default" script job can be:
- "Import" script task
- call the another script job "SMT Stencil"
- "Save" script task

Such a sequence of script tasks will perform import of production data, will call another script
named "SMT Stencil" (the parameters for this stencil script job must be specified in the call
job) and will save new created CAM file.

3.3. Graphic View
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The graphic view of CircuitCAM is always visible, and typically occupies the largest portion of
the program’s interface. The graphic view is always displaying a layout from the current CAM
document, by default the main layout is displayed. Another layout can be chosen from the Lay-
outs View. When in NC mode, GMC mode, or tool edit mode, a special temporary layout is
displayed.
The graphical data/objects in the currently displayed layout can be edited/created in the graphic
view. Initially the main layout is displayed, another layout can be chosen from the layouts
view.

Graphic Objects

The contents of any layout consists of graphic objects, that are assigned to layers. All graphical
objects define an area except for paths with a width of zero. We distinguish between basic
graphic objects and composed ones.
The basic graphic objects are:

a. Rectangle: A rectangle is defined by two opposing points, and is oriented parallel to the
X and Y axis.

b. Circle: A circle is defined by a centre point on the coordinates, and a diameter.

c. Path: A path is a sequence of lines and arc segments. A path maybe a Closed Path -start
and end point connected together- or it maybe and Open Path path -with distinct starting
and ending points.
- Line Segment: Straight lines which connects two points together.
- Arc segments: Circle arc segments which connect two points on a circle. Because of
numerical stability, a circular arc is typically limited to 270 degrees, arcs bigger than
that are automatically cut into two smaller arcs.
- Circle in Closed Path: A path which consists of a single segment that is one full circle.

d. Polygons: Any closed figure defined by a border which is the outline; this border con-
sists of a sequence of lines and arc segments, similar to those of a closed path. Nor-
mally these lines and arc segments are not allowed to touch or cross each other.

e. Polygon Cutouts: It is a polygon with an outer border and one or more inner borders cut
into it.

Note:When a rectangle is rotated, it is converted to a polygon.

Figure 157. When a rectangle is rotated, it is converted to a polygon.
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The composed graphic objects are:
a. Flashes: A flash is defined by a configItem (toollist), a coordinate, and rotation.
b. Sub layout instance: The sub layout stores within it various information, like; the layer

information, the rotation and orientation of objects, sizes of objects.

Note:When creating text or data matrix, they are decomposed into basic graphical
objects, e.g.: a data matrix is decomposed into several small scaled rectangles.

For more details about graphical objects and inserting them, please refer to: Insert

Display Grid

The grid is a set of visual points that are laid symmetrically, these grid points will help you
align your graphical objects with ease.
To show and hide the grid, simply click on the Show Grid button in the Unit/Grid toolbar.

Figure 158. Unit/Grid toolbar

The Grid Spacing menu, enables you to choose the distance between grid points.
The Measurement Units drop menu, allows you to choose the unit which will be used for all
measurements in CircuitCAM, you can also set the measurement unit from the General Set-
tings menu.

Snap to Grid

The snap to grid feature explains as follows: When you draw, resize, or move a shape or an
object, it will align or "snap to" the nearest point in the grid, even if the grid is not visible. If
your shape or object does not move where you want, turn off the snap to grid option or choose a
smaller scale grid.
You can change the value by which the mouse moves to the grid from the Cursor Grid Spac-
ing in the toolbar.
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3.3.1. Zooming and Panning
Navigating through a document or a project in CircuitCAM is made easy, explained in this page
is the various means of navigation used in CircuitCAM.

Zooming

The process of zooming, is simply changing the scaling of the viewed workspace. The view-
able area of a document/workspace can increased or decreased.
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Zooming options are also accessible through View menu and Zooming Toolbar.

Zooming In and Out

The graphical representation is shown enlarged or minimized by the factor of two (half and
double).
Either using keyboard hotkeys Page Up and Page Down, or using the mouse scroll wheel, the
current cursor position is used instead of the screen centre point. If the mouse cursor is outside
the graphic view area, the last recorded mouse position will be used as zooming point.

ZoomWindow

Allows drawing a rectangle around a specific area to bring it into focus. This function is acces-
sible by holding down the Alt button and drawing a rectangle around the desired place.

Figure 159. The process of Zoom Window

Zoom Selected

This function re-scales the view to fit the selected object(s).
This function is accessible from the view menu, or from the zoom toolbar.

Figure 160. The process of Zoom Selected
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Overview

When using this function, all graphical objects are shown fitting the screen.
This function is accessible from the view menu, zoom toolbar, or keyboard hotkey Home.

Figure 161. Zoom Overview

Previous Views

CircuitCAM stores a history of the previous views, CircuitCAM saves the last twenty views
(current view + nineteen old views).
The previous view can be restored through the view menu, zoom toolbar, or keyboard hotkey
Insert.

Figure 162. Previous View; after clicking Insert the last view is restored

Panning

Panning (changing is visible area of the layout) is performed by dragging the layout at any
place in the Graphic View while the Right Mouse Button is held, or, by simply clicking the
place to view in the Preview Window. Alternatively you can also use the horizontal and ver-
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tical scrollbars. The size and location of the scrollbars is relative, the length of the slider indi-
cates the current visible region of the layout.

Figure 163. Right click panning in Graphic View.

Figure 164. Navigating by selecting a place from the Preview window
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3.3.2. Manipulation of Graphic Objects
Manipulation operations for graphic objects affect the single points or segments, which are
identified by the selected marker, or work with a total group of selected objects.

Single Object 

Manipulation operations on paths and polygons belong to the Single object group. Any manip-
ulation operation can be called by using one of the following methods (for more information on
the methods see Manipulation operations):

l Curve submenu of the Modify menu or keyboard Ctrl + character.

l Unit/Grid toolbar.

Group of Objects 

Some manipulation options are available for a group of selected objects. Almost all of these
operations are available for a single selected object. The most of the functions are called from
the Modify menu. When the mouse is in the graphic window, the right mouse click will access
a context menu for editing of selected objects (see Right Mouse Button Menu).

Markers

The single selected object has one or more markers, which can be accessed by individual
manipulation operations. The number and shape of these markers depend on the type and com-
plexity of the selected object.
The following markers can appear on the selected object:

l - anchor point marker;

l - centre marker;

l - point marker;

l - supplemental point marker (appears only on rectangles);

l - arc segment marker (the dark side of the marker image indicates the direction of a
path/polygon);

l - line segment marker (the dark side of the marker image indicates the direction of a
path/polygon).

While using various functions, it is needed to make precise mouse movement; it is needed that
the mouse snaps to specific points on the previously created (already existing) objects. To
achieve this, while the selected function is active (whether; drawing, editing, moving, or meas-
uring), holding down the shift button and clicking on an object will display all the marker points
of the object. When moving the mouse over a marker point, the cursor will snap to the exact
position of this point.
Clicking the mouse button while the shift button is pressed does not alter or change the selec-
tion.
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Circle:

l Two markers opposite to each other on the perimeter - for the size change.

l One marker in the Centre - for moving.

Figure 165. Circle markers

Rectangle:

l Four markers at the corners - for the size change

l Four markers on the edges - for the size change.

l One marker in the Centre - for moving.

Figure 166. Rectangle markers

Path and Polygon:

l One marker at each structural point (start point, end point and line support point).

l One marker on each arc or line segment.

l One marker on the Middle point of every arc segment.

Figure 167. Path with arc markers

Flash:

l Only one marker at the point of origin.

Figure 168. Flash marker
Depending on the size of the object and the zoom factor, only some of the markers may be vis-
ible. CircuitCAM displays marks on the screen, which do not overlap with their neighbours.
One of all displayed markers may exist as the selected marker or Anchor Point. The marker is

indicated by and is used as:
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l reference point for the move/duplicate group,

l reference point for the rotate/mirror group,

l starting point for path/polygon manipulation operations.
Coordinates of the Anchor Point are displayed in the Status bar, together with actual coor-
dinates of the cursor. Please notice, after the single object is selected, the Anchor Point is set
to the coordinates of the selected marker. The Set Anchor function (see Set Anchor Point)
allows a user to change an anchor point coordinates.
To move from one marker to a neighbouring marker, press the Plus (Next marker) orMinus
(Previous marker) key. Press and hold down one of the keys to move the marker repeatedly.
Particularly in case of a path and polygon, it is helpful to know that the Next marker moves the
selection attribute in a direction of the structural sequence and the Previous marker moves
respectively in the opposite direction. In case of a closed path/polygon the marker moves in a
loop.

The single Object Manipulation Operations

Add Point/Segment

Inserts a new support point between two existing ones, or adds a new support point at the begin-
ning or the end. It depends on what support point is chosen – start/end point or one of segment
middle points.

1. Line segment: A new support point is inserted between existing support points.

2. Start or end point of a path: Appends new support points/segments to the existing
path.

Cut Point/Segment

Divides a path or a polygon into two parts, with polygons/closed Paths always first converted
into paths.

1. Central support point: The path is divided into two paths at this point.

2. Segment: The selected segment is divided into two parts at the segment middle point.

Delete Point/Segment

The single support point or a complete segment with adjacent support points is removed from a
path or a polygon. If during this operation less than two supports points remained, the path or
polygon is completely removed. The following cases are possible:

1. Start or end support point: The support point is removed together with the connected
line or arc segments.

2. Central support point: The central support point is removed. The line segment links
the adjacent support points.

3. Line segment: The line segment with adjacent support points is removed.

4. Arc segment: The arc segment is converted into a line segment.
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Move Point/Segment

Moves a single support point or a segment.

1. Support point: If a support point is moved, the neighbouring segments are changed
respectively. With arc segments, the bulge is kept. The direction and length of the seg-
ment is changed.

2. Line or arc segment: A shape, a length and a direction of the selected segment are
retained. However, a length and a direction of neighbouring segments are changed.

Create or Move Arc

Changes a line segment into an arc segment or the bulge of an existing arc. It works only on
segments and not on line support points. The support points adjacent to the segment are not
changed.

1. Line to arc: A line segment is converted into an arc segment.

2. Change arc: The bulge of an existing arc segment is changed.

Combine

Combines paths, where the ends are closer than a minimum specified distance (Gap distance
value in the Curve combine dialogue), to a single path. The statistics of the Combine oper-
ation is presented in the Message Log view:
x path connections were done, x resulted in a closed path(s).

Figure 169. Combine operation initial data and result

Close

The selected open path is converted to the closed path. An additional line segment is added to
connect start and end points.

Figure 170. Close operation initial (open path) data and result (closed path)

Path to Polygon

All selected paths are closed to polygons, therefore losing their width.
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Note. New polygons take up a different area in comparison to the paths area before the
operation. Furthermore, all paths inside selected flashes are closed to polygons too (including
nested flashes).

Figure 171. Path to Polygon initial data and result

Restrictions:
l A path with just one line segment cannot be converted into a polygon.

l The paths must not intersect. Please check this.

Combine to Polygon

The purpose of this function is to combine paths, where the ends are closer than a minimum
specified distance, to close them and covert them to polygons.

Figure 172. Combine to Polygon initial data and result

Convert to Polygon

Any selected simple graphic object, i.e. circle, rectangle and path is converted into polygons of
the same shape. The original objects are deleted. This is useful where targeted manipulations
must be carried out on these objects.
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Figure 173. Convert to Polygon initial data (rectangle, open path,closed path) and result
(polygons)

Note. Since objects remain the same shape and belong to the same layers, no changes are
visible on the screen, except for the markers - they are generated anew.

Convert to Closed Outline Path

All selected graphics objects (circle, rectangle, polygon, flash, etc.) are converted into an out-
line path with a zero path width. The original objects are deleted.

Figure 174. Convert to Closed Outline Path initial data (circle, rectangle, polygon) and
result (outlines)

Denest Polygon Cutout

The selected polygonCutOut (boundary) and all it's cutOut's (inner figures) are replaced in a
graphic window with their origin shapes (circle, rectangle, path and so on).

Figure 175. Denest Polygon CutOut initial data (selected one hole) and result (denested
all holes)

Note. This function is only available in the CircuitCAM variants STANDARD and PRO.
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Denest polygon Cutout Hole

Only selected cutOut's (inner figures) are replaced in a graphic window with their origin
shapes (circle, rectangle, path and so on). In case the polygonCutOut has no more cutOut's, it
is denested too.

Figure 176. Denest Polygon CutOut Hole initial data (selected one hole) and result
(denested only selected hole)

Note. This function is only available in the CircuitCAM variants STANDARD and PRO.

Convert to Circle

Coverts the selected simple graphic object (i.e. flash, rectangle and path or a group of selected
objects) into a circle of the same area. The original object is deleted. In case of a group of
objects, all these objects must belong to the same layer. The destination layer coincides with
the source layer.

Figure 177. Convert to Circle initial data (selected rectangles) and result (circle)

Note. To view an area of selected objects use Area of Selected Objects command. For a
single object, the area is defined in the Properties view.

Draw to Flash

Converts selected objects to flashes.
Selected objects, which make a connected area and belong to the same layer, are converted to
a flash. For absolutely similar areas only one tool is created ("similarity" depends on Tol-
erance 'Draw to Flash' [%] value).
Draw to Flash always keeps the original structure of selected objects to the additional 'Draw-
ToFlash__Backup' layer; witch is accumulated but never deleted.

Note. After Activity-Cancel a backup for the last selected group is not created (i.e.:,
'DrawToFlash__Backup' remains the same which was before last Draw to Flash operation).
You can split a layout (select not all objects at once) and run Draw to Flash at several times –
the final result will be the same. 
The configuration must be given as a destination place (any object with these attributes should
be selected before). All flashes after converting remain on its origin (drawing) layers.
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Note. The Tolerance 'Draw to Flash' [%] is set in the General Settings -> Calculation
Parameters sheet (to see/modify it, open the Settings menu, select the General settings...
line and click on the Calculation Parameters node on the left side of the window). This func-
tion is available in the CircuitCAM PRO variant only.

Figure 178. Draw to Flash initial data (selected rectangles and overlapping circles) and
result (generated flashes)

Convert to One Flash

Converts selected objects into a single flash.
All selected simple graphic objects (i.e.: circle, rectangle, flash, polygon and path) are con-
verted into a new flash. The Configuration field of dialogue-box allows a user to
select/change a tool list for the new flash.

Figure 179. New Flash dialogue window
After the Configuration is set, the next suitable tool name is suggested in the Name field auto-
matically, but user can enter an applicable tool name, too.
In addition, a mass point or centre point is calculated on selected objects. The type of a point
depends on Point method setting –Mass or Centre in the General Settings dialogue. 
The original objects are deleted and a new object is made as selected.
In case the original objects belonged to different layers, a new object is placed on one of them
randomly.
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Figure 180. Convert to One Flash initial data (two object selected) and result (only one
object selected)

Note: This function is only available in the CircuitCAM variants STANDARD and PRO.

Convert to Instance

Converts selected objects into a single instance/layout.
All selected simple graphic objects (i.e. circle, rectangle, flash, polygon and path) are copied
into a new layout. The Name field of dialogue-box is for defining of a layout name, fields
Type and Category allow a user to select additional layout properties - type and category.
Flag Insert instance - if On, creates a new instance of the selected objects in the current lay-
out, otherwise selected shapes remain in the current layout without any changes.

Figure 181. New Layout dialogue window

Exchange with Flash

Compare Shape

A piece of a topology, which is not alone flash and is identical to the selected flash, is replaced
with a flash.
The original objects are deleted and all new objects are made as selected.
The identical means not only the same amount and size of objects, but the same relative loca-
tions too - any difference can’t exceed the Tolerance 'Draw to Flash' [abs] value.
The Tolerance 'Compare shape/BBox/Outline' [abs] is set in the General Settings -> Accu-
racy page (accessible from Settings -> General settings... menu).

Note. This function is available in CircuitCAM PRO variant only.

Compare Bounding Box

A connected piece of a topology, which size of the bounding box (on both X and Y directions
separately) differs from a bounding box of the selected flash less than the Tolerance 'Draw to
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Flash' [abs] value, is replaced with a flash. Any bounding box is assumed as the “black box”.
The original objects are deleted and all new objects are made as selected.
The Tolerance "Draw to Flash" [abs] is set in the General Settings -> Accuracypage
(accessible from Settings -> General settings... menu).
The function is based on resolution of Polygon Package.

Note.This function is available in CircuitCAM PRO variant only.

Compare Outline

If a difference between an area of the connected piece of the topology and an area of the
selected flash when they are matched according to their mass points is less then the Tolerance
'Draw to Flash' [abs] and Tolerance 'Draw to Flash' [%] values, the piece is replaced with
a flash.
The original objects are deleted and all new objects are made as selected.
The Tolerance 'Draw to Flash' is set in the General Settings -> Accuracy page (accessible
from Settings -> General settings... menu).
The function is based on resolution of Polygon Package.

Note. This function is available in the CircuitCAM PRO variant only.

Step and Repeat

Selected objects are repeated in a matrix ((x*y) –1) times in a specified direction, according to
the settings in the dialogue window.
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Figure 182. Step and repeat dialogue window
l Grouping

l Flash flag - if On, converts selected objects to one flash (like Convert to Flash
operation) and later duplicates it in accordance with settings in Distance and
Repetition areas

l Layout instance flag - if On, converts selected objects to one layout and later
duplicates sub-layout instance in accordance with settings in Distance and Repe-
tition areas

l Offset: defines a space between repetitions. The default values are calculated as the
bounding-box of selected objects.

l Repetition: specifies a size of repetition matrix. The default value is [1, 1] (no repe-
titions).

l Arrangement specifies the directions how objects will be created in X and
Y directions:

Figure 183. Arrangement modes

Note. This function is available in the CircuitCAM PRO variant only.

Create Bounding Shape

Creates a circular bounding shape one per each group of overlapped graphic objects. This func-
tion works on one layer, because the fiducials are located on a separate layer. The Source
layer combo box indicates a name of the source layer. If the source layer is empty, Cir-
cuitCAM will display a message.
There is a special (so called Butterfly-Fiducials) case, when two square flashes do not overlap
and CircuitCAM creates two circles. To avoid this the Merge distance value is introduced. If
a distance between objects are less thanMerge distance value, these objects are merged and
just one circle on the centre point of the objects is created.
The original objects are not deleted. The destination layer is selected from the Destination
layer combo box.

(184)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Figure 184. Create Bounding Shape dialogue window
The Oversize field allows creation of a bigger or smaller bounding shape.
If the Clear destination layer check box is set On, the destination layer will be cleared out
before creating the new bounding shape, a confirmation message will appear to approve the
removal of objects.

Note: This function is only available in the CircuitCAM STANDARD and PRO variants.

Create Outline

Generates an outline on the edge of each object located on the Source layer. This function
works on one layer, selected in the Source layer combo box. If the source layer is empty, Cir-
cuitCAM will display a message.
The original objects are not deleted. Resulting outlines will be placed on the Destination
layer. A destination layer is selected from the Destination layer combo box (a destination
layer will be created if a new name was entered).
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Figure 185. Create Outline of Shape dialogue window
If the Clear destination layer check box is set On, the destination layer will be cleared out
before creating the new outlines, a confirmation message will appear to approve the removal of
objects.

Note: This function is only available in the CircuitCAM STANDARD and PRO variants.

Perfect Shape

Checks selected objects on a perfect rectangle, a rounded rectangle, a bevelled rectangle, a cir-
cle and an oval according to the given tolerance. If yes, converts the perfect shapes into
flashes of mentioned types.
New created apertures are saved in the selected configuration (Aperture/Tool List).

Figure 186. Perfect shape tolerance dialogue window

Note. This function is available in the CircuitCAM PRO variant only.
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Polygon to Path

Converts polygons to paths.

Remove Holes

Removes holes inside a closed area of pp-polygons.
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3.3.3. Boolean Operations
CircuitCAM provides basic set operations on graphical objects, the applicable set operations
include; union, difference, intersection, XOR, paths on area, and paths off area.
To perform Boolean operations properly, some notes must be taken into consideration;

n The primary selected object (the object with markers) is the main operator for Boolean
operations, the rest of the selection group will be considered as one polygon and will be
treated as the secondary operator.

n Boolean operations only affect graphical objects that are present on the same layer.

n Boolean operations only affect graphical objects that are overlapped.

Explained next are the various Boolean operations included in CircuitCAM, a unified example
will be used to demonstrate these operations.

Figure 187. The plain example used to demonstrate Boolean operations;
object A is a rectangle, object B is a circle, object C is an open path
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Union

All graphical objects whether polygons or paths, are eligible to the union operation, known
from the theory of sets.
The union operation is the process of merging the selected overlapped graphical objects to
create one new polygon represented on the same layer.
The union operation is simplified as the word "or", e.g.: in the figure below; the operation is:
Graphical objects available in; A or B or C.

Figure 188. After the three objects are selected, the union operation is executed, the
result is a new polygon D

Note: The union operation is still effective even if there is not a primary selected object.

Difference

All graphical objects whether polygons or paths, are eligible to the difference operation, known
from the theory of sets.
The difference operation is the process of calculating the graphical differences between the
main operator and the secondary operator(s), and representing those differences as a new poly-
gon(s) on the same layer.
The difference operation is simplified as the word "not", e.g.: in the figure below; the operation
is: Graphical objects available in; A not B.
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Figure 189. After the two objects A and B are selected, A is the primary selected object
(operator);

the difference operation is executed, the result is a new polygon D

Figure 190. After the two objects A and B are selected, B is the primary selected object
(operator);

the difference operation is executed, the result is a new polygon D

Figure 191. After the three objects A, B, and C are selected, A is the primary selected
object (operator);

the difference operation is executed, the result is TWO new polygons D and E

Intersection

All graphical objects whether polygons or paths, are eligible to the intersection operation,
known from the theory of sets.
The intersection operation is the process of calculating the graphical intersections (overlaps)
between the main operator and the secondary operator(s), and representing those intersections
as a new polygon(s) on the same layer.
The difference operation is simplified as the word "and", e.g.: in the figure below; the oper-
ation is: Graphical objects available in both; A and B.
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Figure 192. After the two objects A and B are selected, the intersection operation is
executed;

the result is a new polygon D

Note:While using the intersection operation, when working with only two graphical
objects; the primary selected object does not alter the result, as seen in the figure above.

Figure 193. After the three objects A, B, and C are selected, A is the primary selected
object (operator);

the intersection operation is executed, the result is a new polygon D
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Figure 194. After the three objects A, B, and C are selected, B is the primary selected
object (operator);

the intersection operation is executed, the result is a new polygon D

XOR

All graphical objects whether polygons or paths, are eligible to the XOR (Exclusive Dis-
junction)operation, known from the theory of sets.
The XOR operation is the process of calculating the graphical intersections (overlaps) between
the main operator and the secondary operator(s), and removing those intersections. The result
is the exclusive areas of the selected objects.
The XOR operation can be simply explained as the inverse (negative) of intersection operation.
See and compare example figures of intersection and XOR.

Figure 195. After the two objects A and B are selected, the XOR operation is executed;
the result is TWO new polygons D and E
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Note:While using the XOR operation, when working with only two graphical objects; the
primary selected object does not alter the result, as seen in the figure above.

Figure 196. After the three objects A, B, and C are selected, A is the primary selected
object (operator);

the XOR operation is executed, the result is a set of new polygons

Figure 197. After the three objects A, B, and C are selected, B is the primary selected
object (operator);

the XOR operation is executed, the result is a set of new polygons

Paths on Area

This operation trims the paths, leaving only the portions that are present inside an area (poly-
gon).
For this operation to work, at least one polygon and one path must be selected.

(192)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Figure 198. After the three objects are selected, the Paths on Area operation is executed,
the result is trimming of the path C as shown

Figure 199. After the two objects A and C are selected, the Paths on Area operation is
executed,

the result is trimming of the path C as shown

Note: The Paths on Area operation is still effective even if there is not a primary selected
object.

Paths off Area

This operation trims the paths, leaving only the portions that are present outside of an area
(polygon).
For this operation to work, at least one polygon and one path must be selected.
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Figure 200. After the three objects are selected, the Paths off Area operation is executed,
the result is trimming of the path C as shown

Figure 201. After the two objects B and C are selected, the Paths off Area operation is
executed,

the result is trimming of the path C as shown

Note: The Paths off Area operation is still effective even if there is not a primary
selected object.
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3.3.4. Size Modification
The Size modification allows a user to scale the size of the selected graphical object. In case a
few objects are selected, these modification are available when objects belong to the same
level only.

Size Modification Dialogue

To open the dialogue window, select the Size Modification from the Modify menu. Most of
these operations use Polygon Package with Resolution of Polygon Package from the Accu-
racy tab of General settings window. 

Note: This function is only available in the CircuitCAM PRO variant.
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Scaling

These shape modification operations are based on recalculation of coordinates (x,y) for each
shape point.  A new point coordinates (x,y) are get by scaling offsets between the point coor-
dinates and the shape Mass/Centre point coordinates in both X and Y directions. The scaling
can be done with the same scale factor in all directions or with the different scale factors for
the different directions, according to which type of the scaling is selected:

Figure 202. Shape modification dialogue window, Scaling panel

l Area: The scaling factor is a quotient of a square root of a shape area by a square root
of the shape area increased by a value from the Value(%) field (this field appears only
after the area option is On). The same scale factor is in force in all directions (the radio
button All directions is allowed only).

l Length: The scaling factor is calculated directly from a value, defined in the Value(%)
field. In different directions the same or different scale factors can be used. That
depends on witch type of scaling is selected (All directions/x,y/+x,-x,+y,-y). The pic-
ture below shows original pad (green color) and modified pad (red color) (to better
emphasize differences the scaled shape is shown in outline mode). Oval pad size - 4
mm by 2 mm; scaling values: +X(%) = 20, -X(%) = -10, +Y(%) = 10, -Y(%) = -5 :

Figure 2. Original pad (green color) and modified pad (red color)

l Absolute: The scaling factor is a quotient of a length of a shape bounding box by a
length of the shape bounding box increased by an absolute value from the Value(%)
field. The same scale factor is in force in all directions (the selection button All direc-
tions is allowed only).

l All directions: The scaling is calculated in all directions with the same scale factor.

l X,Y: The scaling is calculated in x and y directions with the different scale factors. It
can be used in the Length scaling mode only.
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l +x,-x,+y,-y : The scaling is calculated in -x, +x, -y, +y directions with the different
scale factors. It can be used in the Length scaling mode only.

l The arrows allow the user to counterchange x and y values (also +x with -x, +y
with -y and +x, -x with +y, -y).

l Mass point: The offset values are calculated between shape points andMass point.

l Centre point: The offset values are calculated between shape points and Centre point.

l Special: while flag is On a rounded rectangle keeps ratio of its original shape during the
scaling.

Polygon Operations

Polygon operations are used to extend, round or truncate a shape. These operations must be per-
formed strictly in the following order:

1. Oversize or Rounding;

2. Stretch;

3. Convert to the rectangle/circle.
Any of these operations can be switched on/off. The Polygon operations panel has the fol-
lowing switches:

Figure 203. Shape modification dialogue window, Polygon Operations panel

l Oversize: oversizes a shape in all directions by a value from the Value field. The selec-
tion of a type of the over-sizing (Extend, Truncate or Round) is allowed.

l Rounding: performs rounding operation in all directions. The operation is executed two
times - the shape size is decreased and increased with the same oversize value and the
result is the same size with all rounded corners only by a value from the field Value.
The picture below shows original (green) shapes and shapes (red) after rounding (in out-
line mode):
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Figure 204. Rounding results: positive value (left) and negative value (right)

Note: A positive rounding value works on convex corners only (left shapes in the picture
was done with Value = 1.3 mm), negative value – on concave corners only (right shapes in the
picture was done with Value = -1 mm).
Convert to:

l surrounding rectangle: A Bounding Box of a shape is calculated and the shape is con-
verted into rectangle of the same size as the Bounding Box.

l surrounding rectangle with same area: An area of the shape is calculated and the
shape is converted into rectangle of the same size as the area. Mass point is assumed as
a centre point of the rectangle.

l circle with same area: An area of a shape is calculated and the shape is converted into
circle with the same area. Mass point is assumed as a centre point of the circle.
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3.3.5. Properties
Sometimes it is useful to specify main characteristics of the selected graphical object very
quickly. For example, a line width and corner types of the path, a circle diameter, a number of
lines and arc segments in a polygon. For this purpose the function Properties with a respective
dialogue box can be used. These dialogue boxes allow modifying some properties too.
The Properties function can be called from the Edit menu or from the context menu (to open
the context menu click the right mouse button when the mouse is in the graphic window) or by
clicking on a particular object in the graphic view. Three different actions are possible:

1. Document information window appears: no object was selected before.

2. Properties dialogue window appears: a path, polygon, pad or circle was selected.

3. Area of selected objects is calculated and displayed: more than one graphical object
was selected.

Document Info Window

The Properties window of the current document, which is opened in a graphic window, is dis-
played:
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Figure 205. Properties panel, Document information
This information is kept in a CAM document. With each Save/Save As operation this infor-
mation is updated with the User Information on page General Settings.
In addition, the Underlying CAT file field shows the template CAT file that was used to
create the document.

Note: Some parameters, like General settings, are automatically stored into Underlying
CAT file.  So, if the Underlying CAT file does not exist on the current PC, the warning mas-
sage “Invalid name of underlying CAT file. General Settings Assignments are not saved”
comes up.
The Time stamp field informs user when the underlying template file was created/modified.
The Comment field shows the CircuitCAM version, which was used by saving the cam file.

Path Properties

This dialogue window appears in the Properties panel if only one open/closed path was
selected (in case of closed path the Object type filed value is switched to Closed Path):

Figure 206. Properties panel, Closed path

l Layer: Shows the layer of the selected path.

l Configuration: A name of the aperture list for the selected path. The list is empty if
the Local Draw Attributes check box is switched On.

l Tool: An aperture name from the aperture list, which is shown in Configuration field,
for the selected path. There is possibility to change the tool - select it from the Stand-
ard toolbar or the Tools panel (Activate tool function in context sensitive menu). The
list is empty if the Local Draw Attributes check box is switched On.
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l Line segments/Arc segments: The information text fields in read-only mode to inform
user how many line and arc segments are used in the selected path.

l Path width: A width of the line in any unit the selected path is drawn (only positive
values are allowed). The list is editable if the Local Draw Attributes check box is
switched On.

l Path length: The total length of the path.

l Circle diameter: The text field shows a diameter of the circle in the selected closed
path. This field is used and is enabled when the selected path is closed path that con-
sists only of a single circle.

l Corner Type / End Type: A shape of the line end (End Type) and corners (Corner
Type) for paths. If we assume that a round tool draws a path, then the attributes for
both are ROUND. The other options EXTEND and TRUNCATE are however also
specified by the EDIF standard, but the graphical representation of these shapes is
restricted. The lists are enabled, if the Local Draw Attributes check box is switched
On.

Circle Properties

This dialogue window appears in the Properties panel if only one circle was selected:

Figure 207. Properties panel, Circle

l Layer: The layer of the selected circle.

l Diameter: The circle diameter is displayed in the same unit used for drawing e.g.:
mm or inch. The list is always enabled.

The next fields show additional circle properties (in read-only mode):

l Circle area: Shows the circle area.

l Circle perimeter: Shows the circle perimeter.

Rectangle Properties

This dialogue window appears in the Properties panel if only one rectangle was selected:
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Figure 208. Properties panel, Rectangle

l Layer: The layer of the selected rectangle.

l a and b: The text fields show the sizes of the rectangle.
The next fields show additional properties (in read-only mode):

l Rectangle area: Shows the rectangle area.

l Rectangle perimeter: Shows the rectangle perimeter.

Polygon Properties

This dialogue window appears in the Properties panel if only one polygon was selected:

Figure 209. Properties panel, Polygon

l Layer: The layer of the selected polygon. This list is always enabled.

l Line segments/Arc segments: Indicates how many line and arc segments are used in
the selected polygon.

l Polygon area: Shows the polygon area.

l Polygon perimeter: Shows the polygon perimeter.

Flash Properties

This dialogue window appears in the Properties panel if only one pad or hole (flash) was
selected:
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Figure 210. Properties panel, Flash

l Layer: The layer of the selected pad/hole.

l Configuration: The name of the aperture list for the selected pad/hole.

l Tool: An aperture name from the aperture list, which is shown in the Configuration
field for the selected pad/hole. There is a possibility to change the tool - select it from
the Standard toolbar or the Tools panel (Activate tool function in context sensitive
menu). The list is always enabled.

l Type: The text field in read-only mode shows a type of the tool (for more information
on tool types, see the Flash Attributes sheet of Tool properties.

l Parameters: Shows dimensions of the tool in any unit (for more information on tool
dimensions, see the Flash Attributes sheet of Tool properties).

l Aperture/Tool transform: Four text fields in read-only mode show the location of the
point (xOff, yOff), scale factor and rotation angle. The dimensions of the point are rel-
evant to the tool dimensions, presented in the Parameters field.

l Pad/Hole transform: The text fields show where and what rotation the selected tool is
placed in the graphical window. Values of these fields can be modified.

Selection Properties

This dialogue window appears in the Properties panel if more than one graphical object is
selected:

Figure 211. Properties panel, selected 43 items
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l Number of items: The number of selected items.

l Size: The size of the rectangle for the selection area.

l Bounding area: The bounding area of the selection.
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3.3.6. Selection of Graphic Objects
To change graphical information inside the graphic window (move, delete etc.), the elements to
be amended must be selected by clicking them with the mouse. One or more objects can be
selected at the same time; this is called a selection group, which contains the selected objects.
The selected objects are visually highlighted by a different color, for the highlight color see
Layers View.

In most cases one of the selected objects is the primary object, thus indicated by markers on its
construction points. see Manipulation of Graphical Objects.
The primary selected object is the main operator in all editing and moving operations; such as
Boolean Operations.
Adding or removing a selection from the group will changes the primary selected object.

CircuitCAM has a number of functions and switches to determine what kinds of graphical
objects may or may not be selected. These functions are available by the Select menu or on the
Select toolbar:

Note: Every selected element can be deselected with the ESC key or Cancel from the
context sensitive menu.
The summary information of the selection appears in the Properties window: the number of
items, the size and the bounding area.

Single Object

A single graphic object is selected by a single mouse click. Objects, which are closest to the
cursor position, are selected first. If a number of objects are superimposed at the same place,
one object after another can be selected by repeated clicks.
There are three selection modes on a single object:

l select single object (new selection mode): selects a new object by left-click on an
applicable object. All objects selected before will be deselected. To set the new mode
use one of the following:

a. clicking on the item in the Select toolbar;
b. or set the New function from the Select menu;

c. or Cancel operation.

l add single object (add selection mode): adds a new object to the selected group by left-
click on the object to be add. To set the add mode use one of the following:

a. clicking on the item in the Select toolbar;
b. or set the Plus mode from the Select menu;
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c. or holding down Ctrl key while clicking with the mouse.

l remove single object (remove selection mode): removes an object from the selected
group by left-click on the object to be remove. To set the remove mode use one of the
following:

a. clicking on the item in the Select toolbar;
b. or set the Minus function from the Select menu;
c. or holding down Shift key while clicking with the mouse.

Area

All objects inside a rectangular area are selected. The rectangular area is defined by two oppo-
site corner points with the mouse as in the following procedure;

Press Set the first corner point by pressing and holding the mouse button.
Move Move to the next corner point with the button held down
Release Set the second corner point by releasing the mouse button.

During these operations, the rectangular area is displayed for visual checking. There are three
selection modes on an area:

l select single area (new selection mode): only the objects from the rectangle area are
selected (all previous selections will be cancelled). To set the new mode use one of
the following:

a. clicking on the item in the Select toolbar;
b. or set the New function from the Select menu;

c. or Cancel operation.

l add new area (add selection mode): add all objects of a new rectangle area to the
selected group. To set the add mode use one of the following:

a. clicking on item in Select toolbar;
b. or set the Plus mode from the Select menu;
c. or holding down Ctrl key while clicking with the mouse.

l remove area (remove selection mode):remove all objects of a new rectangle area
from the selected group. To set the remove mode use one of the following:

a. clicking on the item in the Select toolbar;
b. or set the Minus function from the Select menu;
c. or holding down Shift key while clicking with the mouse.

Note: All selection functions are altered by changes in the "Selection Type" in the Select
Menu.

Sequence

This is a special selection mode, which allows the user to select objects in the order of their
appearance (in the order these objects were drawn) or otherwise. For more details, see
Sequence.
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3.3.7. Context Menu "Right Mouse Button"
While using the right mouse button in the client area of a Graphic view, the following popup
menu (mouse context sensitive menu) will appear:

Figure 212. Right mouse button menu (context sensitive menu)

Cancel
Finishes/Interrupts the current action. E.g.:, deselects selected objects;
finishes/interrupts any Insert operation; finishes Measure operation; inter-
rupts Copy/Duplicate operations and so on.

Add Point/Seg-
ment The menu item appears only if selection is made in the Graphic view.

See Add Point/Segment.

Cut Point/Seg-
ment

The menu item appears only if selection is made in the Graphic view.
See Cut Point/Segment.

Delete
Point/Segment

The menu item appears only if selection is made in the Graphic view.
See Delete Point/Segment.

Move
Point/Segment

The menu item appears only if selection is made in the Graphic view.
See Move Point/Segment.

Create or
Move Arc

The menu item appears only if selection is made in the Graphic view.
See Create or Move Arc.

Combine...
The menu item appears only if selection is made in the Graphic view.
See Combine....

Close
The menu item appears only if selection is made in the Graphic view.
See Close.
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Move Selected See Move selected.
Duplicate
Selected See Duplicate Selected.

Pitch of Two
Pads

Calculate a distance between centre points of two selected areas (pads)
only.

Measure See Measure.
Cut Move the selected objects to the standard clipboard.

Copy Copy the selected objects to the standard clipboard.

Paste Extract the objects from the clipboard.

Remove Delete all selected objects.

Properties Activate Properties panel, where the characteristics of the selected
object are specified.
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3.3.8. Editing operations

Create Gap

This command adds a gap at the active marker point. A width of the gap can be specified from
the Breakout Tab field in the Settings -> General settings -> Diverse, page and can be set to
a new value.
This feature only works on paths (open or closed), in case of a polygon, first it must be con-
verted to a closed outline path. See more.
This function can be applied at:

1. Start or end support point: The selected point is assumed as the gap's centre point
(the path is shortened by the specified Gap Value/2).

2. Central support point: The path is divided into two paths at this point, and this point
is assumed as the gap's centre point.

3. Segment: The selected segment is divided into two parts at the selected point, and this
point is assumed as the gap's centre point.

The Create Gap function is accessible by any of the following means:

n Going to the menu; NC/Tool path ---> Create Gap.

n Keyboard shortcut; Ctrl + G

Reverse

This command reverses the direction of the selected object.

The Reverse function is accessible by any of the following means:

n Going to the menu; NC/Tool path ---> Reverse.

n Keyboard shortcut; Ctrl + R.
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Rotation and Mirroring

There are two different modes to rotate selected objects;

n The relative mode is available for any type of objects, where the resulting rota-
tion/mirroring of any object depends on the position of its current anchor point. Relative
mode rotates and mirrors multiple selected objects around the anchor point of the whole
selection group.

n The absolute mode (also called flash rotation) is possible only for flashes/pads. Absolute
mode rotates and mirrors selected objects around its centre point (0,0), thus, all selected
flashes will have the same rotation/mirroring (location of flashes is not changed).

The rotation/mirroring functions are accessible by any of the following means:

n Going to the menu; Edit ---> Rotate Relative.

n Going to the menu; Edit ---> Set Flash Rotation Value.

n Accessing the functions from the Relative Rotations toolbar
or

the Flash Rotations Toolbar

In the Rotate dialogue window, the function Value allows the user to define the direction of
the rotation and enter the desired angle.

Figure 213. Rotate dialogue window
Other functions execute fixed actions.
This example object illustrates the effects of the various functions:
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Figure 214. Rotate function effects

Value ... Mirror X

90° Mirror X+90°

180° Mirror Y

270° Mirror Y+90°

The given point of the original (x, y) is changed in the following way:

n 90(-y, +x)

n 180(-x, -y)

n 270(+y, -x)

n MX(+x, -y)

n MXR90(+y, +x)

n MYz(-x, +y)

n MYR90z(-y, -x)
User can choose any case for a fixed rotation from the following list, the first line Value….
was already described above:
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Figure 215. Edit -> Set Flash Rotation Value menu content
The framed menu icon indicates a current rotation for the selected object, and is used only in
the absolute mode.

Set Anchor Point

Initially the anchor point is set to the centre of the coordinate system (0/0). The Set Anchor
Point allows to set an anchor point to any other coordinates.
After the selection of a graphic object, CircuitCAM displays markers on the screen, which do
not overlap with their neighbours. One of these markers is selected as Anchor Point. The
anchor point is displayed with X-Y values, which are shown in the right area of the status bar.
The Set Anchor point function allows changing the anchor point to the coordinates (X;Y),
which are typed in the text field of the Set Anchor dialogue window.

Figure 216. Set Anchor Point panel

To set the Anchor Point at the current mouse position press Ctrl + Shift and click left mouse
button any place on the graphic view. The particular X and Y coordinates appear in the Set
Anchor window.
The anchor point is used as a reference point for move/duplicate group; used as a starting point
for path/polygon manipulating operations for setting a new zero point; used as a start point for
measuring the component sizes and others operations.

An anchor point can be set either in absolute or in relative mode. A user can switch the
current mode to another temporarily by entering '!' in front of the "X;Y" in the text field.

The Set Anchor Point function is accessible by any of the following means:

n Going to the menu; Edit ---> Set Anchor Point.

n Keyboard shortcut; Ctrl + Shift + A.

Set Cursor

This function sets a new cursor position, and simulates a mouse left click on that position.
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The mouse cursor coordinates are taken from corresponding dialogue window. The Set Cursor
function can be used in drawing/manipulating graphic objects.

Figure 217. Set Cursor dialogue window
The Set button has the same meaning as OK, but keeps dialogue box open for the next manip-
ulations. E.g.:, it is useful while adding a new path. Furthermore, a new cursor position can be
set either in absolute or in relative mode. The user can switch the current mode to
another temporarily by entering '!' in front of the 'x;y' in the text field.

The Set Cursor function is accessible by any of the following means:

n Going to the menu; Edit ---> Set Cursor.

n Keyboard shortcut; Ctrl + Shift + C.

Swap

The Swap function changes the order of objects. It works on the selected object(s) inside the
same layer and between objects. The current position of the selected object is shown on the
left field of the Status Bar. For example, the current fragment shows the selected flash-circle
has an order number 24 among all existing flashes in the layer that the selected flash-circle
belongs to.

Figure 218. Status bar with flash number
Four different swap operations are available:

n Move to the next position in the group (Shift + J);

n Move to the previous position in the group (Shift + I);

n Move to the first position in the group (Shift + F);

n Move to the last position in the group (Shift + L).

The Swap function is accessible by any of the following means:

n Going to the menu; NC/Tool path---> Swap.

n Using the previously explained keyboard shortcuts.
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3.3.9. Inserting Operations
CircuitCAM allows various objects (polygons/paths/pads...etc) to be inserted to the workspace,
all inserting operations are accessible via the menu; Insert.
General Hints:

n When inserting a new object, first you must select the desired layer, otherwise the cur-
rently active layer is used.
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n If one or several objects (from the same layer) are already selected, when inserting a
new object, the original object(s) will be deselected, and the new object will be added to
the current layer.

n If several objects from different layers are selected, inserting operations are not possible
(objects names and icons are greyed out).

Arc

Paths and outlines of polygons, consist of line and arc segments. A line segment is always
drawn first. The start and end points of the segment are fixed. Then the line segment can be
converted into an arc segment by using one of the two following methods:

1. Centre Point: The circle sector is determined by defining the Centre point of the cir-
cle.

2. Point on Arc: An additional point on the arc determines the circle sector.

Drawing procedure:

n Start by drawing a path or a polygon.

n Draw a line segment, which is changed into an arc segment. Any line segment can be
used.

n Activate the Centre Point Arc or Point on Arc function in the Insert menu or click
on the Centre Point Arc or Point on Arc in the Insert toolbar.

n Depending on the selected arc method, one of the following actions is carried out:

1. Centre Point method: The Centre point of the arc is specified;

or

2. Point on Arc method: A point is specified on the arc;

n The conversion of the line segment into an arc segment is interrupted by Esc or right
mouse button click.

n The next segment then can be drawn.

Circle

CircuitCAM supports three different methods to draw a circle.

Centre Method

The Centre point and a point on the edge of the circle are entered. The circle is filled.

Figure 219. Filled Circle (1- centre point, 2- point on edge)
Drawing procedure:
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n Activate the Dynamic Radius Circle function in the Insert menu or click on the
Dynamic Radius Circle in the Insert toolbar.

n Set the Centre point of the circle with a mouse.

n The circle stretches between the Centre point and the current mouse position.

n Set a point on the perimeter of the circle with the mouse; the circle is complete.

n Set the Centre point of the next circle or end the circle function with Esc or the right
mouse button click.

Centre + Diameter Method

The diameter must be entered in the Diameter field of the dialogue window; only the Centre
point is specified. The circle is filled.

Figure 220. Circle Diameter dialogue window
Drawing procedure:

n Activate the Fixed Diameter Circle function in the Insert menu or click on the Fixed
Diameter Circle in the Insert toolbar.

n Type the diameter in any unit in the Diameter text field.

n Set the Centre point of the circle with a mouse. The circle is complete.

n More circles can be defined by setting more Centre points. Quit the function with Esc or
the right mouse button click.

Circle in Closed Path method

The method works like Centre + Diameter method but the circular ring (donut) is assumed as
a closed path. The circle is not filled.

Line Drawing Modes

While drawing lines and an arc segments, there is often a need to align the segments exactly
vertically. This can be done using the line drawing methods. The following methods can be
used:

1. 90 angle: The effective mouse position changes only vertically/horizontally.

2. 45 angle: The effective mouse position changes only at 45 degrees angles and incre-
ments.
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3. Any angle: The effective mouse position agrees with the displayed mouse position.
Any angle can be drawn.

Open Path

The function inserts a new path that consists of one or more lines or arc segments. The start
and end points of these segments are called the line support points. The sequence of the line
support point is specified when drawing a new path. It determines the subsequent output direc-
tion when generating production data.
The following layer attributes determine the shape of a path:

n PathWidth: Defines the line width.

n EndType: Defines the shape of the first and last line support points.

n CornerType Determines the shape of the inner line support points.
The types ROUND, EXTEND and TRUNCATE are available for the corner type and the end
type.

Drawing procedure:

n Select an aperture/tool, otherwise the path with zero line width and local draw attrib-
utes will be drawn.

n Activate the Open Path function in the Insert menu or click on the Insert Open
Path in the Insert toolbar.

n Set the first line support point with the mouse.

n The line stretches between the first line support point and the current mouse position.

n Set the second line support point with the mouse.

n End the path with Esc or the right mouse button click. The next path now can be
drawn.

n Another Esc or the right mouse button click ends the line function.

Closed Path

The Closed Path function is very similar to Open Path function except the last path point will
be joined to the start point. In the drawing procedure the Open Path function must be changed
to the Closed Path function.

Pad

Follow this routine to insert a new pad (flash):

n Select an aperture/tool, otherwise the drawing is disabled.

n Activate the Pad function in the Insert menu or click on the Pad in the Insert tool-
bar.

n Set the Centre point of the flash with the mouse.
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n The next flash now can be drawn.

n Esc or the right mouse button click ends the drawing function.

Polygon with Cutouts

A polygonCutOut is a filled area with holes, defined by outer outlines and one or more inner
outlines. The outlines consist of two, three or more lines or an arc segments. An outline is not
allowed to intersect itself (like an “8” shape) or with other outlines. The start and end points of
these segments are called support points. The support point sequence is specified when draw-
ing a new polygon.
The function inserts a new polygonCutOut. The polygonCutOut consists of at least two figures.
The first figure is always an outer figure (boundary), all others figures are inner figures (cut-
outs).
A boundary shape may be a polygon, a circle and a rectangle. For the inner shape additionally
a flash and a path can be used. The figure below is a polygonCutOut with a rectangular outer
and a circular inner shape.

Figure 221. polygonCutOut with rectangular outer and circular inner shape

The type of the object, and the type of the cutout are both represented in the properties window
and the status bar;

Figure 222. Types of cutouts identified in the status bar

To denest the selected CutOut from polygonCutOut and to destroy the selected polygonCutOut
at all (shapes are not removed but they become simple shapes as a polygon, a circle, a rec-
tangle and so on) use corresponding Denest cutOut and Denest polygonCutOut functions
from the Modify menu.

n Select the items (polygon, circle, rectangle, flash), which should be a cut out, in the
Graphic view.

Figure 223. Selected circle

n Select in the main menu Insert -> Cutout menu item. The Select outline for cutouts
mode is turned On (see message line in the status bar). The special mouse cursor
appears on the screen.
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Figure 224. Cutout menu item

n Select a figure, a candidate to boundary for a new polygonCutOut.

Figure 225. Selected a boundary polygon for polygonCutOut

n Press Esc button to switch Off selection mode to see the result of the Cutout operation.

Figure 226. Result of Cutout operation

Note: This function is only available in the CircuitCAM variants STANDARD and PRO.

Polygon

A polygon is a filled area defined by an outline. The outline consists of two, three or more lines
and an arc segments. The outline is not allowed to intersect itself (like an “8” shape), because
the software cannot decide what is inside and what is outside. The start and end points of these
segments are called support points. The support point sequence is specified when drawing a
new polygon.

Drawing procedure:

n Activate the Polygon function in the Insert menu or click on the Insert Polygon in
the Insert toolbar.

n Set the first support point with a mouse.

n The line stretches between the first support point and the current mouse position.

n Set the second line support point with the mouse.

n Set the third and all other support points.

n End the polygon with Esc or the right mouse button click. The next polygon now can be
drawn.

n Another Esc or the right mouse button click ends the polygon function.
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Rectangle

Two opposite points describe a rectangle. The sides of the rectangle are parallel to the x and y
axis.

Drawing procedure:

n Activate the Rectangle function in the Insert menu or click on the Insert Rectangle
in the Insert toolbar.

n Set the first corner point in the graphics area by clicking with the mouse.

n The rectangle stretches between the first corner point and the current mouse position.

n Set the opposite corner point with the mouse. The rectangle is now drawn.

n Now the next rectangle can be started, or the function can be ended with Esc or the
right mouse button click.

Rubout Area

The function inserts a new rubout area.This area is a zone where the isolation channels around
conductor tracks and pads are milled, and also all residual copper between the conductor tracks
and pads is removed from the circuit board.
A shape for the rubout area (polygon, rectangle, circle and etc.) can be selected by using the
corresponding functions from the Insert menu or Insert toolbar. The rectangular shape is set
by default.
Top layer: Creates a rubout area on the top side of the circuit board.
Bottom layer: Creates a rubout area on the bottom side of the circuit board.
All layers: Creates a rubout area on both sides.

You can see more inserting operations in the Insert menu.
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3.3.10. Manipulation Operations
CircuitCAM supports some manipulation operations on paths and polygons (see Manipulation of
graphic objects). They affect individual support points or segments, the support point or seg-
ment to be modified is identified by the selection marker.
Any manipulation operation can be carried out by one of the following methods:

1. Standard method:

n Select the standard operation from the Path/Polygon operations list.

n Select a path or a polygon.

n Move the cursor to one of the markers so that the cursor’s shape changes.

n Click the left mouse button to execute the standard operation.
With some operations, the mouse button simply needs to be clicked (cut and
delete).
While with others the cursor is moved with the button held down (add/append
point, move point, create or move arc). 

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
(215)



CircuitCAM 7.5

2. Temporary method - Temp x (method is very similar to standard method):

n Move the cursor to one of the markers so that the cursor’s shape changes.

n Select temporary operation by pressing and holding down the corresponding key-
board shortcut.

n Click the left mouse button to execute the temporary operation.

Note: Releasing the keyboard shortcut key disables the temporary operation.

3. Direct method:

n Activate the support point or segment marker to be manipulated.

n Activate the direct manipulation operation from the Modify ---> Curve menu.
n With some operations these steps are sufficient, while with others a new position
must be specified by the mouse.
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3.3.11. Text and Barcodes

3.3.12. Text
CircuitCAM supports creation of text using pre-installed fonts on the windows system (Please
note that CircuitCAM only supports TTF and TTC fonts), or special fonts that are part of Cir-
cuitCAM. In contrast to TTF and TTC fonts, the special CircuitCAM fonts have the advantage
of a clear centre path, so that they can be manufactured efficiently by a milling/laser tool of the
chosen width:

n CircuitCAM default.

n ISO3098.

n CircuitCAM stencil. , the stencil font is used
when creating SMT stencils, the advantage of this font is that it creates gaps between
cuts, thus maintaining the stencil free of large cut holes, as seen in the preview image
with the letter "o".

The stencil font is designed in such a way that when the material is cut through by laser
or milling tool, no material will fall out. this is ensured by creating texts as little gaps.
See in the example the letter "o" is created using four small gaps. When using the other
fonts, the material inside the letter "o" will fall out.

When creating text in CircuitCAM, that text is converted into basic graphic objects on the spec-
ified layer. Because of this the text can not be edited afterwards.
Follow this routine to insert a new text:
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n Activate the Text function in the Insert menu or click on the Text in the Insert toolbar
and fill fields of text dialogue window.

Figure 227. Insert text dialogue window

n Set a destination layer in the Layer field.

n Set a font. Select a font family from the Font Name combo box. The font is a complete
set of characters, letters, and symbols of a particular typeface design. In addition, from
the Style combo box you can choose a type style (for example, Regular, Bold, Italic,
Bold Italic). The range of available type styles depends on the selected font. Select a
character set from the Charset combo box (for example, Arial font has Western, Baltic,
Turkish, Russian and other character sets).

Note: Some fonts inWindows 2000 cannot display all Unicode characters. If you see that
any characters are missing in your text, you can change the font to one that includes these char-
acters. Generally, the "Microsoft Sans Serif" font is a good choice for Unicode characters.

n Set a text height and the path width in the Height and Path width fields.

n Set a line distance in the Line Spacing field. The line spacing specifies the spacing
between baselines.
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n Set a character distance in the Char Spacing field. The character distance controls the
spacing between two characters. A positive character distance value moves characters
apart, any negative value is invalid.

n Set an interpolation level in the Level of linear interpolation. The level of linear inter-
polation controls the quality of drawing glyphs. To reach best quality, the level of linear
interpolation must be set to 10.

n Set a text insert mode in the Mode group. Possible modes are Mouse, Absolute and Rel-
ative.

n Set a rotation in the Angle field.

n Press OK. In case of the Mouse mode, you need to set the start point of the text in the
graphic window with the mouse and do left-click to fix the text.

3.3.13. Barcode
The create text function can also be used to create barcodes. In this case the created graphics
does not represent the text itself, but instead consists of a sequence of rectangles which make
up the barcode.

Figure 228. Barcode Sample
To insert a barcode, special additional fonts to support barcode must be installed. The pro-
cedure is the same as inserting text but the font is changed to a barcode supported font.
Barcode fonts can be obtained from several places over the internet, either paid or for free.
Barcode fonts are usually available in the TTF (True Type Font) format, or TTC (True Type
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Collection) format. To install new TTF or TTC font into a Windows system, a right mouse
click is applied on the file, then install is selected from the context menu.
To read more about TTF and TTC fonts, please refer to: "http://e-
n.wikipedia.org/wiki/TrueType" and "http://en.wikipedia.org/wiki/TrueType_Col-
lection#TrueType_Collection"

Figure 229. Installing a new font

Listed below are some of the fonts we tested at DCT;

n http://www.barcodesinc.com/free-barcode-font/
n http://www.free-barcode-font.com/
n http://www.ttfotf.com/free/barcode-fonts/
n http://www.windows8downloads.com/win8-bar-code-3-of-9-wbccwyxh/
n http://www.windows8downloads.com/win8-bar-code-2-of-5-interleaved-cragiwnl/
n http://www.windows8downloads.com/win8-ean-bar-codes-coxrgxyk/
n http://www.windows8downloads.com/win8-connectcode-datamatrix-barcode-fonts-gcy-
mauwa/

Note: Some fonts have some additional requirements/settings to operate; e.g.: to use the
first two example fonts, the data embedded in the barcode must be contained between asterisks
"*", i.e.: to write "ABC123" in barcode it should be entered as "*ABC123*", those asterisks
will be ignored by the barcode scanner/reader. For other fonts requirements please refer to
each font individual documentation.

Note: All mentioned brands, websites, and companies are only listed as examples and
external references, material/information included in the external links are subject to change
without notice.
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3.4. List Views
The list window (list view) displays layers, configurations, apertures, tools and other sections
of a CAM document in a tabular form. The following functions are supported in the tabbed pan-
els:

n User can edit, delete or add new entries. It is supported by Copy/Paste, Delete oper-
ations and in Properties dialogue boxes as well
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n Multiple selection is supported by using the standard selection keys (Ctrl + mouse, Shift
+ mouse and Shift + arrows).

n All list view windows supports standard Print Preview and Print commands.

Selected and Active List Entry
entries in the list views can be selected by either the mouse or the up / down arrow keys. When
a list view is active, the properties view shows information about the selected item. An item
can be made active by either double clicking it or by choosingMake Active from the context
menu. An active object is indicated by bold text. In the case a graphical object is selected, the
name of the corresponding items in the list views ( layer, config-item, layout) is indicated in
bold red color.

Figure 230. D14 is the selected item and the Properties View shows its characteristics.
D16 is the active item of the selected graphic object, shown in red bold color.

Paste Conflicts
Conflicts may appears when pasting data from one CAM document into another CAM doc-
ument because objects with the same name already exist. For the following types conflict solu-
tion is supported through a special dialogue:

l Layers
l Tools
l Layouts
l Jobs

The paste dialogue will only show up only if conflict exist. User can choose to either over-
write, not overwrite, overwrite all, not overwrite all or change the name of the object.
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Figure 231. Paste Layer Dialogue
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3.4.1. Layers
Every graphical object is assigned to a layer. Layers with their current settings are listed in the
Layers view. The window can be activated in the following ways:

n Selecting Layers in the View menu;

n or clicking the layer button in the Layers toolbar;
n or by pressing and holding Ctrl + tapping on Tab, then select Layers in the dialogue
window.

Figure 232. Layers view
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n Visible: Click on this check box to make the marked layer visible or invisible,
i.e.: it is no longer shown in a graphics window. At the same time, when a layer is invis-
ible, it cannot be selected. If the layer is subsequently made visible again, it still cannot
be selected and must be made selectable again.

n Name: Specifies the name of the layer. A layer can be activated by pressing Alt + dou-
ble click on its name, or selecting it from the Layer toolbar drop down list, or by select-
ingMake Active from the context sensitive menu (right mouse button on an applicable
layer).
The status of the layer is indicated by the text style and color:

l Grey - The layer is not assigned (has no available object data);

l Black - The layer is assigned (has associated object data);

l Red - The layer is assigned and some of the available objects are selected.

l Bold Text (black or red) - the layer is active. New data are saved on this layer.

n Order: Click on the number to make the marked layer the highest (top) level. The
number 1 is assigned to this layer and the number of all other layers is incremented by
one.

n Selectable: Click on this check-box to switch the marked layer to "not selectable" ,
i.e.: the concerned layer cannot be selected by any of the above facilities and thus not

modified either. Clicking the check box again switches back to "selectable" .
n True Width: Click on this check box to show the elements on the marked layer with

their real line width ( True Width). Otherwise the width=0 mode is used ( Line
Only).

n Outline: Graphic elements (a line, a rectangle, a circle and a polygon) are shown filled

as standard ( Filled). Click on this check box to show the elements on the marked
layer only in outline ( Outline).

a) b)
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c) d)

Figure 233. Graphic view: a) True Width and Filled, b) True Width and
Outline, c) Line Only and Filled, d) Line Only and Outline

n Color: Specifies a color of the graphical object on a particular layer. The colored
square is divided in two parts. The right part specifies a color of the flashes on the layer,
the left - for other graphical objects on the same layer. There are two ways to select a
color for the layer: In the Layer properties dialogue window (double click on an appli-
cable layer to open the dialogue window);

n In the Colors dialogue window, which is invoked by using the Select color sub menu of
the context sensitive menu):

Figure 234. Colors dialogue window
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Context Menu

A context sensitive menu is available (mouse right button) to activate, move, copy, add new,
delete a layer, change properties of the layer, add graphical objects to the selected layer and
etc.

Figure 235. Layers view context sensitive menu

Move to Layer Move selected objects to the focused layer.

Copy to Layer Copy selected objects to the focused layer.
Make Active Make the current layer active.
Hidden Make the current layer invisible on the graphics window.

Visible Make the current layer visible on the graphics window.

Visible Selected Only Make the current layer visible on the graphics window, other lay-
ers made invisible.

Disable Selection Make the current layer non-selectable.
Enable Selection Make the current layer selectable.
Enable Selected
Only Make only the current layer selectable.

Select Graphic Select graphic objects on the layout according to selected layer
(s).
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Objects

Invert Selection Select all non-selected objects and deselect previously selected
objects.

True Width Show elements on the marked layer with their real line width.

Line Only Show elements on the marked layer in line mode=0.

Outlined Show elements on the marked layer in outline only.

Filled Show all graphical elements filled.
Order Arrangement
Mode Set the order arrangement mode On.

Move Up Change the order of the layer by moving it up.

Move Down Change the order of the layer by moving it down.

Copy Copy the selected layer to the standard clipboard.

Paste Extract the objects from the clipboard.

Remove Remove the selected layer.

Add Create a new layer.
Properties Open the Layer Properties window.

Toolbar

The Layers view has its own toolbar.

Figure 236. Layers view toolbar

The list of available actions in the Layers view. This list contains items available in
the context sensitive menu.
Show all layers
Show all layers. If the option is set Off, only layers,
which contain any object are listed.
All Visible and Selectable
Make all layers visible and selectable.
Add Layer
Add a new layer.
Remove Layer (Delete)
Remove a layer.
Order Arrangement Mode
Move Up
Change the order of the layer by moving it up.
Move Down
Change the order of the layer by moving it down.
Move to Layer
Move selected objects to the focused layer.
Copy to Layer
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Copy selected objects to the focused layer.

Layer Properties

The Layer Properties dialogue window helps to create a new layer, or change properties for
an already created layer. 
It comes up with:

n context menu (right mouse button);
n double-click on a cell in the Name column.

Figure 237. Layer Properties dialogue window

n Name: Specifies the name of the layer.

n Order: Indicates order number for the layer.
Settings group

n Visible: If On, the current layer is visible in the graphics window.

n Selectable: If Off, the current layer is not selectable and cannot be modified.

n True Width: If On, the elements on the marked layer are shown with their real line
width.

n Outline: If On, the elements on the marked layer are shown only in outline.
Layer Colors group
Select a color to display graphic objects in the layer. The Flash Colors group works in a sim-
ilar way but for flashes only.

The double click on a cell in the Order column makes this layer first in the list.
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Note: New options will be applied to all selected layers simultaneously.
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4. Tools View
A tool, also called aperture or configItem is an object with geometric properties, that can be
used to create flashes or to draw paths. In the case the object is used for milling or drilling
machines, that are driven by certain NC formats, we call the object a tool. In the case the
object is used for photo plotters or layouts formats, we call it an aperture. The generic term in
CircuitCAM for all these cases is configItem.
ConfigItems are grouped into lists, that are called configurations, tool lists or aperture lists.
Each list belongs to a format, and depending on the type of the format, special properties apply
to these lists. For the PostScript format any kind of configItems can be used. Tools and tool
lists can also be created independent of a particular format under the Diverse category.
The tools view is organized in a tree structure, the highest level is the data format, the second
level is individual lists, and the third and final level is the tools and apertures.
Supported NC formats:

n Excellon
n LMD
n G-Code
n HP-GL

Supported Layouts/photo plotters formats:
n Gerber -including extended Gerber "Gerber X"
n Barco
n IEC61182
n ODB++

Other formats:
n PostScript
n Diverse

The Tools view can be activated in the following ways: 

l Select Tools in the View menu, or you can select a tool from the combo box in the
standard toolbar;

l or by pressing and holding Ctrl + tapping on Tab, then select Tools in the dialogue win-
dow.
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Figure 238. Tool view

Figure 239. Combo box, standard toolbar view

Expand the nodes to view the list of apertures/tools:
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Figure 240. Apertures/Tools list in Tools view
The tools view is divided into several columns:

n Name: This field shows the type, the list name, and the aperture/tool name with the
corresponding shape icon; identifying the shape of the tool: - circle; - square;
- oval; - rectangle; - rounded rectangle; - bevel rectangle; - octagon; -
marker; - special; - undefined.

n a, b, c, ... , j : These fields describe the shape dimensions. E.g.: a - value means a dia-
meter of a circle or a width of a rectangle/oval; b - height of the rectangle; c - value
sets a bevel or radius for a bevel/rounded rectangle. In case IEC special shape library
is used, these values are set according to the shape description that is standard of IEC
library. An empty field means either the value is zero or this field is not used. If a tool
is used only in a drawing mode, a and b fields show the end type and the corner type of
the path.

To see more detailed tool properties or to modify them (e.g.:, to change mode, type, dimensions
and so on) a special tool dialogue window can be used (see Tool Properties).

Context Menu

While using the right mouse button in the client area of the Tools view, the following popup
menu (mouse context sensitive menu) will appear:
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Figure 241. Tools view context sensitive menu

Make Active Set the tool for a graphical object (path,
flash).

Select Graphical
Objects

Select graphical objects on the layout
according to selected tool list(s)/tool(s).

Add Tool List... Create a new tool list.

Add Tool... Create a new tool.
Insert Copy Create a new tool list/tool copy.

Copy Copy the selected tool list/tool to the stand-
ard clipboard.

Paste Extract the objects from the clipboard.

Remove Delete selected tool/list.

Properties... Activate the Aperture/Tool properties win-
dow.

Toolbar

The Tools view has it's own toolbar.

Figure 242. Tools view toolbar

The list of available actions in the Tools view. This list contains same items avail-
able in the context sensitive menu.
Show All Tools
Show or hide unused apertures/tools in the tools view.
Add Tool List
Create a new tool list. A new tool list will appear below the selected tool list.
Add Tool
Create a new tool. A new tool will appear below the selected tool in the list.
Remove Tool/List
Delete selected tool/list. Only unused tools can be removed.
Aperture/Tool Unit
Change unit for aperture/tool dimensions.
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4.0.0.1 Tools List Properties

Gerber / Excellon / IEC61182 / Sieb & Meyer Format Prop-
erties Dialogue
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Figure 243. Gerber (Excellon / IEC61182 / Sieb & Mayer) Format Properties dialogue
window

l Unit: Select a unit (mm or inch) which is used to represent the coordinates of all graph-
ical objects drawn using this tool list.

l Decimal position: The position of the decimal point has to be determined. To do this,
the m.n digits, and the information whether leading or trailing zeros are to be output,
are used together.

l Values: Coordinates can be in absolute or relative (incremental) form.

l Digits m.n: These values are used if no decimal point format is set. "m" indicates the
number of digits before the decimal point and "n" the number of digits after the dec-
imal point.

l Size (for Export only): Indicates the size (bounding box) of the board.

Coordinate Format

Right click on a tool/aperture list node and select Properties to open a particular tool/aperture
list properties dialogue window. To add a new tool list, click on the Add Tool List button. The
Coordinate Format dialogue window helps to create a new aperture/tool list or change prop-
erties for already created aperture/tool list.
Tool List Name field allows the user to modify a name of the tool list.

Postscript Format Properties Dialogue

Figure 244. Postscript Format Properties dialogue

Enable export size: If Enabled flag is set On these four values specify the size of the avail-
able export area. This information is used for export only. See also Enable export size in Gen-
eral Settings under Default Configuration , see also Data Formats
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HP-GL/Diverse/LMD Format Properties Dialogue

The same data format dialogue window is used for HP-GL, Diverse and LMD con-
figurations.

Figure 245. HP-GL (Diverse / LMD) Format Properties dialogue window

n Unit: The resolution can vary from plotter to plotter. The HP7475 plotter from Hewlett
Packard (one of the first with the HP-GL language) has a resolution of 0.041 mm.

n Direct circle export: If flag is On, the HP-GL exports simple circle. Otherwise (cir-
cle like shapes) are exported as arc segments. 

n Arc interpolation: If flag is On, then an arc in closed/opened path and a circle in
closed path are exported as a set of lines. Interpolation step depends on values from
"Unit" and "Max chord-length".

n Max chord-length: Specifies the maximum chord length during arc interpolation. 
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n Max Working Area: If Enabled flag is set On, these four values specify the size of
the available plot area. This section is used for export only.

l see also Data Formats

DXF Format Properties Dialogue

Figure 246. DXF Format Properties dialogue window

n Unit: Shows a unit value, which is used to represent the coordinates of all graphical
objects drawn using this tool list. For import this setting is only used as default and can
be overwritten by the appropriate commands.

n Fill Circles: If flag is set On an imported circle is filled. Otherwise the circle is
assumed as circle in Closed-path (a contour with zero path width).

l see also Data Formats

Barco Format Properties Dialogue

Figure 247. Barco Format Properties dialogue window
This empty dialogue means that there is no possibility to change this format's parameters, see
also Data Formats .

G-Code Format Properties Dialogue

For G-Code export the assumption is that the PCB is in the x-y plane of the machine. Several
values for the Z-axis have to be provided for rapid movement, milling, and drilling. The value
depends on the absolute Z-position of the machine in relation to the work piece.
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Figure 248. G-Code Format Properties dialogue window

n Unit: Select a unit (mm or inch) which is used to represent the coordinates of all graph-
ical objects drawn using this tool list.

n Up: Defines the Z-value for rapid movements without milling/drilling.

n Down: Defines the Z-value for milling operations.
n Drill: Defines the lowest Z-value for drilling.
n Enable export size: If Enabled flag is set On these four values specify the size of the
available plot area. This section is used for export only.
see also Data Formats
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4.0.0.2 Tools Properties

A tool, also called aperture or configItem is an object with geometric properties, that can be
used to create flashes or to draw paths. The properties of a tool/aperture are specified in the
aperture/tool properties dialogue. The main property of an aperture/tool is its type. Various
dimensions of the tools, are expressed in the letters "a, b, c, d, e, f, g, h, i, j". The following
types are supported;

n Rectangle: A rectangle is defined by two opposing points, and it is oriented parallel to x
and y axis, the parameter a defines x direction value, b defines y direction value.

n Circle: A circle is defined by a centre point, and a diameter. the parameter a defines the
diameter.

n Oval:
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n Square: A square consists of four equal sides, and four 90 degrees angles, and it is
oriented parallel to x and y axis, the parameter a defines the side length.

n Rounded Rectangle:
n Bevelled Rectangle:
n Octagon:
n Marker:
n Undefined:
n Special:
n Off:

The Aperture/Tool Properties dialogue window helps to create a new aperture/tool, or
change properties for the already created aperture/tool.
To open Aperture/tool properties dialogue, select tool from tool list, using your right mouse but-
ton, click on selected tool then properties. See also Active config-item, Library View.
The Name field specifies an aperture/tool name.

Flash Attributes

Shows the tool shape and size for the flash mode (as shown below and is set by default):

Figure 249. Aperture/Tool Properties dialogue window, Flash Attributes panel
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n Name: Specifies an aperture/tool name.

n Type: Specifies the shape of an aperture/tool for the flash mode. To change the type
(shape) to circle/square/oval/…/Marker/Special, click on the drop down menu next to
the field, and edit the fields a,b,c,…,i,f if needed.
Select the Off option, to switch off the usage of this tool in a flash mode (when the tool
is needed only for drawing).

n IEC61182: Specifies the shape from the special shape library. To set a shape from the
special shape library, select the Special line and select a type from IEC61182 combo
box (or type from the keyboard).

n a, b, c, ..., j: These fields describe the shape dimensions. E.g.:, a value is the diameter
of a circle or the width of the rectangle/oval; b – the height of the rectangle; c value sets
a bevel or a radius for a bevel/rounded rectangle.

n Edit: Opens a new dialogue, for graphical editing in tool properties, the graphical edit-
ing of the aperture/tool layout can be ended by either saving the changes or discarding
them. It can either be ended by choosing Save/Discard from the Item Edit window
shown below, or by accessing the menus; Edit ---> Item Edit ---> then choosing Save
or Discard.

The bottom part of the dialogue "Preview" shows the graphical view of the selected tool/aper-
ture, and explains the meaning of fields (a/b/c/…/i/f).

Transform

Shows the origin point xOff/yOff according to how the tool is drawn by using dimensions from
the (a/b/c/…/i/f) fields, how it is rotated, and what scale is used. These fields are only avail-
able for flash apertures which does not belong to the Special group.

Figure 250. Aperture/Tool Properties dialogue window, Transform panel
If the User Defined check box is switched On, it is possible to modify the displayed values.

Draw

Shows the tool size and some additional features for the draw mode.

Note: The tool shape is the same as in Flash page.
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Figure 251. Aperture/Tool Properties dialogue window, Draw panel

n If the Derived from Flash Definition check box is switched Off and the Available
check box is On, it is possible to modify these values. Otherwise they are set from the
flash attributes.

n Path width: defines the thickness of lines for the path drawing.

n End type: the type of the start and end points of the path.

n Corner type: specifies the corner's type of the path.

n Capture interval: specifies the min andmax values, which are used to select an appli-
cable drawing tool in export operations. The size of selected tool must be inside the
capture interval (min < pathWidth > max). If Capture interval flag is Off, default min
and max values are used: min = pathWidth * 0.95, max = pathWidth * 1.05.

Note: The capture interval option is used only for drawing. The capture interval for flash-
ing is defined in the Diverse page.

n Overlap value: (when flag Overlap=On) is used:

1. in Export task to specify the overlap value in shapes filling mode;

2. in Export task to store an initial overlap value of scanner fields.

n Min path length: defines the length value of the shortest path, which participates in
the following conditions:

1. in Export: pathWidth  >  Min path length;

Diverse

When the User Defined check box is switched on, shows and allows modification of the tool
capture interval for flashing:
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Figure 252. Aperture/Tool Properties dialogue window, Diverse panel
To output a pad as a flash, the tool size (a/b/c/…/i/f) must be inside the specifiedMin and
Max values. If User Defined flag is Off, default min and max values are used (e.g.: for a:Min
= a * 0.95, Max = a * 1.05).
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4.0.0.3 Tool Edit Mode

Tools/apertures of type special, do not have parameters, and thus can only be edited graph-
ically. Tools/apertures of other types can also be edited graphically, but they are then auto-
matically converted into special tools.
Graphical editing of a tool is accessible through the tool properties, under Flash tab, when
clicking the Edit button, the current shape of the tool is converted into a special temporary lay-
out, with a unique name e.g.:@@_Item_Edit_GerberDefault1_D13. When finishing the graph-
ical editing of a tool, the special layout is removed.
While graphically editing a tool/aperture, all normal editing operations of a layout are avail-
able, with the exception that only one predefined temporary layer can be used.
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Figure 253. Tool properties window.

Figure 254. Tool Edit mode.

Editing a tool works exactly like the graphical editing and insertion operations; you can modify
shape or size, you can add another path or polygon, you can create a cutout......etc.
After finishing the desired editing, the edit mode can be closed by choosing either to save or
discard the changes.

Figure 255. Ending the item edit mode by selecting Save/Discard changes.
Editing mode can be ended also by accessing the menu; Edit ---> Item Edit ---> then choos-
ing save or discard.
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4.0.1. Jobs and Quick Access
The Jobs view contains a list of available jobs, which can be of type:
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n Stencil Frame generator,

n Export,

n Scripts.
The details of a job can be defined once stored in a CAM or CAT file, and can be executed
many times.

The Jobs view panel can be activated in the following ways: 

n Select Jobs in the View menu;

n or by pressing and holding Ctrl + tapping on Tab, then select Jobs in the dialogue win-
dow.

Figure 256. Jobs view

In case the Show in quick access option in script Properties window is checked, the selected
job is included into the Quick Access view.

Various jobs properties:

n Stencil Frame generator job properties;

n Export Job and Export Task properties.

n Script properties.
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Context Sensitive Menu (Right Mouse Button Menu)

When clicking the right mouse button in the client area of the Jobs panel, one of the following
context sensitive menus) will appear:

Figure 257. Jobs view context sensitive menus

Icon Function Description
Add Frame Gen-
erator... Create a new Frame Generator job.

Add Export
Job... Create a new Export job.

Add Task... Create a new task under the selected Export Job.
Add Script... Create a new Script.
Add Script Com-
mand... Create a new command under the selected Script.

Insert Copy Create a copy of the selected job/task.

Make derived... Create a new script, with parameters derived from the selected script.
(This function is only applicable with Scripts)
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Icon Function Description
Make Script
from Selection Create a new script from selected jobs.

Move Up Change the order of the Job/Command by moving it up.

Move Down Change the order of the Job/Command by moving it down.

Copy Copy the selected Job/Command to the standard clipboard.

Paste Insert Clipboard contents.

Remove Remove the selected Job or Command.

Run Run the selected Job.
Properties... Edit the selected Job or Command.

Note: Paste dialogue will appear if items have same names but items are different to
choose wether to "Override, Not override, Override all, Not override all, Change names".

Toolbar

The Jobs view window has its own toolbar; this toolbar contains the same functions accessible
from the context menu.

Figure 258. Jobs view toolbar
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4.0.1.1 SMT Stencil Frame Generator
The SMT stencil frame generator creates the outer geometry objects of a stencil:

n A rectangular shape.

n A rounded-rectangular shape.

n Only the corners of the rectangular/rounded  shape with middle segments.

n Rectangular/rounded shape with a user specified gaps.

The created frame is displayed as a path with width 0 on the destination layer.
In addition the frame generator has a possibility to create and add a pattern of fixing holes in
the generated frame.

SMT Stencil Frame Generator Dialogue Box

To open the dialogue box, select an existing job under Stencil Frame Generator branch or add
a new job in the Jobs view.
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Figure 259. Stencil Frame Generator dialogue window

n Job name: Allows the user to enter/edit a job name.

n Frame size: Defines the frame-box size; switched On check-box.

n Radius: Indicates that the rounded shape will be drawn. The field of the radius (not dia-
meter) size is available; in case the.

n Centermark: Is switched On, a special marker (like a “V”) with a width of 2 and a
height of 3 mm at all sides is generated.

n Whole outlines: Means that a rectangular shape or a rounded rectangular shape will be
created.

n Corners only: Creates either the corners [15 mm] of the rectangular shape with middle
segments [20 mm] or the corners [90 degree arc + 10 mm line extensions] of the rounded
rectangular shape with middle segments [20 mm] if the Radius check-box is switched
On.

n Break Out Tabs: Means that a rectangular shape or a rounded rectangular shape with
specified number of gaps will be created. Parameters of such gaps are controlled in the
special Break Out Tabs group.

n Graphic from File: Copies the whole layout from the selected file on the destination
layer. To choose the file a special Graphic from File tab is used.
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Note: If the size X/Y in the Whole outline mode, is smaller than 50 mm, the middle seg-
ments are skipped. If the size X/Y is smaller than 30 mm, the corners are connected.

n Break Out Tabs group: No on x defines a number of gaps in x direction; No on y
defines a number of gaps in y direction;Width defines a width of the gap (the same in
both directions).

Notes:
1. Group is enabled only if Break Out Tabs shape is set.

2. In case of even number of gaps the centermark is allowed.

n Destination Layer: Specifies a layer on which the generated frame is placed. It can be
chosen from the list or entered as a new one.

n Centred on Layer mode: The frame is centred and placed around the sum of all objects
on one of source layers. The source layer can be chosen from the list or entered as a
new one.

n Absolute to zero point: Absolute to zero point mode places the frame as absolute, i.e.:
one of the corners of the generated frame is at the given X,Y coordinates. This corner is
chosen from the Corner group.

n Glue Holes: The glue (fixing) holes will be generated only if Enable flag is switched
On.

n Aperture: Specifies a type of the glue hole. Only two types of flashes are allowed - cir-
cle and square.

n No of rows: Specifies the number of rows of fixing holes. The number is the same in
both x and y directions. If this number is zero the flag Enable will be switched to Off
automatically.

n Hole diameter: Specifies the diameter of the hole. All holes have the same diameter.

n Row distance: Specifies the distance between two rows. To get a regular placement of
holes, the distance can be recalculated and be different in x and y directions.

n Layer: Specifies the layer where generated fixing holes will be placed. It can be chosen
from the list or entered as a new one.
The figure below shows a frame with circular glue holes generated with parameters that
were set in the dialogue box.

(246)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Figure 260. Frame with circular glue holes

l OK button saves all the values in the job.
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4.0.1.2 Export Job
With export job it is possible to convert the contents of the current layout into formats other
than the CAM format. All supported formats are graphical formats, except for layout instances,
which only provides a list of layout instance names. For all other formats an export job is
divided into smaller export tasks, which allow exporting of individual layers with different
parameters. Available export jobs are listed in the Jobs view and also under File -> Export
menu. Export jobs can be executed either by the Run button in the Jobs view or via File ->
Export -> ... menu.
To create a new export job, activate the Jobs view: select the Jobs submenu in the View
menu or click the Jobs tab on the left side of the CircuitCAM window. Then select
Export job type in the list, press on the button in the Jobs view toolbar or right click on the

Export branch and select the Add Script menu in the context sensitive menu. The Export
Job Properties dialogue appears.
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Figure 261. Export Job Properties dialogue window

n Name: specifies the name of the job.

n Configuration Type group: provides a list of selection buttons to select a format type.
For more information about data formats, see Data Formats.

n File Specification: unless otherwise specified, the file specification is relative to the
directory where the CAM file is stored. In the case that a new CAM document was
created (Untitled N) a Save As dialogue shows up for storing the CAM file in a direc-
tory to choose. The file specification may contain the character "*" that is then during
export replaced by the name of the CAM file (without it's extension). Examples:

l Assuming that the open CAM file is c:\test\example.cam

l "xyz.abc" will result into an exported file c:\test\xyz.abc,

l "*.abc" will result into an exported file c:\test\example.abc,

l "New_*5.abc" will result into an exported file c:\test\New_exam-
ple5.abc,

l "e:\mydata\xyz.abc" will result into an exported file e:\mydata\xyz.abc,

l "e:\mydata\*.abc" will result into an exported file e:\-
mydata\example.abc.

Note: If no tool is defined for the export job an Export Error Message window will
appear.

n Transform button allows a user to set a new origin point, new scale and rotation of all
data by the defined angle. See Export Transforms.

n 1:1 Transformation: This flag indicates whether further scaling is applied in the trans-
formation menu, if scaling is applied checking this box will restore the scale to 1.
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Running an Export Job

To run an export job:

n Select the desired export job, then press the Run Job button in the Jobs view tool-
bar.

The run job processing window appears, indicating the progress of each job/task steps.

Figure 262. Job processing window

After a job is finished successfully, a confirmation window appears, this window also displays
the output path of the exported file, (the path of the exported file is the same path of the CAM
document);

Figure 263. Job finished window

If a job was erroneous; an indication window appears, this window displays the number of
warnings and errors that were found during the execution of the job.

Figure 264. Job finished with errors window
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Examples for some of the export errors:
n Inappropriate tool(s) defined.
n Export size (area) not compatible with the design area.

All the job progress is displayed in the Message Log.

Figure 265. The Message Log showing the job execution details
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4.0.1.3 Export Task
To open the Export Task dialogue window: select an export job under the Export node
(in the Jobs panel) and click left mouse button on it. Press right mouse button on the existing

task and press the button or create a new task by using the button . Export task char-
acteristics will be shown. 
When having more than one export task in an export job, the different export tasks maybe
based on different configurations/tool lists of the same type (e.g.: G-Code, LMD). In this case
the format details of configuration of the first task will be used for the whole exported file. For
the following tasks only the specified tools/config-items are considered, but not the format
details.
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Common Export Tasks Properties

n Layer: Graphic data on the selected layer will be exported.
In the selection list there are filters; "-- All --" and "-- All visible --".
Selecting "-- All --", will export all layers, selecting "-- All visible--" will export all vis-
ible layers.

Note:When selecting "-- All --", empty layers will be ignored, but invisible layers
will be exported.

n Use job transformation: If ON, the current task uses transformation properties of the
related job. If OFF, the Transform button is enabled and a user can set individual trans-
formation for the current task in the Export - Transform dialogue.

Common Export Task Properties except PostScript

Figure 266. Excellon Export Task dialogue same as (G-code, DXF, Barco)

n List: A name of the aperture list, it can be configured for all export jobs except Ger-
berX type. Either an existing configuration/tool list is chosen, or a new one is gen-
erated, based on the default configuration properties in general settings. Included in the
aperture list is the desired export size, in case no size is specified, the size specified in
the general settings will be used.

n Sorting: A group of flags to define how the order of the output objects will be done.
Direction specifies the sorting direction. Enable the Min.Distance flag to switch-ON
sorting, flag Off is used to switch-Off the sorting at all. If flag Closed (primary) paths
first is enabled, the closed paths have higher priority to compare with the rest of
objects. Circle-diameter flag groups circles according to the diameter size.
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n Fill mode: allows filling of closed shapes during an output. The default filling is con-
centric.

n Collect: This flag extends a scope of actions on flashes and circles. E.g.:, the flag Poly-
gon in Gerber export, outputs all flashes and circles as Gerber polygons too (with G36
and G37 commands); if arc interpolation is set it is used for flashes and circles too and
so on.

Special Properties for GerberX Export Task

Figure 267. GerberX Export Task dialogue

l Polygon: The flag is used only for Gerber to output the Gerber polygons (with G36 and
G37 commands).
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Special Properties for HP-GL and LMD Export Task

Figure 268. LMD Export Task dialogue

n Macro: This LMD-Format specific functionality allows minimizing the amount of data
to transfer, by sending a complex configItem only once, and then only sending the trans-
formations for each flash. Main usage of this functionality is for SMT Stencil Laser
applications..

n Scanner Support: In the case that scanner fields are defined and a flash fits completely
within a scanner field, then the flash will become part of the scanner field. If a flash
does not fit completely into one scanner field it will be processed outside of the scanner
fields.
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Special Properties for HP-GL Export Task

Figure 269. HP-GL Export Task dialogue

n Extending: To do swing-in and swing-out. The swing-in and -out path is a short line vec-
tor, which is tangential to the start and end-point of open paths. Closed paths, circles and
polygons are not supported this way. For the swing-in and -out lines a special artificial
tool (PEN) with number (last_used + 1) is used. The distance for swing-in and swing-out
(one) is specified in corresponding edit field.

Figure 270. Swing-in and -out paths (blue lines)
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Special Properties for PostScript Export Task

Figure 271. Post Script Export Task dialogue

n Configuration: Drop down menu to choose a preset configuration for the export size, in
case no configuration chosen, default configuration from the default configurations in the
general setting menu is selected

n Inverse: If ON the Postscript layer is exported in negative color way. Oversize option
is enabled when the Inverse flag is ON, it create a bounding box based on the value pro-
vided.

Note: Typically when working for PostScript, one file per layer is needed. To achieve
these several export jobs, each with a single task for one layer is needed.

Note: PostScript files "*.ps" are viewable by applications such as;
n Adobe Acrobat "http://www.adobe.com/products/acrobat.html"

n GSview "http://www.ghostscript.com/"
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4.0.1.4 Export Transforms
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Figure 272. The Export Transform window.

When clicking the Transform button in the Job Properties or Task Properties windows, the
above window appears with the following selection groups:

n Orientation Group:
o Fixed Angles: Rotates the orientation of the design on the specified working area

with a fixed angle; (0, 90, 180, 270)
o Mirroring: Mirrors the orientation of the design either on X-axis or Y-axis.
o Fixed Angle and Mirroring: Combines various values of fixed angles and mir-

roring.
o Auto: This selection selects the best orientation for the working area, either nor-

mal or rotated 90 degrees.
o Other: Rotates the design according to an arbitrary angle; the Auto function is

only available for LMD, HP-GL, Excellon, and G-Code exports.

n Origin Group:
o Align X: This menu has 4 variants; Off: No alignment on X-axis, left alignment,

centre alignment, and right alignment.
o Align Y: This menu has 4 variants; Off: No alignment on Y-axis, top alignment,

centre alignment, and bottom alignment.
o X: Specifies a value for an offset on X-axis.
o Y: Specifies a value for an offset on X-axis.

n Scale Group:
o Auto Checkbox: Automatically fits the design to the whole working area.
o Value field: Specifies the value to scale the design. E.g.: If we enter the value 2,

the size is doubled.
The transformation settings can either be set in the Job Properties, or Task Properties. If a
transformation is set in the job properties, this transformation can be applied to all tasks falling
under that job. However in the task properties it can be chosen whether to use the general job
transformation or specify a special transformation for that task.

Note: For the following formats rectangles are not supported while export job transform
is used with a free angle (LMD, HP-GL, Excellon, GCode).

(256)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

Note: BARCO and DXF formats have no sizes.

Examples on Export Transforms

Transformations

Figure 273. Alignment is set to centre on X and Y axis
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Figure 274. Alignment is set to centre on X and Y axis, and scale is set to "2" - Double

Figure 275. Alignment is set to centre on X axis, and bottom on Y axis, and scale is set to
"1/2" Half, and 90 degree rotation

Figure 276. Alignment is set to centre on X and Y axis, and the inverse flag is on
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Figure 277. Alignment is set to right on X axis, and centre on Y axis

Figure 278. Alignment is set to right on X axis, and centre on Y axis, and rotation is 270
degrees

Auto Origin

For the auto origin function we have an example of a drawn figure, left figure shows export
without using auto origin function, right figure shows export file while using auto function.
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Figure 279. left figure shows the auto origin off and right figure shows the auto origin on

Auto Scale

For the auto scale function we have an example of a drawn figure, left figure shows export
without using auto scale function, right figure shows export file while using auto scale func-
tion.
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Figure 280. left figure shows the auto scale off and right figure shows the auto scale on

Note: Auto origin function can be selected with the auto scale function.
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4.0.1.5 Scripts
Scripts are jobs which provide the capability to execute a sequence of tasks without further
user intervention. Script commands are either invocations of other jobs or normal tasks. Scripts
appear under the Script branch in the Jobsview. Scripts can be assigned to categories of arbi-
trary names.

Figure 281. Jobs view, listing available Scripts and Quick Access view with included
Scripts
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Add Script

To create a new Script click on Add Script button in the Jobs view toolbar. The Script
Properties dialogue window appears on the screen.

Figure 282. Script Properties dialogue window

Name Shows/uses the Script name

Background
processing

CircuitCAM executes the Script in minimized mode. No messages, any ques-
tions come up in the screen (except a file open dialogue for import task in Open
File dialogue mode).

Show mes-
sages

If Off, no messages, any questions come up in the screen (except a file open dia-
logue for import task in Open File dialogue mode).

Show prog-
ress bar If Off, the progress bar does not show.

Create log
file If On, creates a log file in a specified place.

Append if
exists

If On and a log file already exists with the same name, it appends the info at the
end.

Multiple export tasks can be grouped by choosing the option make Script from selection, this
option allows the user to choose different script jobs to be run at once, also can be added to
Quick Access.

Note: If warning or error message appeared for one of the grouped scripts, it will be
shown immediately and referred for later to be viewed in the Message Log, to disable the warn-
ing or error message uncheck the show message flag in the Quick Access properties.
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Script Properties

To see the current parameters of a particular job, select the job or press right mouse button and
select Properties menu item. The Properties view with detailed data of the selected job
appears on the left bottom section of the CircuitCAM window.

Figure 283. Properties view of selected Script

Focused object
Type Specifies the type of the focused object - Job.
Name Shows/uses the Script name.
Category Specifies the category the selected job belongs to.

Image

A static picture that is shown along with the
Script in quick access that should illustrate the
capabilities of the script. All pictures are stored in
the sub-folder img under the installation directory,
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e.g.: C:\Program Files (x86)\CircuitCAM7\img.
User can place here further pictures as needed.
when pressing on "..." an open dialogue shows up
to choose a new picture for the current job. The
recommended size of images is 300 x 300 pixels
in PNG1 format.

Show in Quick Access If On the Job will be viewed and added in the
Quick Access View

Job execution

Background processing

CircuitCAM executes the Script in minimized
mode. No messages will display, any questions
come up in the screen (except a file open dialogue
for import task in Open File dialogue mode).

Show messages
If Off, no messages, any questions come up in the
screen (except a file open dialogue for import task
in Open File dialogue mode).

Show progress bar If Off, the progress bar does not show.
Log file

Create If On, creates a log file in specified place.
File name (will be gen-
erated if left empty) Specifies the name and the location of the log file.

Append if exists If On and a log file already exists with the same
name, it appends the info at the end.

Parameters Parameters for a particular job.

Adding Scripts to quick access

A Script is selected, then select an image file to be assigned to the Script by clicking on image
tab found in properties panel (See below; This image folder is found in the Program files\ Cir-
cuitCam7 \img), In the comment tab user may write a comment to be reminder of the Script
descriptions.
The Quick access view displays predefined and user defined Scripts for direct execution. Each
entry in the quick access view consist of:

n Name of the script

n The description of the script

n A picture indicating the script function

1A bitmap image file format that supports lossless data compression
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Figure 284. Assigning image to the corresponding job
The image chosen in the property panel will appear in the quick access panel along with the
comment that was added in the properties panel.

Note: If no picture is chosen, only the name of the Script will appear.

Note: If no comment is added nothing will appear with Script name.

Figure 285. Script added with image and comment is written below the job name
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Run Script

To run a Script:

l Select the desired script, then press the Run Job button in the Jobs view toolbar.
Or

l Press on an applicable job in the Quick Access view.

Figure 286. Run Script dialogue window

The Run job dialogue window appears on the screen. For each parameter a user can specify
Name, Type, Value, and Comment.
Name is a sequence of any alphabetical characters.
Type of parameter can be selected from the list of supported types in CircuitCAM. The types
of parameters are:

n String,

n Integer,

n Real number,

n Layer name,

n Tool name - it is used to specify a tool name with or without a tool list name in the front,
e.g.: “MillingTools/Universal Cutter 0.2 mm” - “MillingTools” is tool list name and “RF
Cutter 0.25 mm” is a tool name.

n Length - a distance in units, specified in CircuitCAM settings.
Value: Value is dependent on the specified type of parameter.
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Comment: This field is used to describe the current parameter (meaning, usage, restrictions
and etc.). This comment will be displayed in parameters dialogue window which is displayed
before job execution. Values that can be added to the comment field can be; free text, single
parameters, e.g.: "Layer $Layer_name is empty." or "Layer $src_layer was copied to $dst_
layer."
Save for later use:When checking the "Save for Later Use" box, the chosen parameters will
be saved within the CAM file so the user can apply them again later. If the box is not checked,
the changed parameters will only be used for this single execution of the script.
Get Defaults button: If the user wants to get the original parameters of the script, clicking the
Get Defaults button will do the following; check the underlying template file *.CAT, and com-
pare the current values and restore the original values.

Run Script Parameters

The following parameters are from the script "Insulate_Top_Rubout_Primary", the included
parameters may differ from one script to another;

n Tool Primary: The primary that will be used to mill the circuit board.
n Layer Source: Specifies the source layer for the insulation.
n Layer Rubout: Graphical objects on this layer define additional areas which have to be
cleared by the isolation process.

n Layer Destination: Specifies the layer for output data.
n Resolution for Polygon Package: Specifies the grid to be used.
n Top Side: Specifies whether the job will be executed on the top or bottom side of the cir-
cuit board.

n Overlap Percentage: Specifies the overlap between two insulation lines created by dif-
ferent tools.

n Allowed Damage:
n Overlap Same Percentage: Specifies the overlap between two insulation lines created
by the same tool.

n Additional Channels: Number of additional insulation channels to be created around
pads and tracks.

n Y-Parallel Rubout: Directions of serpentines.

Make Derived Script

This functionality allows creating a new derived script based on a selected script that already
exists. For this all parameters and their assigned values are copied, but the content of the
selected script is not copied. Instead of this a "Call job script task" which calls the selected
script is created. After the parameter values are modified according to the needs, a new script
is saved under the desired name.
When selecting "Make Derived" from the context menu, the following window appears; this
window is similar to the run script dialogue but it allows creation of a new script based on the
modified parameters.
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Figure 287. New Derived Script Dialogue

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved.

4.0.1.6 Script Tasks

Add Script command

To add a new task in the Script, press Add Task button either from the Jobs view own tool-
bar or context sensitive menu. Select a task from the tasks list and press OK button:
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Figure 288. New Script command dialogue window

There are two types of the tasks in the tasks list - Jobs and non-Job actions.

n In Add job, group you can see all predefined CircuitCAM job groups (SMT Stencil
Frame generator, Export, Script) and jobs, which are created in the current CAM doc-
ument. Export task additionally saves output file by the name, given by Save or Save As
commands. If there were no such tasks in the job, it opens the standard Save As dia-
logue, where the last imported file is suggested.

n Add non-job action group allows the user to add a new task as a function, which has no
execution jobs, for example Import, Create Outline.

Script command Parameters

To see the current parameters of a particular task, click on a task or press right mouse button
and select Properties menu item, the particular Properties view will appear.

Note: The Properties window differs according to the type of the task.
Any task has the following properties: type, name, and a comment property. The string in the
name property is displayed in the Jobs view. If it is empty, the type of the operation is dis-
played instead.
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Some tasks have some additional parameter fields. For example, the Oversize task, from the
Script commands group has these fields:

Figure 289. Properties view, Script command of type Oversize properties

Value A positive value for stretching, or a negative one for constraining the objects in
the stack.

Corner
type

Combo-box to select one of proposed types - rounded (Rounded), sharp
(Extended) or cut (Truncate).

Interactive Allows interactively set oversize parameter via input dialogue. Otherwise (if thisflag is Off) takes oversize value from the Value field.

Changing of property values is also done through the Properties view.

Available script commands

Import

Imports selected files to CircuitCAM.
Settings:
a) File to import. This parameter can be set to "Open file dialog" or "From command line"
mode.
If "Open file dialog" is set, the file selection dialog box is opened, otherwise the file(s) for the
import must be specified as command parameters.

b) File type recognition. This parameter can be set to "By import assignment" or "Automatic".
"By import assignment" value indicates that CircuitCAM will use "Import assignments" set-
tings to detect types of input files. If CircuitCAM will not be able to detect all file types -
import dialog box will be shown.
"Automatic" value indicates that CircuitCAM will use internal automatic recognition mode to
detect types of input files. If CircuitCAM will not be able to detect all file types - import dialog
box will be shown.

Save

Saves current document.
Settings:
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None.

Save As

Saves current document with different name.
Settings:
a) Interactive. This parameter has two states - ON or OFF.
If value is "ON", the "Save as..." dialog will be shown.
If value is "OFF", value from "File name" as new name.

b) File name. This parameter is enabled only if "Interactive" parameter is OFF.
Full path and file name must be specified.

Start an external Program

Runs external program.
Settings:
a) Program name. This parameter holds the full path to the executable file.
b) Parameters. This parameter holds parameters for the specified program.
c) Hidden.
d) Hold script until program closes. This parameter has two states - ON or OFF.

Terminate CircuitCAM

Stops CircuitCAM execution.
Settings:
None.

see also script commands of the Configurable Geometry Engine
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4.0.1.7 Configurable Geometry Engine
CircuitCAM is able to perform complex operations on graphic objects by the so-called "Set
Operations", also known as 2D “Constructive Solid Geometry” or CSG1 operations. In Cir-
cuitCAM the classical CSG operations are extended in various ways to include operations on
areas and paths, and to support infinite areas and more.
A Polygon/Path variable can contain either a Polygon or a Path. A Polygon can be completely
empty or completely full (infinite flag), and it can contain any number of non-intersecting
closed inner and outer boundaries which consist of line and circular arc segments. An outer
boundary defines the outline of an area. An inner boundary defines a hole within an area. A
Path can contain zero, one or many single paths, each consisting of any sequence of line and

1Constructive Solid Geometry
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circular arc segments. A single path may be closed or open; in the latter case it has a dedicated
start and end point.
Polygon/Path variables can be stored either on the stack or in a register. All operations that
consumes, generate or modify Polygon/Paths work on the stack; similar to the programming
language Forth, see http://en.wikipedia.org/wiki/Forth_(programming_language).
The stack can contain zero, one or more Polygon/Path variables. The Register contains a fixed
set of 100 Path/Polygon variables, numbered from 0 to 99. CircuitCAM ensures that at the
beginning of each Script the register variables are empty, the stack however may be filled by a
previous manual Set Operation.
Like all other Script commands, the Stack Operations are executed in the sequence in which
they are defined. Conditional and looping operations contain inner Stack Operations that are
only executed when a defined condition is met.
Stack Operations are created through the New Script command dialogue. Once created, the
properties (also called parameters) of the selected Stack Operations are displayed in the Prop-
erties view. Changes of property values are made through the Properties view. All Stack
Operations have a name and a comment property. The string in the name property is displayed
in the Jobs view. If it is empty, the type of the Stack Operation is displayed instead. Some
Stack Operations require further properties, indicated below.

CircuitCAM Document Preparation

Clear selection

Unselects all objects from the active Work layer.

Clear work layer

Deletes all objects from the active Work layer.

Copy selection

Copies selected objects to the active Work layer.

Create layer

Creates a new layer (if not exist already) and makes it the Work layer.

Create tool

Creates a new tool (if not exist already) and makes it the Work tool.

Create tool list

Creates a new tool list (if not exist already) and makes it the Work tool list.

If layer exist

Checks if layer with specified layer name exist in current CircuitCAM document.
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Move selection

Moves selected objects to the active Work layer.

Select

Selects objects on active Work or specified layer. This command has two additional modes to
manipulate current selection: adds additional objects to current selection or removes subset or
all objects from current selection.
This script command has filter which indicates object types to be added, appended to current
selection or removed from current selection.

Set work layer

Sets the new working layer for follow up operations. Before the first invocation of this oper-
ation, all Stack – CircuitCAM document interaction operations (e.g., Move to Stack, Copy to
Stack, ...) will work on the selected graphic objects, afterwards - on the objects of the work
layer.

Set work tool

Sets a new working tool for follow up operations. Before the first invocation of this operation
the currently active tool is used.

Set work tool list

Sets a new working tool list for follow up operations. Before the first invocation of this oper-
ation, the currently active tool list is used.

Stack – CircuitCAM Document Interaction

Move to stack

Calculates the merged outline(s) (outer and inner) of the selected graphic object(s), and pushes
it/them onto the Polygon stack. The graphic objects fromWork layer are removed.

Move to stack as path

Calculates the merged outline(s) (outer and inner) of the selected graphic object(s), and pushes
it/them onto the Path stack. The graphic objects fromWork layer are removed.

Copy to stack

Calculates the merged outline(s) (outer and inner) of the selected graphic object(s), and pushes
it/them onto the Polygon stack. The graphic objects remain onWork layer.
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Copy to stack as path

Calculates the merged outline(s) (outer and inner) of the selected graphic object(s), and pushes
it/them onto the Path stack. The graphic objects remain onWork layer.

Pull from stack

Pulls the result of a set operation from the Polygon stack. The result of this action is always
presented in the form of the CircuitCAM polygons (even if no operations were performed on
the Polygon stack). Resulting PP-Polygon will be placed onWork layer in CAM polygon and
path.

Pull from stack as path

Pulls the result of a set operation from the Path stack. The result of this action is always pre-
sented in the form of the CircuitCAM paths (even if no operations were performed on the Path
stack). Resulting PP-Path will be placed on Work layer in CAM path.

Pop stack

Pulls out and destroys last element from the stack.

General Stack and Register Operations

Clear register

Clears the Register.

Clear registers

Clears all the Registers.

Clear stack

Clears the Polygon/Path stack.

Copy register to stack

Copy the Register to the Polygon/Path stack.

Copy stack to register

Copies the Polygon/Path stack to the Register.
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Create Path

Creates path with two same coordinates and pushes it to the stack. A flag to specify if path is
closed or not.

Create polygon

Creates empty polygon and pushes it to the stack. An infinity flag for a new polygon is set via
parameter.

Duplicate

Makes a copy of the of the object on the stack and pushes it onto the stack.

If register has value

Checks if specified Register has Polygon/Path.

Move register to stack

Moves the Register to the Polygon/Path stack.

Move stack to register

Moves the Polygon/Path stack to the Register.

Swap

Replaces the content of the top two stack operations.

Simple Operations

Combine closed path

Combine a set of neighbour Paths into the single path. Initially this task checks and closes all
open paths in incoming set of Paths. The distances between closed paths are checked and
paths are combined if this distance is less than the value specified by the user.

Figure 290. Combine closed path initial data (left) and result (right)

Combine path

Combines the ends of single paths if the distance between the two ends is smaller than a spec-
ified value. Depending of the mode, the direction of single Paths may be inverted while doing
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so.

Covert to path

Convert Polygons to Paths.

Convert to polygon

Convert Paths to Polygons with the given thickness and corner/end types.

Create mark

Creates circular polygon on the stack with specified diameter parameter at the beginning of the
path which must exist on the stack.

Denest polygon cutouts

The cutouts (inner figures) are extracted out of polygon cutout and become separated areas.

Descending sheet clear

Clears the chain of descends sheets.

Difference

The top object on a stack is subtracted from the second object on a stack. The top object must
always be a Polygon. The second object and the result is either a Polygon or a Path.

Get bounding box

Calculates the bounding box of Polygon/Path on the stack. Four parameters X low, Y low, X
high and Y high will hold corresponding values of calculated bounding box.

Get center point

Calculates the centre point of Polygon/Path on the stack. Two parameters X and Y will hold
corresponding values of calculated center point.

Get length

Calculate the length of Path on the stack. The parameter Length will hold the resulting value.

Get mass point

Calculates the mass point of the Polygon/Path on the stack. Two parameters X and Y will hold
corresponding values of calculated center point.
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Get No of descending sheets

Calculates the number of descending sheets.

Get start point

Gets the start point of the Polygon on the stack. Two parameters X and Y will hold cor-
responding values of calculated center point.

Intersection

At least one stack value must be a Polygon.

Inverse

For Polygons, inverts all boundaries so that inner boundaries become outer boundaries and
outer boundaries become inner boundaries. By this also the infinity flag is changing. For Path
the direction of each single path is inverted.

Number areas

Numbers areas within the Polygon on the stack. The start number is provided via parameter
and the resulting number is set to the same parameter.

Number sheets

Numbers sheets within the Polygon on the stack. The start number is provided via parameter
and the resulting number is set to the same parameter

Oversize

In case of Path the Path is widened to an area.

Remove holes

Removes all holes and further nested objects inside Polygon on the stack.

Remove identical points

Removes the points with same coordinates from the Path on the stack.

Remove outlines

Removes all outlines on the top level, in case the infinity flag is not set. In the result, the infin-
ity flag is set.
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Remove small holes

Removes all holes and possible further objects inside that are smaller than a given value.

Remove small paths

Removes Paths, which have the smaller length than a specified parameter.

Resolve

Resolves Polygon on the stack with specified parameter for interpreting polygons overlay.

Rotate

Either rotates or mirrors in fixed 90 degree steps, or rotates by an arbitrary angle.

Sheet number clear

Clears sheet numbers for the Polygon on stack.

Shift

Shift all objects by the given x-y value.

Union

Both stack parameters are either Polygons or Paths. The result is of the same type. In case of
Path, the Path on the top of the stack is appended to the 2nd path on stack.

XOR

Calculates the exclusive intersection XOR between the two Polygons on the stack.

Simple Conditional Operations

Has boundary

Starts inner operations if condition is met.

Has data

Starts inner operations if condition is met.

Note: If level with a given name cannot be found, level will have no graphical objects,
error message will be generated.
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Is infinite (Pp infinity)

Starts inner operations if condition is met.

Complex Operations

Check missing holes

Checks Polygons from two different layers if each area on one layer has corresponding area on
the other layer. Three different polygons will be generated on the stack(starting from the most
top):

l "warning" polygon which indicates places where overlaps objects from more than two
layers

l "error 2" polygon which indicates areas where polygon from first layer exists, but not
corresponding polygon from the second layer.

l "error 1" polygon which indicates areas where polygon from second layer exists, but not
corresponding polygon from the first layer.

Create needle from concentric

The first Polygon on stack is used as base, the second Polygon(s) are used for needle ends.

Figure 291. Create needle from concentric initial data (left) and result (right)
Centre points of needle (Secondary) polygons are calculated and connected with the nearest
points on base polygon.

Create serpentine

Creates serpentine milling tracks. The direction of milling tracks can be set by the X-parallel
parameter, (when On – horizontally oriented milling paths will be created, when Off – ver-
tically). The distance between parallel lines is defined in the field "Distance between scan-
lines".

Cut path at path

The first Path initially could be closed path. After Cut path at path, it becomes open.
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Cut path at polygon

Cuts the Path at the position, indicated by the Polygon. A path initially could be a closed path.
After Cut path at polygon it becomes open.

Cut stripes

Cuts the Path at the position, indicated by the Path.

Extend path start and end points

Extends start and end points of the Path on the stack by specified distance. There are two
parameters: extension distance for start point and distance for end point.

Note: if Path has only 2 vertices with the same coordinates, the task will do no nothing.

Extend path to coordinate

Extends start point of the Path to the specified coordinate by parameters for the script com-
mand.

Extend path to nearest object

Extends start/end point of the first Path to the second Path. Distance parameter must not be
exceeded while extended points.

Find common path

Finds common borders of two Polygons on the stack.

Find lead-in

The first Polygon is a contour, the second Polygon is the basis (undersized).
The result is a Path from the basis contour.
Parameters for this task:

n LeadIn Distance – distance of Lead-In path;

n Angle – defines angle between LeadIn Path and contour;

n Counter clock-wise;

n Tangential approach – if is ON arc is the result of this task, otherwise – result is line
segment;

n Use midline;

n Inside – indicates where to create the LeadIn path.
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Figure 292. Find lead-in initial data (left) and result (right)

Get sub path by length

The single Path has to be traced for this task. This task creates new Path which is sub part of
original Path. The Distance specifies the length of the new path. A sign of the Distance value
indicates the beginning of a new path -the positive sign means that the beginning of the new
path will be from the start of the original path, if negative, then, from the end of the original
path.

Figure 293. Get sub path by length initial data (left) and result (right)

Hatch

Fills a Polygon with parallel lines in the parallel distance Distance 1. The direction is specified
byMode 1. Hatch lines are extended, truncated or turned around by Distance 2 as specified by
Mode 2.

Intra minimum space

Checks if Polygon on the stack has narrow places defined by the Distance parameter.

Midline

Calculates a midline of the Polygon on the stack.

Figure 294. Midline initial data (left) and result (right)

Midline grid

Calculates a midline of the Polygon on the stack using grid based algorithm.
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Midline voronoi

Calculates a midline of the Polygon on the stack using voronoi algorithm.

Midline voronoi with perfect shape

Calculates a midline of the Polygon on the stack using voronoi algorithm, but separating per-
fect shapes at the beginning and handling them is special way.

Note: the perfect shape means objects like circle, rectangle, rounded rectangle and etc.

Outline diff

Calculates an outline of the second Polygon on the stack, which is not covered by the first Poly-
gon on the stack, and converts the results into a Path.

Outline shift

Calculates the outline of a Polygon which is shifted by a given value, and provides the result as
a Path.

Smooth path

Removes points from the Path which are on the same line.

Sort path

Sorts the order of single Paths in the given Path according to the specified mode. If the inverse
flag is set, the direction of the single Paths may be changed.

Sort polygon

Sorts areas inside of the Polygon in the stack according area size: ascending or descending.
The parameter with value "0" sorts in descending mode and with value "1" sorts in ascending
mode according area size.

Step and repeat

Repeats Path/Polygon on the stack according the given parameters. Repetition in X and Y
directions are specified by two integer parameters, as well as offset between repeated objects
are defined by two offset parameters. The fifth parameter is step and repeat mode. Currently
there are up to 16 different step and repeat modes. More details about can be found here Step
and Repeat .

Striping and stripping

Generates cutting and heating lines within the Polygon.
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Conditional Polygon/Path Operations with Numeric Value
to Compare to:

If area

Starts inner operations if condition is met.

If bounding box

Calculates bounding box values of Polygon on the stack, and performs comparison of bounding
box values with a specified value according to the Mode parameter. The Mode parameter can
have a predefined value.

n X – width of bounding box is compared with the specified value;

n Y – height of bounding box is compared with the specified value;

n max X,Y – the higher value between width and height is found and compared with the
specified value;

n min X,Y – the lower value between width and height is found and compared with the
specified value.

If circular segment

Checks if a Path on the stack has a circular segment. A Path element must be on the stack.

If closed path

Checks if a Path on the stack is closed.

If full circle segment

Checks if a Path on the stack has a single circle segment. A Pathelement must be on the
stack.

If length

Starts inner operations if condition is met.

If perimeter

Starts inner operations if condition is met.

If selected

Starts inner operations if amount of selected objects is bigger than specified Amount.
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If single line segment

Checks if a Path on the stack has a line segment. The Path element must be on the stack.

Looping Polygon/Path Operations

Area decomposition

De-composes a Polygon into single areas with a single outer boundary or not, if the infinity
flag is set.

Descending sheets decomposition

De-composes a descending sheets of Polygon into single areas with a single outer boundary or
not, if the infinity flag is set.

Path decomposition

De-composes a Path into single Paths.

Segment decomposition

Iterates through single segments of a single Path.

Sheet decomposition

De-composes a Polygon into polygons with a single inner or outer boundary.

Auxiliary

Change parameter

Modifies the current Parameter by a specified value. Currently supported modes for changing
Parameter’s value are: adding, subtraction, multiplication and division.

Compare parameters

The specified Parameter is compared with an explicitly defined value or with other Param-
eter. Comparison modes are: less, more, equal and not equal.

DDE

CircuitCAM supports Dynamic Data Exchange(DDE) protocol. This protocol is used for send-
ing between applications that share data. There are parameters provided for this script com-
mand which allows specify application name and message string.
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Group

This command is only as placeholder for set of script commands which are intended to perform
single task.

Polygon package resolution

Modifies polygon package resolution.

Quit job

Stops the execution and exits the current job.
If Quit job parameter is On, the execution of the job is stopped.

Set parameter

Sets a new value for the specified parameter, defined by the Parameter name. The Value can
be set explicitly or specifying another parameter name by Value.

Set parameter from tool property

An active tool must be set before calling this task. The specified tool property of the active tool
is read and set for the specified parameter by the Value.

Show message

Displays specified message in dialog box or within "Message Log" view. The current set of
parameters with values can be logged into "Message Log" view if "Log parameters" flag is
checked ON.

Note: in message text "{}" has special treatment - within curly braces specified param-
eter $<paramter name> will display exact value in message text. E.g.: "Tool diameter is {$tool
diameter}" will display value of "$tool diameter" parameter.

Skip

Empties operation, which purpose is to display some comment text (if specified).

Task Types

Name Read
Stack Write Stack Parameters

Error
Con-
ditions

CircuitCAM document preparation
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Clear selection
Clear work layer 9210

Copy selection 9009,
9210

Create layer Layer Name 9200

Create tool

Tool Name or
combination of
tool list and
tool name,
Diameter

9202,
9211

Create tool list Tool List
name 9201

If layer exist Layer name 9200

Move selection 9009,
9210

Select

Layer name or
Active layer
name, Selec-
tion Mode,
Object types

Set work layer
Layer Name
or
Active layer

9200,
9220,
9223

Set work tool

Tool
Name/Active
tool
or com-
bination of
tool list and
tool name

9202,
9211,
9225

Set work tool list
Tool List
name or
Active tool list

9201,
9221,
9224

Stack – CircuitCAM document interaction

Move to stack Polygon++ 9001,
9008

Move to stack as path Path++ 9001,
9008

Copy to stack Polygon++ 9001,
9008

Copy to stack as path Path++ 9001,
9008

Pull from stack Path/Poly-
gon--

9000,
9210

Pull from stack as path Path/Poly-
gon--

9000,
9210

Pop stack Path/Poly-
gon--

General Stack and Register operations
Clear register
Clear registers
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Clear stack

Copy register to stack
9100,
9101,
9001

Copy stack to register 9000,
9100

Create path Path++

X: real;
Y: real;
Closed path:
integer

Create polygon Polygon++ Infinite

Duplicate Path/Poly-
gon

Path/Poly-
gon++

9000,
9001

If register has value

Move register to stack Path/Poly-
gon++

9100,
9101,
9001

Move stack to register Path/Poly-
gon--

9000,
9100

Swap

Path/Poly-
gon--
Path/Poly-
gon--

Path/Poly-
gon++
Path/Poly-
gon++

9002

Simple operations

Combine closed path Path-- Path++ mode
Distance:Real

9000,
9004

Combine path Path-- Path++
mode
Distance:
Real

9000,
9004

Convert to path Polygon-- Path++ 9000

Convert to polygon Path-- Polygon++

Corner type
End types
Oversize
value

9000,
9004

Create mark Path Polygon++ Length : Real 9000,
9004

Denest cutouts Polygon 9000,
9003

Descending sheet clear 9000,
90003

Difference
Polygon--
Path/Poly-
gon--

Path/Poly-
gon++

9002,
9007

Get No of descending sheets Polygon Amount: integ-
er

9000,
9003,
9300,
9302

Get bounding box Path/Poly-
gon

X low: Real;
Y low: Real;
X high: Real;
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Y high: Real;

Get center point Path/Poly-
gon

X: Real;
Y: Real;

9000,
9300,
9302

Get length Path/Poly-
gon Length: Real;

9000,
9300,
9302

Get mass point Path/Poly-
gon

X: Real;
Y: Real;

9000,
9300,
9302

Get start point Path/Poly-
gon

X: Real;
Y: Real;

9000,
9300,
9302

Intersection

Path/Poly-
gon--
Path/Poly-
gon--

++Path/Po-
lygon 9002

Inverse Path/Poly-
gon 9000

Number areas Polygon Variable:
Integer;

9000,
9003,
9300,
9301

Number sheets Polygon

Variable: Inte-
ger;
Constant:
Integer;

9000,
9003,
9300,
9301

Oversize Path/Poly-
gon-- Polygon++

Corner type
Oversize
value

9000

Remove holes Polygon-- Polygon++ 9000,
9003

Remove identical points Path 9000,
9004

Remove outlines Polygon-- Polygon++ 9000,
9003

Remove small holes Polygon-- Polygon++ Size: Real 9000,
9003

Remove small paths Path-- Path++ Size: Real 9000,
9004

Resolve Polygon Value: Integer 9000,9003

Rotate Poly-
gon/Path

Enum: 90
degree rota-
tion and mir-
roring,
Arbitrary
angel : Real

9000

Sheet number clear Polygon 9000,
9003
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Shift Poly-
gon/Path x, y: REAL 9000

Union

Poly-
gon/Path--
Poly-
gon/Path--

Poly-
gon/Path++

9002,
9005

XOR Polygon--
Polygon-- Polygon++ 9002

Simple conditional Polygon/Path operations

Has boundary Polygon inverse flag 9000,
9003

Has data Poly-
gon/Path

Is infinite (PpInfinity) Polygon inverse flag 9000,
9003

Complex operations

Check missing holes Polygon--
Polygon--

Polygon++
Polygon++
Polygon++

9000,
9002,
9003

Create needle from concentric Polygon--
/Polygon-- Path++

Create serpentine Polygon Path++
ToolDiameter:
Real;
Mode: Integer

Cut path at path Path--,
Path-- Path++

Cut path at polygon Path--,
Path-- Path++

Cut stripes Path--,
Path--

Path++,
Path++

9000,
9004

Extend path start and end points Path
start: Real;
end: Real

9000,
9004

Extend path to coordinate Path
X: Real;
Y: Real;

9000,
9003

Extend path to nearest object Path--, Path Path++ 9000,
9004

Find common path Polygon--,
Polygon-- Path++ 9000,

9003

Find lead-in Polygon--,
Polygon-- Path++

distance of
lead in
angle,
direction,
tangential
approach,
use midline,
inside

9000,
9002,
9005,
9007

Generate cutting points on path Path-- Path++ Length: Real; 9000,
9003
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Get sub path by length Path Path++ Distance:
Real

9000,
9004

Hatch Polygon-- Path++

Distance1:
real;
Distance2:
real;
Mode 1:
integer
Mode 2:
integer

9000,
9003

Intra minimum space Polygon Polygon++ 9000,
9003

Midline Polygon--;
Path--

min distance
to border;
bor-
der-
Indication:
PATH

Diameter: Rea-
l;

9000,
9002,
9003

Midline grid Polygon Path++ 9000,
9003

Midline voronoi Polygon Path++ 9000,
9003

Midline voronoi with perfect
shape Polygon Path++ Diameter: Rea-

l;
9000,
9003

Outline diff
Polygon--,
Polygon--

Path++/P-
olygon++

9000,
9002,
9003

Outline shift Polygon-- Path++ Shift: Real 9000,
9003

Smooth path Path-- Path++ Distance: RE-
AL

9000,
9004

Sort path Path-- Path++

Inverse: bool-
ean, Mode:
Integer Direc-
tion: integer

9000,
9004

Sort Polygon Polygon-- Polygon++ Sorting Type:
integer

9000,
9003

Step and repeat Path--/Pol-
ygon--

Path++/P-
olygon++

Repeat
X: Integer;
Repeat Y:
Integer;
Offset
X: Real;
Offset Y:
Real;
Mode: Integer;

9000

Striping and Stripping Polygon--,
Polygon

9000,
9003
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Conditional Polygon/Path operations with numeric value to com-
pare to

If area Polygon

Size: Real,
Bigger or
smaller: bool-
ean

9000,
9003

If bounding box Polygon
Size: Real,
mode: x, y, xy
max, xy min

9000,
9003

If circular segment Segment

If closed path Path 9000,
9004

If full circle segment Segment

If length Path

Size: Real,
Bigger or
smaller: bool-
ean

9000,
9004

If perimeter Polygon

Size: Real,
Bigger or
smaller: bool-
ean

9000,
9003

If selected Amount: int
If single line segment Segment

Looping Operations `

Area decomposition
Polygon –
(at end)

Polygon++
(for inner
loop)

9000,
9003

Descending sheet decomposition
Polygon –
(at end)

Polygon++
(for inner
loop)

9000,
9003

Path decomposition
Path –
(at end)

Polygon++
(for inner
loop)

9000,
9004

Segment decomposition Path – 9000,
9004

Sheet decomposition
Polygon –
(at end)

Polygon++
(for inner
loop)

9000,
9003

Auxiliary

Change parameter Value: dou-
ble/string

9300,
9301,
9302

Compare parameters Value: dou-
ble/string

9300,
9301,
9302

DDE Server: string;
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Topic: string;
Text: string;

Group
Polygon package resolution
Quit job

Set parameter Value: dou-
ble/string

9300,
9301,
9302

Set parameter from tool property
Property name
Parameter
name: string

9212,
9300,
9301,

Show message
Text: string;
Message
type: Integer;

Skip

Abbreviations, used in the table:
1. ++ : push something to stack.
2. -- : remove something from stack.

ERROR Codes:

9000: Stack is empty
9001: Stack overflow; Stack can hold at max 10 objects
9002: Expect at least two objects on stack
9003: Top object on Stack is required to be a Polygon, but it is Path
9004: Top object on Stack is required to be Path, but it is Polygon
9005: Top 2 objects on Stack must be both either Path or Polygon, but they are of different type
9006: Second top object on Stack is required to be Path, but it is Polygon
9007: Second top object on Stack is required to be Polygon, but it is Path
9008: Nothing to move into stack, nothing selected or no work layer defined

9100: Register index is out of range (allowed 0 to 99)
9101: Indexed register is empty, can't be moved/copied to Stack

9200: Invalid work layer name
9201: Invalid tool list name
9202: Invalid tool name
9210: No work layer defined
9211: No tool list defined
9212: No tool defined
9220: Specified layer not found
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9221: Specified tool list not found
9222: Specified tool not found
9223: Active layer not set
9224 : Active tool list not set
9225: Active tool not set

9300: Parameter types do not match
9301: Parameter can not be updated (types do not match)
9302: Specified parameter [%1] not found
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4.0.2. Layouts
 The Layouts view presents a list of layouts. The Properties view shows details of the
selected layout or layout components.

Figure 295. Layouts and Properties view

Note: If the Layouts view is not visible on the screen, go to the menu View ---> Lay-
outs to make it visible.
Layouts in Layouts view are grouped by:

n layout type,
n layout category for layouts with same type.

Defined layout types in CircuitCAM are:

n Undefined/None,

n Land Template,

n Package Terminal,

n Padstack,

n Footprint,

n Package,

n Footprint Occurrence,

n GMC Shape,

n Package Footprint.
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A Layout contains any type of graphic objects: paths, polygons, flashes and etc.. Layouts can
have references to other layouts (which are called sub-layout instances).
A user can freely specify an applicable categories for layouts.
The following special notations are used in Layouts view:

l Red color - indicates that this layout is selected in the main graphic window.

l Bold - indicates that this layout is active (sub-layout instances to this layout can be
inserted in to layout which is displayed in the main graphic window).

l - indicates that this layout is currently displayed in the main graphic window.
l - used only for FootprintOccurrence layouts and indicates that footprint occur-
rence doesn't have footprint information (no reference to PackageFootprint layout).

Context Menu

While using the right mouse button in the client area of the Layouts view, the following popup
menu (mouse context sensitive menu) will appear:

Figure 296. Layouts view context sensitive menu

Make Active Sets the selection in Layouts view as active,
and it can be inserted into current layout.

Switch to
Displays graphical data of selected layout in
main graphic screen.

Select Graphical
Objects Selects graphical objects in current layout.

Add Layout Adds new layout after current selection in
Layouts view.

Remove Removes currently selected layout.

Create Footprint

Creates footprint from currently selected lay-
out (this can be performed on Footprint
Occurrence or Package layout – for more
details see below).
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Apply Footprint
Applies footprint for currently selected layout
(this can be performed on Package layout –
for more details see below).

Clear Footprint

Removes footprint information from currently
selected layout (this can be applied to Pack-
age Footprint layouts – for more details see
below).

Undo Footprint
Occurrence

Removes footprint information and restores
recognized objects (this can be applied to Foot-
print Occurrence layouts – for more details
see below).

Copy Copy data of current layout to the standard
clipboard.

Paste Pastes data from clipboard to current doc-
ument.

Back Switches to previous layout.

Forward Switches to next layout.

Properties Displays properties dialogue box for currently
selected layout.

Toolbar

Layouts view contains a toolbar.

Figure 297. Layouts view toolbar

The list of available actions in the Layouts view. This
list contains same items available in the context sen-
sitive menu.
Show All Layouts
Shows/hides all layouts which are not used in the cur-
rent layout
Back
Switches to previous layout
Forward
Switches to next layout
To Main
Switches toMain layout
Add Layout
Displays dialogue box for creation of new layout
Remove Layout
Deletes layout (only not used layout is available for
delete)

See Footprint for the functions:
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l Create Footprint,

l Apply Footprint,

l Clear Footprint,

l Undo Footprint Occurrence.
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4.0.3. Libraries
The Libraries view, presents a list of available libraries. The available libraries are stored in
the installation directory under the Libraries folder. A user can change this folder in the Gen-
eral Settings -> Directories page. The Properties view shows details of the selected library.

Figure 298. Libraries and Properties view

Note: If the Libraries view is not visible on the screen, go to the menu View ->
Libraries to make it visible.

Types of Libraries

A user can create a library from the following three types of libraries:

n Package library.

A Package library file has the extension “*.cam-pkg”. Package libraries are used for
Package recognition. A new Package library entry can be created from scratch or from
selected items. Packages are used to identify components such as BGA, PLCC and etc.
on the current layout. A default “BGA-default.cam-pkg” library is provided with the Cir-
cuitCAM installation in the default libraries location (see General Settings).

n Footprint library.
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A Footprint library file has the extension “*.cam-ft”. As a result of Package rec-
ognition, the current footprint in the layout can be replaced by a footprint of the Foot-
print library. A new Footprint library entry can be created in the Layouts view from
layouts, which are either of type Package or Footprint Occurrence (see Create Foot-
print). Footprints can be applied only for Packages (see Apply Footprint). No default
Footprint library is provided with the CircuitCAM installation.

n GMC shape library.

A GMC library file has the extension “*.cam-gmc”. Until CircuitCAM version 6.2,
GMC library had the extension “*.gmc” and can be converted to the new format (see
Import Libraries). A new GMC library entry can only be edited through the GMC dia-
logue (see GMC). GMC library shapes can be applied on any layout (see GMC Com-
pare). A default “Sample_new.cam-gmc” library is provided with the CircuitCAM
installation in the default libraries location (see General Settings).

States of Libraries and Library Components

The sub-icon indicates that a library is read-only and cannot be modified.
User can specify which components from which library to use for package recognition. This
can be performed by double clicking on a single package in the Library view (the indicates,
that the package will not be used for package recognition). This will include/exclude the pack-
age from the recognition procedure.
The sub-icon indicates that the item is excluded from recognition/exchange total library as
well.
The current state of included and excluded packages is stored in the file PkgRList.xml, in
libraries directory. This file is loaded when CircuitCAM starts, and is saved on exit.
After a package state is changed, the library is indicated as modified. It is necessary to Save
library modifications.

Context Menu

While using the right mouse button in the client area of the Libraries view, the following
popup menu (mouse context sensitive menu) will appear:

Figure 299. Libraries view context sensitive menu
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Recognize This Recognize the current selection in the library.
New Library Create a new library.
Create Package from Selection Create a new package from selected objects.
New Package.... Create a new package.
Save Save modifications to the focused library.
Save As... Save selected library with a new name.
Edit... Edit library item. See also Tool Properties
Copy Copy the selected element to the standard clipboard.

Paste Extract the objects from the clipboard.

Delete Delete library or library item.
Statistics... Show statistics about focused library.
Import libraries... Import old format libraries.
Reload Reload libraries.

Toolbar

The Libraries view contains a toolbar.

Figure 300. Libraries view toolbar

The list of available actions in the Libraries view.
This list contains same items available in the context
sensitive menu.
Save library
Saves modifications to the focused library.
Save As
Saves selected library with a new name.
Delete
Deletes library (only libraries that are not used/active
are available for delete).
Reload
Reloads libraries.
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4.0.4. Packages and Footprints
Data formats (like GERBER, GERBERX and etc.), which can be imported to CircuitCAM,
have only “raw” data "pads and tracks". Users need to identify components on imported or
created designs. For that purpose package library and package recognition can be used.
Default package library (contains BGA's packages) is delivered with CircuitCAM. The direc-
tory Libraries is created in CircuitCAM installation directory. The library file name is BGAde-
fault.cam-pkg. This library can be extended with new packages by the user (see Library).
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Components from package libraries are used to scan through CircuitCAM data and identify
components. A user can extend a default package library. New components can be added to
library via Library menu or by context menu in Libraries view (see Libraries). New com-
ponents can be created from scratch or from currently selected objects.
Package – is a layout with a type of Package. Pins are defined as instances to (Package Ter-
minal) layouts. The placement points of these instances are used when the package is used for
recognition.
Other information (like courtyard, pin-area and etc.) are placed in level objects on appropriate
levels (“Courtyard”, “PinArea” and etc.)

n Each package entry in library contains:

n Set of pins and centre points,

n Pin area,

n Courtyard,

n Body size.

The names of packages are constructed in the following way:

n Package name.

n Pitch.

n Rows and columns.

n Pin number.
Example: BGA40P16x16-209 – means that this is BGA package; pitch is 40 mm, has 16 rows
and 16 columns and contains 209 pins.
All packages have the "/x" and "(y)" post fix. "/1" and "/2" indicate different pin arrangements
while "(1)" and "(2)" will indicate different alternatives of the same pin arrangement, but with
different pin area, package area, courtyard and etc.
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4.0.5. Create Package from Selection
To create a package from selection, first of all CircuitCAM will check how many not read-only
libraries exist in specified libraries directory. Possible situations:

n No libraries available for creating new packages – warning message will appear;

n One library for creating new packages – Create Package from Selection dialogue box
will appear;

n Several libraries for creating new packages – the dialogue with detected libraries will
appear and user must check one library to proceed further:
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Figure 301. Select libraries dialogue window

Then the main dialogue window comes up with the package preview.

Figure 302. New package dialogue window
For newly created BGA packages all pads are circles with diameter half of pitch. Note, that
you create only a package, but not a footprint here. So, these circles do not define the land
areas to be used for the footprint. They are only for indication of the position and visualization,
and are shown with the flag Show Terminals. Meanwhile the flag Show originals shows the
original shapes of selected pads.
For all BGA types the pads are always on a fixed grid defined by a pitch (or pitch-x and pitch-
y). But for other package categories they may have pads that are outside of the main grid.
The 0/0 point always is the centre of the package. For a 5x5 BGA this is the pad in the centre,
but for a 4x4 BGA it is between the centre pads. All pads are either a full pitch or a half pitch
away from the centre (in x and in y separately).
In the General Setting - > Predefined Pitches list a user can add some pre-defined values of
typical pitches:
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Figure 303. Predefined pitches panel

The combo box lists some pre-defined values of typical pitches, but a user can add pitches as
well. The initial pitch values are taken from the current library. In general, the calculated pitch
may be slightly different to some the ideal value from the predefined pitch list. In such case a
pitch should snap to the nearest pre-defined value. For this the Predefined Pitches tab has
snap-tolerance.
The New Package window has some information about the package to be created. Some
parameters are editable (Name, Category, Pitch, Body size, Angle), other parameters are
only informative.
The properties for BGA packages:
Name Editable
Category Editable
Pin Read-only
Pitch Editable
Bounding box
Body size Read-only
Pin area Read-only
Angle Editable
columns Read-only
Rows Read-only

During the creation of a new package from selection there is no direct information presented
for the Courtyard, Body size and Pin area. So this information has to be derived from other
values.
First a Bounding-box of all pads on layer terminal is calculated (those that will go into the
package, including the final pad diameter).
The Body size is 5% bigger than the Bounding box, (2.5% in each direction).
width of the Pin area is number of pin columns, multiplied by pitch. The height of the Pin area
is number of pin rows, multiplied by pitch.
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The Courtyard is +15% of Bounding box, so 7.5% in each direction.
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4.0.6. Package Recognition
Performs automatic package recognition with enabled libraries.
Invoke the Package Recognition line from the Library menu. By mouse double-click ena-
ble/disable (remove/add the ) the package library(-s) from Libraries view.
There are two possibilities to work with pads; on selected pads only or on the whole layout. In
both cases, if pads belong to more than one layer, the user has to set layer(s) in the dialogue:

Figure 304. Select layers dialogue window
Automatic recognition process goes according to descending number of pins - starts from pack-
ages with maximum number of pins and ends with packages with minimum number of pins.
The recognition ensures that there are no additional elements inside the courtyard. Otherwise
the package is not recognized.

a) b)
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Figure 305. a) Initial data for recognition, b) recognized data
If a package is recognized and still does not exist in CAM file, the Package and its Package
Terminals are copied from the Package Library to the CAM file.
A Footprint Occurrence is always created when package is recognized.
The Footprint Occurrence is a layout with type FootprintOccurence.
Footprint occurrence is created in current CAM file: all relevant land objects (level objects
with draws and flashes) are moved from the working layout into the new created layout. A sub-
layout instance to the new created footprint occurrence is created, instead of moved land
objects. Also the sub-layout instance to corresponding package is added inside the footprint
occurrence. The name of the footprint occurrence is the name of the recognized package
appended with a dot and sequence number.
If a user does not agree with the recognition result, he can simply denest the Footprint Occur-
rence with menu commandModify -> Denest Flashes/Instances and have back the original
state.
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4.0.7. Footprints

Create Footprint

This command provides ability to extend footprints library by creating new footprints. This com-
mand is enabled only when a Footprint Occurrence or Package layout is selected.
The user needs to specify footprints library for creation of a new footprint. If more than one
library exists in the Libraries directory, the dialogue box will appear and user will be
prompted to specify library for storing of footprint.

Figure 306. Select dialogue window to select libraries
If no Footprint libraries exist in specified libraries directory, the user should create a new foot-
print library before creating a footprint.
Data for footprints is located on the layer ModifiedObj.
The creation of a footprint from Footprint Occurrence is made as follows:
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- All level objects from specified layout, are copied onto the layer namedModifiedObj;
- Other data (like sub-layout instances) are skipped.
The creation of a footprint from Package is made as follows:
- All sub-layout instances of packages are denested, and all level objects are moved to the Mod-
ifiedObj layer;
- The proposed name for new footprint will be similar to the selected package (information
between "(…)" will be removed).
After the footprint is created, the user has the possibility to edit it. The newly created footprint
is displayed in main graphic screen and is prepared for editing.

Apply Footprint

This command works only on selected Package layouts.
CircuitCAM searches all enabled footprints libraries (see Library view) to find the cor-
responding footprint for selected package.
Possible cases:
Case 1: A corresponding footprint was not found.
No actions are performed.
Case 2: One corresponding footprint was found.
First, all level objects are deleted from the selected Package layout. After this, all level
objects onModifiedObj level from corresponding footprint will be copied into the selected lay-
out. All copied level objects will be moved on the layer, on which current Package layout was
found.
Case 3: A few corresponding footprints were found
The dialogue box with the list of all corresponding footprints will appear and user will need to
specify which concrete footprint to use. When user specifies, which footprint to use, all other
actions are same like in case 2.
If the apply operation was successful, the target layout type is changed from Package to Pack-
ageFootprint.

Clear Footprint

This command can be used only for selected PackageFootprint layouts.
CircuitCAM will remove all footprint information from selected PackageFootprint layout:
remove level objects from corresponding level (level on which Package layout was found) and
layout type is changed from PackageFootprint to Package.

Undo Footprint Occurrence

Removes footprint information and restores recognized objects
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4.0.8. Geometric Manipulation Centre
The Geometric Manipulation Centre (GMC) is a group of toolbars and dialogues to analyse
systematically all pads in a layout and to modify them as needed. The resulting modified pads
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are primarily used to establish a paste mask. To optimize the solderability of a PCB typically
modifications of the solder paste mask are needed. In general the GMC can be used to make
any kinds of mass modifications on graphic objects that are provided in patterns.

Figure 307. GMC main overview
The GMC maintain libraries of modified pads, group of pads or complete footprints for later re-
use. The requirements on how to modify pads are dependent on the used PCB technology or
customer requirements. Thus several libraries with alternative modifications are typically
needed.
To organize a systematic review of all pads, several additional layers are used.
The following sub-layers for each layer Xxx (e.g.: SolderPasteTop) are used throughout the
GMC process:
Xxx: original layout;
Xxx_Work: objects not yet processed;
Xxx_Mark: objects to be modified;
Xxx_Modified: objects (after modification) waiting for assertion to be ready;
Xxx_Ready: objects ready for any operation/calculation.

GMC functionality

The GMC functionality consists of:

n The GMC view for detailed modifications of pads and building up a GMC library.

n The GMC toolbar with the function

1. (to open the GMC view)
2. to move selected objects from Xxx_Work to Xxx_Mark
3. to move selected objects from Xxx_Mark to Xxx_Work
4. to move selected objects from Xxx_Modified to Xxx_Mark
5. to move all objects from Xxx_Modified and Xxx_Mark to Xxx_Ready
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6. to move selected objects from Xxx_Ready to Xxx_Work
7. to copy all objects from Xxx to Xxx_Work. The original objects on the

Xxx layer become invisible. All other specific GMC layers are empty.

Toolbar and workflow

Workflow with GMC View and toolbar with no or incomplete GMC library:

1. The GMC-Init Copy all to WORK operation copies all objects from Xxx to Xxx_
Work, and indicates that all objects are waiting to be processed.

2. The button moves selected elements from the Xxx_Work to the Xxx _Mark layer.
The opposite direction is available with the button.

3. Press on GMC ( ) to start the GMC view that switches the complete CircuitCAM
behaviour into the special GMC mode.

4. There is a shortcut for the steps {1} to {3}: select some pads and press the GMC but-
ton.

5. While in GMC mode, we see only the pads on the _Mark layer and their actual mod-
ification, if available. User can now modify the pads by using any combination of prede-
fined shape, shape modification, size modification or glue dots.

6. When modification is finished, the resulting pad or group of pads, or complete footprint
can be stored in a GMC library under some user-defined name

7. The performed modification can now be applied to all other similar pads or group of
pads that remain on the Xxx_Work layer.

8. Till this point all modifications are temporal. Only when the Apply button is pressed, the
modified objects are removed from the Xxx_Mark layer an placed on the Xxx_Modified
layer, and the special GMC mode ends. Discard also ends the GMC mode, but all mod-
ifications are ignored.

9. After additional manual verification, all modified objects on Xxx_Modifed, including the
objects on Xxx_Mark, are moved to Xxx_Ready by the operationModified-to-Ready (

). Nevertheless, an incorrect modified objects can be send back to Xxx_Mark with
Modified-to-Mark ( ).

10. Steps 2 to 9 are repeated till all objects from Xxx_Work are processed. Therefore, no
pad remains on this layer, and the complete result is on the Xxx_Ready layer. This ends
the GMC process

11. In the rare case that afterwards some incorrect modified object are detected on Xxx_
Ready they can be selected and send back to Xxx_Work by the operation Ready-to-
Work ( ).

The Init button has an additional function:
The faster and more convenient way to modify size of a flashed pad is to change its size in the
CircuitCAM aperture list, instead of using the Size Modification in the GMC. But, to see mod-
ifications in the graphic, these pads must be moved to the Xxx_Modified layer. Therefore Cir-
cuitCAM checks if the Init button has been pressed before an aperture was modified. If yes and
the size or shape of the aperture was changed, all objects drawn or flashed with this aperture
and located on the Xxx_Work layer are automatically moved to the Xxx_Modified layer. The
aperture could be modified either from the main toolbar aperture list or from the List view aper-
ture list or from the aperture graphical editor.
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GMC view details

The GMC view is divided into six tab pages:

n Predefined Shapes

n Shape Modification

n Size Modification

n Glue Dots

n Compare

n Lib
Three buttons are common on every tab:

1. Apply– press this button to apply changes to main graphic. CircuitCAM will close
Geometry Manipulation Centre, and will replace originally opened objects by modified
ones.

2. Discard– press this button to discard changes made in GMC. CircuitCAM will close
Geometry Manipulation Centre, and no modifications to main graphic screen will be
made.

3. Restore– press this button to restore original shapes after modifications in GMC.

Those three options, are also accessible through the dynamic toolbar:
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4.0.9. Predefined Shapes
The operations in the Predefined Shapes panel in most cases are executed on a pair of pads.
The user has to select a pair of pads and open the GMC Predefined Shapes page.
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Figure 308. GMC, Predefined Shapes panel
Set of predefined shapes is represented in the list of predefined shapes. The X and Y values
can be set directly in Unit mode or calculated automatically according to the shape length and
width in parentage mode %.
Exchange: press this button to replace selected object(s) with the shape, which is currently
selected in the list of predefined shapes (the size of new objects is exterminated separately for
each object – using the bounding box of the object).
Rotate: Each click on this button rotates a new shape by 90° counter clockwise. At the same
time the shape is recalculated to fit the bounding box.
Rectangle – converts selected object(s) to a surrounding rectangle.
Oblong – converts selected object(s) to a surrounding oblong.
Bevelled – converts selected object(s) to a bevelled rectangle (the corner value is retrieved
from the Radius edit box).Rounded – converts selected object(s) to rounded rectangle(the
radius value is also taken from “radius” edit box).
Flip horizontally and Flip vertically buttons mirror specified shape(s).
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Scenario:
1) select modified shape;
2) press either Flip horizontally or Flip vertically button;
3) click mouse on original shapes to be exchanged, or use rectangle selection mode if more
than one original shape must be exchanged.
CircuitCAM mirrors the selected modified shape and copy it onto the pads, specified by mouse.
The bounding box centre point of the pad and a new shape is on the same coordinate.
The third button -Make all shapes as selected automatically replaces all original shapes by
the selected modify shape.
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4.0.10. Shape Modification

Figure 309. GMC, Shape Modification panel
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Chop Up group:
Divides a pad into two or more parts.
This section works on all selected objects. Buttons in this group are enabled only if at least one
object is selected.
X / Y specifies a gap size, Number defines amount of gaps on x/y directions.
Inverse flag - select this option to remove divided parts. The resulting pad is a union of gap(s)
segments.
Example:
With the current Chop Up settings

Figure 310. Chop Up settings
a square shape is cut in this way (the right splitting is done with Inverse flag):

Figure 311. Chop Up example

Convert group:
This section works with a single object. State of buttons also depends on the current marker
position
The functionality components of the group:

n arc to corner – converts the selected arc into a corner. The button is activated only if
an arc or a part of an arc of the object is selected;

n corner to arc – converts selected corner into arc, the radius is specified in the
“Radius” edit field. This button is activated only if the corner of the object is selected;

n corner to bevel – converts selected corner into bevel . This button it is activated only
if the corner of the object is selected;

Insert group:

n Points – inserts point(s) in the selected line. Specify an amount of points in the combo
box. This button is activated only after the selected point on the object is in the middle
of the line;

Rotate around centre point group:

n Rotate – rotates/mirrors the selected object according its centre point. Select the rota-
tion angle and mirror type in the corresponding combo box. A user is allowed to enter a
rotation angle manually.

Move group:
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Make your selection from the buttons to move a line, arc, point of selected pad or whole pad by
the specified value:

n Point: moves the selected point (line start/end point, line middle point, arc start/end
point, arc middle point, arc centre point)

n Object: moves a whole pad;

n Square: moves a line segment of a pad (available only if a middle point of a segment
is selected);

n Arc: moves an arc segment of a pad (available only if a middle point of an arc is
selected);

The distance a segment or a pad will be moved, is chosen from an additional combo box. The
value can be either absolute (button Unit) or relative to the pad size (button%). A user can
select one of the predefined values or enter value/ratio manually.

Flip group:
The group is common with Predefined Shapes tab and works in the same way.
Scenario:
1) select modified shape;
2) press either Flip horizontally or Flip vertically button;
3) click mouse on original shapes to be exchanged or use rectangle selection mode if more than
one original shape must be exchanged.
CircuitCAM will mirror the still selected modified shape and copy it onto the specified by
mouse pads. The bounding box centre point of the pad and a new shape will be on the same
coordinate.
The third button -Make all shapes as selected automatically replaces all original shapes by
the selected modify shape.
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4.0.11. Size Modification

The Size Modification tab in the GMC has the exact same features as in the Graphic view,
Size Modification Menu.
The description of each feature can be found on the Size Modification Menu.
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Figure 312. GMC, Size Modification panel
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4.0.12. Glue Dots
This tab allows a user to place a defined number of circular dots with a defined diameter and
distance to each other onto the original pads (these dots are centred on pads).
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Figure 313. GMC, Glue Dots panel
The characteristics of glue dots depend on the component type. The user can save them by the
component name (SOT 18 for example). These names appear in the Name list box, sorted
alphabetically. The same name can be used only once in this list.
Each component may have a different combination of parameters Number, Diameter and Dis-
tance. The name and these three parameters are saved as a list in a text file with the fixed
name “Glue.dot”. The file must be located in the Libraries folder. Structure of the file: SOT
18512.5SOT 14412
If the file “Glue.dot” is not present, the Name list is empty. The file will be updated after
Save, Save as… or Delete was pressed.
In case more than one dot has to be placed, they can be placed either horizontally or vertically
by using two special buttons, located on the right side of the group controls.
The button New clears the Name field and defines settings Number = 1, Diameter = 1 mm,
Distance = 2 mm (these default settings appear when the GMC is opened).
The button Delete removes the actual name from the list, clears the Name field, defines set-
tings Number = 1, Diameter = 1 mm, Distance = 2 mm and updates the file Glue.dot.
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The button Save as… opens a dialogue box to enter a component name and updates the
Glue.dot file.
The button Save saves actual settings for the Number, Diameter and Distance to the actual
Name.
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4.0.13. Compare
The purpose of this section is to compare the originally placed objects in _MARK layer with
objects placed in _WORK layer. When identical objects (according selected criteria in com-
pare section) are detected, they are substituted by objects, modified in _MARK layer.

Figure 314. GMC, Compare panel
User can specify the criteria for the compare/exchange action:
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n Compare Shape - compares all shapes with the original objects and replaces with the
modified objects.

n Compare Bounding Box of Shape - compares a bounding-box of all shapes with a
bounding-box of original objects, and replaces with modified objects.

n Compare Outline of Shape - compares an outline of all shapes with an outline of the
selected flash, and converts matching outline.

For Exchange by pitch group fields description refer to Pitch. The only one difference for
pitch exchange part - detected elements are not only marked as selected (as it is single selec-
tion by pitch), but also changed by the modified ones.
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4.0.14. Library
The Lib panel allows managing of arbitrary shapes to be modified in a library. This includes
viewing, creating, applying, and deleting of shapes and libraries of shapes. A shape in the
library consists of the original geometry and the modified geometry, by which the original
geometry is to be replaced.
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Figure 315. GMC, Lib panel
Lib list contains names of libraries, located in the directory (specified in General Settings… -
> Directories -> Library Directory). Library files have extensions *.gmc and all these files
are read and loaded by CircuitCAM before this dialogue box is opened. If the user changes
extension of library file manually, CircuitCAM will not load this file.

The tree on the left side of the panel shows available GMC libraries and available
shapes in each library.
Preview shows the graphical representation of a selected shape: black color indicates the orig-
inal shape, and blue color the modified shape (see Figure 1).
Get Shape button loads the selected shape in the graphical window, where it can be modified
manually.

Note: Only the modified shape can be edited, but not the original one.

Save to Library button saves the modified shape (together with original one) under a new
shape in the current library.
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New Library creates a new library.

Save and Save As... icons are dedicated to save the selected library under the same or a
new name.

Delete button deletes the selected library or shape. If selected library is not empty, Cir-
cuitCAM will not allow a user to delete it. Delete button removes the selected shape in a
library without any restrictions.
The Shape Compare Type group allows a user to specify a comparison process mode for each
shape separately.
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4.1. Tool Paths

4.1.1. Laser Scanner
The scanners are generated according to the settings in the Laser Scanner dialogue window
(to open this dialogue select the Laser Scanner line from the Tool path menu):

Figure 316. Laser Scanner dialogue window
If the flag Centre on source layer is set the net of scanners is Centred on layer’s objects.
The scanners’ generator creates one configItem of type Rectangle, where the maxX andmaxY
fields define the configItem size. The item has the fixed RectangularScanner name in the Las-
erScanner configuration. Then the generator places a set of flashes of this type on the fixed
LaserScanner layer. The scanners are generated in according to horizontal serpentine law: in
a line with odd number the scanners go from left to right, in an even line – vice versa. If Over-
lap > 0, neighbouring scanners have overlap (common area). 
If the flag Cover fiducials on layer is set On, the fiducials, which are present on the defined
layer (selectable from the combo box), are covered by the Rectangular Scanner configItem.
The flag Best fit according source layer objects can be set On or maxX and maxY size
parameters should be applied for the configItem size.
Of course, the user can modify the set of scanners manually – delete, move, and create some
new scanners and so on.
Laser Scanner is used in LMD and HP-GL export, when special export flag Scanner support
in the export task is set (see Export Task).
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Note: Mentioned actions can destroy the generated arrangement of scanners (serpentine).
But again, the user has possibility easy to restore/change the arrangement of scanners with the
Swap function.

4.1.2. Tool Compensation
Tool Compensation is typically needed for contour routing of a board outline or cutout. Typ-
ically the higher level Contour routing functionality is used for board outlines, but for specific
usages the underlying tool compensation functionality is available as well.
To open the Tool Compensation dialogue window, select in the main menu Tool Path ->
Tool Compensation.

Figure 317. Tool Compensation dialogue window

n Distance: Specifies an offset of the toolpath from the selected path or outline.

n Which toolpath to generate: Specifies on which side of the selected path the toolpath
should be generated. Available selections:

l right / outer - Creates a toolpath on the right side (for open paths) / outer side
(for closed paths).

l left / inner - Creates a toolpath on the left side (for open paths) / inner side (for
close paths);

l both - Generates a toolpath for both sides of the selected path.

n Take care of path width: If On, the offset is calculated from the centre-line of the
selected path. If Off, the offset is calculated from the edge of the selected path.

n OK: Saves the values in registry and generates the toolpath.

Note: The results of the tool compensation operation is located on a new layer, which
name is a combined string of a layer name (the selected path is located on) and a letter L
(left/inner) / R (right/outer).
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Figure 318. Selected outline (light yellow), tool compensation result (on outer side (black
line), Take care of path width On)
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4.1.3. Contour Routing
Contour routing of a PCB is a process to cut out the final PCB from the surrounding material.
This is done by milling along the outline of the PCB, taking into account the width of the mill-
ing tool. To avoid uncontrolled movements of the PCB, some small breakout tabs should
remain, so that the final PCB could later be broken out from the remaining material by hand.
The Contour Routing dialogue has various ways to control the number, size and location of
these breakout tabs. The result of the Contour Routing is tool paths for the selected milling tool.
As an additional functionality the Contour Routing dialogue can also be used for milling of
cutOuts in a PCB.
The Contour Routing dialogue is started from the Tool path -> Contour Routing menu. It
operates on the currently active layout, typically the main layout.
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Figure 319. Contour Routing dialogue window

n Outside/Inside: Specifies the milling area. In case of a closed path (or when the start-
point and the end-point of the open path are contiguous) an inner area for the milling con-
tour calculation has sense only.

n Source: An object for the milling contour routing can be selected before the dialogue
window is called (Current Selection). In case of Layer, a milling contour will be cal-
culated for all objects of the selected layer. To select a layer, hit the ... button next to
the text field and select the layer in the Layers dialogue window.
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Figure 320. Layer dialogue window

n Destination Layer: Defines the resulting layer. If the Clear option is On, all com-
ponents on the selected destination layer are removed.

n Make drill: If On, inserts a hole at the beginning of each cutting line (see blue circles
in the picture below). The hole has the same diameter as the cutting line. These holes
are located on the specified layer, which is defined in the Layer field. To select a layer,
hit the ... button next to the text field and select the layer in the Layers dialogue win-
dow.
If the Clear option is On, all components on the selected destination layer are removed.

n Tool path: Specifies a type and a width of a tool. New values can be selected from the
Tools dialogue window, which appears after the button ... is hit.
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Figure 321. Tools dialogue window

n Breakout options: The group generates gaps around all contours. There are four modes
to do this:

l None: No gaps in contour paths.

l Equal distance: Gap width and distance between two gaps are set in fields Tab
width and Distance.

l 4 edges: Only four gaps with Tab width size are generated around each contour
- on left, bottom, right and top sides. The gaps coordinates are calculated as the
middle points of corresponding edges of surrounding rectangle of the contour.

l 4 corners: Only four gaps with Tab width size are generated around each con-
tour - on left-top, left-bottom, right-bottom and right-top corners. The gaps coor-
dinates are calculated according to intersection points of diagonals of the
surrounding rectangle with the contour.
The results of breakout variations are shown below (Dark Yellow outline).

Figure 322. Contour routing result
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Sequence

This operation analyses the sequence of objects. It changes the selection of objects, works on
objects inside the same layer and between the objects of the same type (e.g., between paths).
A type and a layer define the selected object. If there are no initial selections, the Select next
and Select previous operations are disabled. If a layer is not set, all operations are disabled.
The order of objects can be changed with the Swap operations.
Properties of the selected object (type, current position) are shown in the Status Bar.
This function has four operations:

1. Select the next object in the group Ctrl + Shift + Right;

2. Select the previous object in the group Ctrl + Shift + Left;

3. Select the first object in the group Ctrl + Shift + Up;

4. Select the last object in the group Ctrl + Shift + Down.

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved.

4.1.4. Insulate Milling
CircuitCAM provides functionality to generate insulation paths with up to five different tools:
Primary, Big, Bigger, Small and Smaller.
The Primary tool is mandatory because it is used in the primary insulation channel around all
copper areas, such as tracks and pads on the specified layer. Additional insulation channels
can be generated with either the primary, big or bigger tool, dependent on the availability.
When primary and bigger tools are used for insulation with multiple channels, the first insu-
lation channel will be for the primary tool, the second insulation channel will be for the big
tool, and all other concentric insulation channels will be for the biggest tool if available. Cir-
cuitCAM tries to maximize the usage of the big and bigger tools because of their enhanced life
time.
The small and smaller tool are used for narrow places between the primary insulation channel
and the copper areas, that are too narrow for the primary tool. Because of limited life time of
the small tools, their usage is minimized.
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Figure 323. Predefined insulate job
Besides the primary channels generation, the removal of smaller or larger areas is supported.
The user has a possibility to define a rubout area (see Create rubout area).
Old concentric rubout channels with triangles (see below) were updated to use needles and this
caused the reduction of the vectors number in concentric paths, and improvement of the insu-
lation procedure.

a) b)
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Figure 324. a) Old concentric paths with triangles; b) new concentric paths with needles
(right side)

The set of predefined insulate Scripts are provided with the CircuitCAM installation. Prede-
fined insulate jobs can be accessed and executed via the Jobs view. These jobs are located
beneath the Batch(scripts) node and have a category Customized. The Customized category
name is used not only for insulate jobs.

Figure 325. List of Scripts
When running one of the insulate scripts, the area to work on is defined by the source layer is
subtracted from the rubout area, In the case of no remaining area Warring message will be
shown.

Insulation Examples

Insulation tracks using 4 tools with defined rubout area.
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Figure 326. Insulation tracks (4 tools, defined rubout area)

Insulation tracks using 3 tools with defined rubout area.

Figure 327. Insulation tracks (3 tools, defined rubout area)
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Insulation tracks using 3 tools with a defined rubout area and with additional channels around
the primary channel.

Figure 328. Insulation tracks (3 tools, defined rubout area, additional channels around pri-
mary channel)

Insulation tracks using 2 tools with a defined rubout area.

Figure 329. Insulation tracks (2 tools, defined rubout area)
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Insulation tracks using 2 tools with a defined rubout area and with additional channels around
the primary channel.

Figure 330. Insulation tracks (2 tools, defined rubout area, additional channels around pri-
mary channel)

Insulation tracks using 1 tool with additional channels around the primary channel.

Figure 331. Insulation tracks (1 tool, additional channels around primary channel)
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4.1.5. Striping & Stripping

Striping and Stripping is a technology to remove copper or equivalent material that is laminated
on a base substrate, e.g. a PCB.
For this process a Laser NC machine must be able to operate in two modes; cutting and heat-
ing.
In a first phase, the copper layer is cut into stripes using the laser;
in a second phase, the stripes are heated by the laser so they can be stripped away by an addi-
tional airflow.
Striping and Stripping is only available for the Laser Pro variant of CircuitCAM that comes
with additional documentation and a "default_striping_and_stripping.cat" file that you will
have to copy into the template directories.
To learn how to copy template files, please refer to Synchronize.

Note: For additional and detailed information, please refer to the separate "Striping and
Stripping Documentation" or contact DCT.
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4.1.6. NC Mode
The purpose of the NC mode is to directly control a connected NC machine. The NC mode
allows to control an NC machine manually, or via automated NC data such as; tool paths and
drill positions. The automatic execution of data is applied layer by layer, depending on which
side of the PCB is targeted, the data is either used as it is, or is mirrored.
Before starting the NC mode, we usually need to establish a connection with an NC machine.
Before any data can be executed, the connected NC machine, has to be configured i.e.: "defin-
ing absolute positions for x, y, and z, figuring the orientation of the base material, setting up
tools and more".

NC Mode is accessible via the NC/Tool Path menu;
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Figure 332. NC/Tool Path menu

To start working on NC Mode, the following steps are applied:

Connecting to the NC Server

Before starting the NC mode, CircuitCAM needs to establish a connection with a so called
I++NC server, this server might be connected; locally to the same computer terminal, or
remotely on another computer terminal, or it may even exist directly built-in an NC machine.
When this connection is established, CircuitCAM receives data about the type of the NC
machine, its working area, and other miscellaneous information.
To connect to an NC server, navigate to the NC/Tool Path menu, select Connect to NC
Server. The connection window appears; in this window the address of the machine is entered
in the following format; "IP address: port number";
if connecting to a remote server, an IP address number and Port number are entered,
if connecting to a machine attached to the same computer terminal, Default localhost is
selected.
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Figure 333. Connecting to an NC sever; local machine (left), or remote machine (right)

Note:When connecting to a remote NC server, network or internet access must be avail-
able, depending on the location of the server.

Selecting a layer to process

While in NC Mode, CircuitCAM can only process one layer at a time
The layer to process is selected, and is set as the active layer. See Setting Active Layer.

Figure 334. Setting the active layer for NC mode

Switching to NC Mode

To activate the NC layout, one of the following modes must be selected from the NC/Tool
Path menu:

n NC Normal: Opens the NC layout with normal orientation.

n NC Mirror-X: Opens the NC layout with all objects mirrored on the X-axis.

n NC Mirror-Y: Opens the NC layout with all objects mirrored on the Y-axis.

NC Mode Layout

The NC mode has its special layout; this special layout shows the graphical data of the layer
selected to be processed.
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Figure 335. NC Mode layout

While the NC mode layout is active, and while the NC server is connected, four differences
are noticed as in the figure above,
listed from left to right;

n NC Special Layers.

n NC Machine Area.

n Machine head position.

n NC Controls.

NC Layers

The NC Mode has its special layers; these layers contain the graphical data of various stages;
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Figure 336. NC Mode layers

n NC Prepare: This layer represents the first phase while working with NC Mode; this
layer contains the items which still need more editing and preparation.

n NC Work: This layer represents the second phase in NC Mode; items are moved to this
layer when they are ready to be processed, this layer acts like a ready flag before the
NC machine starts.

n NC Done: The third and final phase in NC Mode; items are displayed here after they
are fully processed by the machine.

n NC Area: This layer only displays an outline, this outline represents the working area of
the machine.

Machine Area/Head Position

An NC machine needs to be configured prior to connection; one of the configurations is to
determine the coordinates of the working area, i.e.: xMin, xMax, yMin, yMax, zMin, and zMax.
After connection, the size of the working area is automatically read from the machine. The
graphical data displayed in the layer NC Area, represent the boundaries of the machine work-
ing plane (a rectangle in the example figure). Since CircuitCAM works only in a 2D mode, the
boundaries of this rectangle are calculated using the xMin, xMax, yMin, and yMax. The values
of zMin and zMax are variables of the NC machine, used to determine the depth of the drilling
and milling.
The current CAM document is then displayed in the NC mode, the absolute coordinates of the
document are applied to the working area of the machine, i.e.: the origin point of the document
(0, 0) is matched to the origin point of the NC machine.
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This special marker indicates the position of the machine head. The initial position
"home" of the head is read automatically from the machine. The place of this cursor changes
place accordingly, as the machine is in process

NC Controls

The NC Control View only appears while in NC Mode, this window displays various controls
for the NC Mode, each explained in details below.

Figure 337. NC Control View

1. Connection Status:
This section indicates whether an I++NC server is currently connected or not.
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2. Tools and Progress:
This table displays the different tools that are present in the selected layer. Beneath the
table, the layer and order controls are displayed.

3. Head Position Coordinates:
This section displays the current coordinates of the machine head.

4. Machine Status:
This section displays the machine status whether; running, stopped, or finished,

5. Machine Head Controls:
The movement group is divided into two parts; Move Absolute andMove Relative.

Connection Status

After connecting to the I++NC server, and after switching to the NC Mode, this section dis-
plays the current connection status.
When a connection is successfully established, CircuitCAM displays "Connected to name_of_
the_server".

Figure 338. The connections status while connected to an I++NC server

If for any reason (power failure, network/internet error) the connection with the I++NC server
is interrupted, the following error message appears, and the connection status is then changed
to "Not connected".

Figure 339. NC Connection error

Note: Even it is recommended to first establish a connection and then switch to NC
Mode, however, it is possible to open NC Mode without connection, in such case the status is
displayed as "Not connected".
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Tools and Progress

The "Tools and Progress Group" displays the various tools present in the layer, the number of
tool paths present under each tool type, it also displays the progress control buttons. By stand-
ard, NC mode starts with all the tool paths in the prepare layer, as seen in the figure below.

Figure 340. NC control standard view, displaying all tool paths in the "Prepare" layer

Listed under the Name column, tools are grouped into separate nodes, these nodes represent
the tool category; (milling, drilling, ....etc). Under each category, the shape and the size of the
tool is displayed.
Next to the name column are the three progress layers; Prepare, Work, and Done, the number
in each field indicates the number of tool paths associated with each layer, e.g.: In the image
above, the Drilling Tool; Spiral Drill 2.4 mm is used in 25 tool paths, those 25 tool paths are
all in the prepare layer.
After reviewing the prepare layer, and after all the objects/tool paths do not need anymore edit-
ing, comes the time for the second phase; Work Layer.
The work layer enables ordering and organization of tool paths; i.e.: the tool paths are proc-
essed in the same order they are added to the work layer, regardless of the tool used. The work
layer is considered as a ready flag before sending the data to the NC server.
To move one or more tool paths to the work layer, they are selected from the graphic layout,
then a left click is mode on the "To Work" button.
To select all of the tool paths created by the same tool, just double click on the number dis-
played in any of the three columns, e.g.: In the figure above, if a double click is applied on the
number "10" next to the Marking Tool; Universal Cutter 0.2 mm, all of the 10 tool paths,
which are present in the prepare layer will be selected.
The final stage is to transfer the data to the NC machine and start processing it, to do this, a
left click is applied on the Start button.
Clicking the Start button will transfer the tool paths from the NC Work layer, to the NC server
(machine), after each tool path is processed, it is then moved to the layer NC Done. While the
machine is running, the head position cursor moves in accordance, identifying in which place
the machine is operating.
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Figure 341. NC Machine progress window

While the NC machine is processing the data, the progress window is visible (shown in the fig-
ure above). The top progress bar indicates the number of tool paths finished in respect to the
whole number of tool paths. The lower progress bar indicates the number of points complete in
each single tool path.
After the data is finished processing on the NC machine, the progress window is closes auto-
matically, after that, either more work is done, or the NC mode is ended.

Figure 342. NC control, displaying the tool paths distributed among layers, according to
their progress

After some or all of the tool paths are processed, the NC control displays the numbers of tool
paths that are processed, as seen in the figure above, i.e.: some tool paths have already been
processed, and another set of paths have been moved to the NC_Work layer.
The Reset button, reverts all the changes done in NC mode, i.e.: all tool paths are moved back
to the NC Prepare layer, any manipulations or modifications are reverted.

Head Position Coordinates

This section displays the current coordinates of the NC machine head, the coordinates are dis-
played in the sequence; x, y, and z.
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Figure 343. NC control displaying the current coordinates for machine head position

As explained before, CircuitCAM only works on 2D designs, the values of the z coordinate are
only for drilling, the value "zero or 0", indicates that the head is up, and a negative value indi-
cates that the head is drilling down.

Machine Head Controls

This section in the NC control, controls the machine head movements,

Figure 344. Machine head controls in NC mode

we have two modes to control the position of the machine head;

a. Move absolute:
In this section there are three control buttons;
Home Button: Moves the machine head to its home position; the initial head position is
automatically read from the machine settings.
Head Up: Retracts (moves up) the machine head, up on the Z axis.
Head Down: Moves the machine head down the Z axis (active drill position).

b. Move relative:
In this section, it is possible to move the machine head to any direction by a desired
value.

(338)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
Reserved



CircuitCAM 7.5

A value is entered in the blank field, then the desired direction arrow is clicked, the
head moves by the entered value.

When the "Direct move" flag is checked, the head place is chosen with a mouse click on the
desired place. See figure below.

Figure 345. Changing the machine head position using "Direct move"
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4.2. Operations and Checks

4.2.1. Base Material with Fixture Hole
The Base Material dialogue creates a boundary box around the PCB design and places fixture
holes and markers to align for the manufacturing processes.
Inserting Base material procedure:

n Select in the main menu Insert -> Base material / fixture holes feature.

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
(339)



CircuitCAM 7.5

Figure 346. Base Material dialogue

n Current design size: Shows the dimension of the current X-Y plane of the PCB.
n Size: Sets the desired size of the Base material boundary box e.g.: 100 x 60 mm, 200 x
320 mm, 300 x 400 mm default size is 95 x 150.

n Generate fixture holes: If the flag is set ON fixture holes will be generated to be used
for aligning PCB with the layout for manufacturing.

n Number: Sets the number of points to be added to the layout e.g.: 2 or 6
n Mirror axis: Sets the orientation of the mirror that will be used in Markers.
n Offset: Sets the distance that the hole will be created from the vertical corner and the
horizontal corner .

n Drill: Sets the drilling tool and so the diameter for the fixture holes.
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Figure 347. Drilling Tools List
n Marker on corner: Indicates the markers to be used for the four corners. The default is
F1 from the Fiducials tool-list.

n Marker on mirror axis: Indicates the markers to be used for the mirror axis, horizontal
or vertical. The default value is F2 from the Fiducials tool-list.

Figure 348. Example of the final Base Material
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4.2.2. Copper Pouring
The function is rather similar to function for the creating of a polygon with cutOut.
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n Select the items (for example pads, tracks), which should be cut out of the ground area,
in the Graphic view.

n Select in the main menu Insert -> Copper Pouring menu item. The Select copper
pouring ground mode is turned On (see message line in the status bar). The special
mouse cursor appears on the screen.

Figure 349. Insert -> Copper Pouring menu item

n Select an area, which should become a ground shield in the Graphic view. The Copper
pouring dialogue window for entering a space between Pads/Tracks and the ground
appears on the screen.

Figure 350. Copper pouring dialogue window
The copper pouring can be performed several times in a sequence for different objects with dif-
ferent widths.
Let us take a sample with two pads (flash-finger and flash-circle) and two tracks (paths).
Create a rectangular copper area around these objects.

Figure 351. Flash-finger and flash-circle with paths and rectangular copper area
Now use the Copper pouring function with a different spacing around pads and tracks: 0.4 mm
for finger, 0.3 mm for flash-circle and 0.2 mm for paths.

Figure 352. Result of copper pouring

Note: This function is only available in CircuitCAM variants STANDARD and PRO.
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4.2.3. DataMatrix
The Data Matrix barcode is a very high-density two dimensional symbology, that can encode
text, numbers, files and actual data bytes. It is a very efficient two dimensional (2D) barcode
symbology that uses a small area with a unique perimeter pattern, which helps the barcode
scanner to determine the cell locations.
The cells are mainly made up of square modules. Because it can encode letters, numbers, text
and actual bytes of data, it can encode just about anything including text characters, Unicode
characters and photos. The encoding and decoding process of Data Matrix is very complex and
several methods have been used for error correction in the past.
Data Matrix is one of the smallest and most dependable barcode symbologies. Data Matrix is
approximately 30 times smaller than a Code 39 barcode representing the same data. Data
Matrix is the best choice to use when sending barcodes over faxed documents.
Data Matrix is covered today by an ISO standard, ISO/IEC 16022—International Symbology
Specification, Data Matrix is in the public domain, which means it can be used free of any
licensing or royalties.
 Follow the routine to insert a new DataMatrix:

n Activate the DataMatrix function in the Insert menu or click on the DataMatrix in
the Insert toolbar and fill fields of text dialogue window:

Figure 353. Insert Data Matrix dialogue window

n Set a destination layer in the Layer field

n Set an encoding type in the Encoding field.

n Set a Data Matrix size in the field Format. It varies from 8 × 8 to 144 × 144 cells. The
size can be chosen automatically by using the Auto value.

n Set the shape of cells in the field Shape.
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n Set the size of one cell in the field Dot size.

n Press OK.
Set the point for left-bottom corner of the Data Matrix in the graphic window with the mouse
and do left-click to fix it.
Here is an example of a Data Matrix code, encoding the text "Always a cut ahead". Used
parameters are shown in the dialogue.

Figure 354. Example of Data Matrix code, encoding text "Always a cut ahead"
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QR Code

QR code is a type of matrix barcode. QR code became popular due to its fast readability and
greater storage capacity.
QR code consists of black squares(sometimes circles) arranged in a square/matrix grid on
white background. The format information records error correction level and the mask pattern
used for the symbol.
QR code is covered today by an ISO standard, ISO/IEC 18004:2015 Information – Automatic
identification and data capture techniques – QR Code barcode symbology specification.

 Follow the routine to insert a new QR Code:
l Activate the QR Code function in the Insert menu or click on the QR Code in the Insert
toolbar and fill fields of text dialogue window:
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Figure 355. Insert QR Code dialogue window

l Set a destination layer in the Layer field

l Set an error correction level in the Error Correction field.

l Set a mask pattern in the Mask field. It has range 0..7.

l Set a version in the Version field. It has range 0..40.

l Set the shape of cells in the field Shape.

l Set the size of one cell in the field Dot size.

l Press OK.

Set the point for left-bottom corner of the QR Code in the graphic window with the mouse and
do left-click to fix it.
Here is an example of a QR code, encoding the text "http://www.circuitcam.com/". Used
parameters are shown in the dialogue.

Figure 356. Example of QR Code, encoding text "http://www.circuitcam.com/"
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4.2.4. Selecting Operations

Pitch

The Pitch function searches and selects the graphical objects which have the same pitch, the
same spacing and area. To specify a pitch, spacing, and area, the Selection by Pitch dialogue
window is introduced (edit fields for the value and check boxes to switch On/Off space and
area). The dialogue window enables the user to define the layer to search on, or search on all
layers. If two selected pads are on the same layer, the layer combo box shows this layer, other-
wise - it is empty. Three tolerances are specified as well (pitch, spacing, and area).

Figure 357. Selection by Pitch dialogue window
This dialogue window can be accessed by one of the following means:

n Via menu Select -> Pitch;
n By right mouse button menu function Pitch of two pads and pressing on the button
Select (see Pitch of two Pads);

n From GMC “Exchange by Pitch”.
The Find button deselects all previous selections and starts new calculations. All settings of
the dialogue are kept for one session.
The OK button stores previous settings.
The current status in all 3 modes (via mouse menu, Select -> Pitch and GMC Exchange by
Pitch) is:

1. A pad (its area) can consist either from one object (flash, path, rectangle,...), or can
consist from a few connected (overlapped) objects on the same level;

2. An area, which consists only of undefined-flash or zero-diameter circle, cannot par-
ticipate in any pitch operation (selection or exchange), because its polygon size is zero.
It means that any such selection prohibits the pitch operation (a message comes up).

3. Areas can belong to different levels.

4. If number of selected areas is either more or less of 2, a message comes up.
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You can see more selecting operations in the Select menu.
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4.2.5. PCB Design Rule Check (DRC)
CircuitCAM allows the user to check for two design rules on the Printed Circuit Boards (PCB):

n Inter Min Spacing, which checks for the minimum distance of networks between two
layers.

n Intra Min Spacing, which checks for the minimum distance of networks within one
layer.

To open the PCB-DRC dialogue, select Design Rule Check -> Printed Circuit Board from
the Edit menu.

Figure 358. Design Rule Check dialogue window

n Layer 1: Specifies the layer to be checked.

n Layer 2: Specifies the second layer to be checked for Inter Min Spacing. In case of
Intra Min Spacing mode the combo-box is disabled.

n Layer Result: After the rule evaluation, all detected violations are placed as graphic
objects on this layer. The layer can be selected from the combo-box or entered as a
new one.

n Width: Specifies a minimum spacing distance between objects.

n PpResolution: Specifies the Resolution of Polygon Package.

n Run: Starts the design rule check.
Example: After starting the above settings on the tutor example a few errors are reported.
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Figure 359. Graphic view with errors (white areas)
The white area indicates where the minimum distance of 0.33 mm is violated.

Note: For a measuring, the anchor-point can be set at arbitrary positions, e.g.: at the out-
line of a track, with a ctrl-shift-click. After the coordinates were switched to relative or polar
coordinates, the distances can directly be read out in the status bar. The picture shows that
there is a distance of only 0.3 mm.
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4.2.6. Stencil Design Rule Check

IPC-7527, "Solder Paste Printing Acceptance Guide" helps to evaluate and optimize the solder
paste printing process.
To check the stencil patterns according to the IPC-7527 guidelines, select Design Rule
Check -> Stencil line from the Edit menu.
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Figure 360. Stencil Design Rule Check dialogue window

Layers group
Contains information about used layers:

n Source: Specifies the layer to be checked.

n Destination: Objects out of the limits are copied in this layer. Default value is "Sten-
cil_DRC". A user can select the layer name from list or enter some string xxx. The
resulting layer will have an extension of selected Thickness value, e.g., "xxx_0.1mm"
or "xxxX_2mil".

n Clear Destination Layer: Deletes all objects from all previous Destination layers.

Thickness: Is applied to all objects on the base layer. The Thickness is the height of the sten-
cil foil. There are pre-defined values 2, 3, .. 10 mil (if mil selection button is chosen) or 0.05,
0.075, 0.1, ...0.25 mm (if mm selection button is chosen).
Ratios to use:
Specifies the parameters for area-ratio or aspect-ratio limits calculation. User can choose to
check only Area-ratio, or Aspect-ratio only, or both (check boxes Area and Aspect):

n IPC-7572A standard: Allows the user to specify one of the application area from the
combo box: "LaserCut", "Electroformed", "Chem-Etch". Each type has own
predefined Area-min, Area-max and Aspect-min values:

LaserCut ElectroFormed ChemEtch

Area-min 0.66 0.5 0.9

Area-max 0.9 0.66 0.9

Aspect-min 1.5 1.5 1.5

n Area: If On , checks Area ratio. When the IPC-7572A standard flag = Off, a user
can set min andmax values manually.
Aspect: If On, check Aspect ratio. When the IPC-7572A standard flag = Off, a user
can set min value manually.

Run: Starts the stencil design rule check.
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4.2.7. Data Formats
There are several data formats supported by CircuitCAM:

l CAM: The native CircuitCAMformat, CAM files are made to store the 2D graphic infor-
mation of bare PCBs.

l CAT: The CAT files have the same internal format as CAM files, but have the file
extension CAT. In this file users can store default layers, configurations, pads, tools,
default jobs, etc. but usually no graphics. So this is an empty layout.

l GERBER: Is a format, in which Gerber data is stored. This format is actually a family
of data formats which are subsets of EIA Standard RS-274D.

l GERBERX: Extended Gerber format, which is also called RS-274X, provides enhance-
ments that handle polygon fill codes, positive/negative image composition, and custom
apertures, and other features.

l EXCELLON: Excellon format usually means; the parts programming codes of the
CNC-2, 4, 5, 6, or 7 Excellon machines.

l HP-GL: Hewlett Packard developed the HP-GL command language for its pen plotters.
Later, it was taken on by other plotter manufacturers and has today become the standard
for pen plotters.

l SIEB & MEYER: This data format is used by the milling and drilling machines from
Sieb&Meyer.

l BARCO-DPF: This data format, developed by Barco, is designed to represent layer
information of a PCB. This format describes the image of the layer such as pads, tracks,
holes, power and ground planes, and also electrical netlist information, as well as addi-
tional product information represented with attributes.

l PostScript: Its a page description language, using vector and bitmap technology. For
the purpose of the CircuitCAM, only vectors are used (lines and circular arcs). See Post-
Script Language Reference from Adobe Systems, Inc.

l DXF: DXF is a tagged data representation of all the information contained in an Auto-
CAD drawing file.

l EESOF: EESOF is an EDA System for High Frequency applications from Agilent Tech-
nologies.

l G-Code: Numerical control format *.NC which is commonly used by 3 to 5 axis NC
machines according to the international standard-ISO 6983 or a vendor specific variant.

l ODB++: Is a data format for PCB artwork from Valor Computerized Systems Ltd.

l LMD (Laser Mill Drill): This format is used to Export CircuitCAM data, and Import
from LMD. The default file extension for the format is *.LMD

l ISO 10303-210: The international STEP standard ISO 10303 is on Product data rep-
resentation and exchange. Part 210 of STEP is the Application Protocol: Electronic
assembly, interconnect and packaging design.
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Aperture Files and Templates (translation files)
The aperture file is an ASCII file, listing the apertures with their corresponding definitions,
e.g.: an aperture number, a type, and a size. The Gerber data can be converted correctly only
with the matching aperture list.
A translation file is used to convert the aperture file from any CAD system so that it can be
imported into CircuitCAM without further modifications. This significantly speeds up the work
with different aperture lists, as there is no need to define apertures manually. Furthermore, you
can use the translation file to convert tool lists in Excellon or Sieb&Meyer format.
CircuitCAM has a number of prepared translation files for the most common CAD systems.
However, it may be the case under certain circumstances that you need to customize a trans-
lation file individually. You can do it in the two ways:

1. Manually - by using any text editor;

2. Automatically – by using the graphical Aperture Template Editor (ATE) program.
The ATE can be used as stand-alone application. See Aperture Template Editor.

Note: The translation files may be found in the CircuitCAM "Ape_Templates" sub
folder, or in the folder you have specified in your CircuitCAM General Settings for the aper-
ture and tool template files.

A translation file is an ASCII format file and can be edited in any text editor. The file is made
up of three sections:

n Fixed parameters;

n Aperture definitions;

n Variable parameters.

Fixed Parameters

The following table shows a listing of the available fixed parameters with possible parameter
values and the corresponding default setting.

Parameter name Parameter value Default setting for
parameter value

APE_UNITS
INCH
MIL
MM

MIL

APE_SCALE <real number> 1

COMMENT

<Character> |
<Character pair> [ 
<Character> |
<Character pair> ]

Empty set

CONFIGURATION

ConfigExcellon
ConfigGerber
ConfigHpgl
ConfigSiebMeyer

ConfigGerber

COOR_MN <integer>.<integer> 2.3

COOR_MODE ABSOLUTE
INCREMENTAL ABSOLUTE
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COOR_UNITS INCH
MM INCH

COOR_ZEROS
DECIMAL
LEADING
TRAILING

TRAILING

KEY_STRING <character string>
REQUIRED_
STRING <character string>

Legend:
| Alternative (or)
[...] 0 or multiple repetition

n APE_UNITS - Defines the unit for the aperture size within the aperture list (MIL,
INCH orMM).

n APE_SCALE - The aperture size within the aperture list can be scaled in addition by
this parameter during import. Example: The circular aperture size is 10 mm and APE_
UNITS is set toMM. Without APE_SCALE a circle with 10 mm diameter will be
imported. If APE_SCALE is set to 0.1, the aperture with 1 mm diameter will be
imported.

n COMMENT - Defines one or more characters, which precede a comment line. Mul-
tiple characters/character pairs are separated by a space. Example: COMMENT @ #
// - means that any line beginning with '@', '#' or '//' is a comment line.

n CONFIGURATION - Specifies the format for which this translation file has been
defined. (Gerber, Excellon, HP-GL or Sieb&Meyer).

n COOR_MN - Specifies the m.n code of the Gerber format. The appropriate values are
specified here if the Gerber data are always created with the same number of integer
and decimal places.

n COOR_MODE - Specifies the coordinate mode of the Gerber format. ABSOLUTE
mode is selected for Gerber data with absolute values, INCREMENTAL mode - for
relative values.

n COOR_UNITS - Specifies the unit for the Gerber data, imperial (INCH) or metric
(MM).

n COOR_ZEROS - Specifies the preference for zeroes in the Gerber format. Set this
parameter to LEADING, if the Gerber data are always created with leading zeroes,
or to TRAILING, if trailing zeroes are always used. Select either TRAILINGor
LEADING, if both of leading and trailing zeroes are exported.

n REQUIRED_STRING (only for automatic detection) - Specifies the keyword that the
aperture list must contain to narrow the search in automatic detection of the translation
file. The scan process continues after finding the keyword to find the most suitable
translation file. All translation files lacking this keyword will be ignored immediately
in the scanning process. This can be used to restrict the range of translation files to be
considered.

n KEY_STRING (only for automatic detection) - It is similar to REQUIRED_
STRING but prevents other templates to be checked at all. If a translation file with
this keyword is found, the scan process on other template files will be ended imme-
diately and this translation file will be used.

Note: If more than one file has the same KEY_STRING, checking process will be can-
celled as soon as such files are located (user gets corresponding message).
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Aperture Definition

Every aperture in the aperture list should be assigned precisely by one of the entries in the aper-
ture definition of the translation file. A code, a mode, a form, and a size distinguish the aper-
tures from each others. Each line in the aperture list is checked for a match with the entries in
the translation file. The aperture information will be converted, if a match is found; otherwise
the aperture will be ignored.
The following syntax is used for the aperture definitions:
1,<DRAW_FORMAT><FLASH_FORMAT>:"<APE_FORMAT>"

<DRAW_FORMAT> param-
eter Meaning

N
An aperture is only used as a flash
aperture, never as draw aperture.

C or R
A line is drawn with round End
Type and round Corner Type aper-
ture.

Q
A line is drawn with extend End
Type and extend Corner Type aper-
ture.

T
A line is drawn with truncate End
Type and truncate Corner Type
aperture.

X
A line is drawn with extend End
Type and round Corner Type aper-
ture.

Y
A line is drawn with truncate End
Type and round Corner Type aper-
ture.

Z
A line is drawn with round End
Type and extend Corner Type aper-
ture.

U
A line is drawn with truncate End
Type and extend Corner Type aper-
ture.

V
A line is drawn with round End
Type and truncate Corner Type
aperture.

W
A line is drawn with extend End
Type and truncate Corner Type
aperture.

<FLASH_FOR-
MAT> parameter Meaning Size parameter in

<APE_FORMAT>

N

An aperture is only
used as a draw aper-
ture, never as flash
aperture.

C
An aperture is used
as round or circular
flash aperture.

%a (diameter)

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
(353)



CircuitCAM 7.5

Q
An aperture is used
as square flash aper-
ture.

%a (side length)

R
An aperture is used
as rectangular flash
aperture.

%a (side length X)%b
(side length Y)

O
An aperture is used
as an oval or finger-
shaped flash aperture.

%a (side length X)%b
(side length Y)

T
An aperture is used
as an octagonal
shaped flash aperture.

%a (diameter)

D

An aperture is used
as rectangular flash
aperture with rounded
corners.

%a (side length X)
%b (side length Y)%c
(corner radius)

B

An aperture is used
as rectangular flash
aperture with cut corn-
ers.

%a (side length X)
%b (side length Y)%c
(cut length )

M
An aperture is used
as a marker shaped
flash aperture.

%a (diameter)

U
An aperture is used
as an undefined
shaped flash aperture.

S

An aperture is used
as special flash aper-
ture. The actual form
must be designed and
implemented in Cir-
cuitCAM.

<APE_FORMAT>parameter is shown in quotation marks ("") and defines the exact repro-
duction of each aperture (aperture line) in the aperture list. Both fixed and variable entries
may be used here. The space is used as the default separator between the various param-
eters. Both a decimal point "." and a comma "," can be used in numbers.
Variable entries Meaning
%% is used for the aperture code

%s
ignores a string from space to space(may be used as often as
necessary)

%a%b are used for size parameters (diameter, side length)
Separator
In the aperture file non-white-space characters are used for the variable entries sep-
aration, but in the translation file these separators must be provided in square brackets.
Note: The separator can be used only between two variable entries (which have a format
characters %).
Fixed entries
All strings appearing between the variable values in the aperture list are permitted as
fixed entries. Multiple consecutive spaces in the aperture list are represented as a single
space in the translation file.
Tip: All entries after the last relevant parameter can be ignored. (There is no need to use
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the %s variable for this.)

Variable Parameters

Some CAD systems are capable of writing more precise specifications of the Gerber format to
the aperture list in addition to the aperture information. Variable parameters may be used for
the evaluation of this information so, that it is not necessary to modify the translation file for
each change in this supplementary information.
The aperture list will be searched during the conversion process for the strings defined for the
variable parameters and assigned to the appropriate parameter where a match is found.

Variable parameter Meaning
Coordinates unit

100 : "<text>"
The string entered for <text> defines INCH as
the coordinates unit.

101 : "<text>"
The string entered for <text> defines MM as the
coordinates unit.
Coordinate mode

110 : "<text>"
The string entered for <text> defines REL-
ATIVE as the coordinates mode.

111 : "<text>"
The string entered for <text> defines ABSO-
LUTE as the coordinates mode.

Integer and decimal places

120 : "<text>%d<text>"
The string entered for <text> defines the M code
(number of integer places).&d stands for the
digit that defines the M code in the aperture list.

121 : "<text>%d<text>"
The string entered for <text> defines the N code
(number of decimal places).&d stands for the
digit that defines the N code in the aperture list.

122 : "<text>%1d.%1d<text>"

The string entered for <text> defines the M.N
code (number of integer and decimal places).
The first variable &1d stands for the digit that
defines the M code in the aperture list. The sec-
ond variable &1d stands for the digit that defines
the N code in the aperture list.
Coordinate zeroes

130 : "<text>"
The string entered for <text> defines the coor-
dinate zeroes as LEADING.(trailing sup-
pressed.)

131 : "<text>"
The string entered for <text> defines the coor-
dinate zeroes as TRAILING.(leading sup-
pressed.)

132 : "<text>"
The string entered for <text> defines the coor-
dinate zeroes as DECIMAL.

Example

Translation file:
APE_UNITS MM
APE_SCALE 0.01
CONFIGURATION ConfigGerber
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1,CC : "Aperture D%%  %a  %s  ROUND DRAW + FLASH"
1,CN : "Aperture D%%  %a  %s  ROUND DRAW"
1,NC : "Aperture D%%  %a  %s  ROUND FLASH"
1,QN : "Aperture D%%  %a  %s  SQUARE DRAW"
1,NQ : "Aperture D%%  %a  %s  SQUARE FLASH"
1,NR : "Aperture D%%  %a  %b  RECTANGLE FLASH"

101 : "scale in mm"
111 : "ASCII data absolute"
122 : "%d.%d digits"
131 : "use trailing zero"

Associated aperture list (part of the file):
┌──────────────────────────────┐

│ GERBER   PRODUCTION   INFO   │

└──────────────────────────────┘

ASCII Data absolute :
3,2 Digits m.n
Scale in mm
disable G - Codes
use trailing Zero
Blendenmaáe in 1/100 mm
APERTURE  CODE   WIDTH  LENGTH
APERTURE  D10     15     15  ROUND    DRAW + FLASH
APERTURE  D11     10     10  ROUND    DRAW
APERTURE  D12    100    100  ROUND    DRAW
APERTURE  D13    160    160  ROUND    FLASH
APERTURE  D14    150    150  ROUND    FLASH
APERTURE  D15     20     20  ROUND    DRAW
APERTURE  D16     90     90  ROUND    FLASH
APERTURE  D17    320    320  ROUND    FLASH
APERTURE  D18     70     70  ROUND    DRAW
APERTURE  D19    100    100  SQUARE   DRAW
APERTURE  D20     10     10  ROUND    FLASH
APERTURE  D21     40     40  ROUND    DRAW
APERTURE  D22    232    232  SQUARE   FLASH
APERTURE  D23    120    120  ROUND    FLASH
APERTURE  D24     50     50  ROUND    DRAW
APERTURE  D25    170    170  SQUARE   DRAW
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Aperture Template Editor
It was explained what a translation file is, and how to write it manually in the Aperture files
and templates (translation files) section. But it is not so easy to write a template file for
beginners. From the other hand, this process can’t be absolutely automated because only a user
can tell, which data are really needed from the aperture/tool file.
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A graphical Aperture Template Editor "ATE" is a tool to generate template files from aper-
ture files. The ATE can be used either as stand-alone application or called directly from the Cir-
cuitCAM when it is needed (the Template Editor button during standard aperture/tool list import
or selection-button Create a new translation file in Wizard import ----> TBD).

Figure 361. Main ATE window
There are some menu commands, and three toolbars around. The centre part shows an aper-
ture/tool file, for which the translation file is to be created. The template writing scenario in
outline is as follows:

n Select a needed tool-line (e.g.:, line "D10   Draw   Circle   20");

n Press a tool shape button (e.g.:, Circle);

n Select tool numbers (e.g.:, D10) and press D-code button;

n Select a tool dimension (e.g.:, 20) and press Argument-A button;

n Press Accept template line button while it is already enable - then the selected line
and all similar lines will be colored in grey. It means, that a template format for these
tools is generated;

n Repeat same actions for other (not colored) lines in the aperture/tool file;

n Press OK button after the editing of a template file is finished (or Cancel to eject). 

Shape & size toolbar

The toolbar contains buttons to code a tool.

Figure 362. ATE Shape&Size toolbar
10 first buttons correspond to all shapes of the tool, supported by CircuitCAM: circle, oval,
square, rectangle, rounded rectangle, bevelled rectangle, octagon, undefined, marker and spe-
cial.

- D-code: set tool number.
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Next four buttons Argument-A, Argument-B, Argument-C and Argument-D define the tool
size. Depending on what type was selected for the tool, these buttons have different look:

For shapes with one parameter (⊆ = diameter for circle and
octagon);
For shapes with one parameter (square, marker);
For shapes with two parameters (oval, rectangle);
For shapes with three parameters (rounded rectangle, bevel rec-
tangle);
For special apertures (up to four values).

- Embedded-Text: Includes the selected text into template format. It allows a user to use
more precise format. E.g.:, for both lines "D10   Draw   Circle   20" and "D13   Flash   Circle  
20" the template line "1,CC: "D%%  %s  %s  %a"" is valid. But the text "Draw" by using
Embedded-Text button is added for D10, the format line already will be "1,CC: "D%% 
Draw  %s  %a"" and do not fit for D13. To separate D10 and D21 needs to include text "Cir-
cle" additionally.

- Skips the selected text by adding it into the square brackets [ ].

- Cleans all selections (after the last pressing on only).

- Undo button.

- Accept template line: Enable state ( ) indicates that the format line is already ready
for usage. You still can update not specified fields (like texts with Embedded-Text button) or
already now press this Accept template line button. Tools (lines), which description cor-
responds to this template, will be made in grey.

Edit toolbar

Figure 363. ATE Edit toolbar
During creation of a template file, all generated lines are kept into combo box, where user can
edit them. It is allowed to add/write format lines manually as well. For this the button Ins
inserts (duplicates) the selected template line, Del - deletes the selected template line and Ovr
- overrides (Apply) the selected line after it is modified or written anew (buttons ).
Ovr function automatically scans a tool file for this new template line and marks recognised
lines in grey. Next group of buttons can be used to insert comment lines (Comment-
Characters button) add special key strings (Key-String and Required-String buttons). For
more information about comments and key strings see in Aperture files and templates clause.

Closing toolbar

To save the generated template into the specified file, press OK button in the Edit toolbar
(right-top corner of ATE window). After selection Yes into question "Template file was mod-
ified. Do you want to save changes?", the final dialogue box of Fixed parameters appears.
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Figure 364. ATE, Template Parameters' Setup dialogue window

Any needed changes for aperture/coordinate units, scaling, zeros mode and others, can be done
here. For more information see in Aperture files and templates clause.
Pressing on OK. The standard Save As…dialogue comes up to specify the location and name
of the template file. After this ATE window is closed and CircuitCAM returns into state where
ATE was called from.

Note:While ATE window is opened all operations on CircuitCAM are blocked.
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Barco-DPF
The current version of Barco-DPF command language is described in:
DPF Format Description, Version 5
November 1998

See also the BARCO-ETS web site
http://www.barco.com
http://194.7.253.113/ets/

Additional information can be found here:
http://www.maniabarco.com/transdown.asp

Units:
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U=unit

Defines the DPF-unit. The possible units are:

MM : millimetre (metric)

INCH : inch (imperial)

MIL : mil (thousandth of an inch)

Head Information:

Xmin,max

Minimum and maximum of job in x.

Is ignored.

Ymin,max

Minimum and maximum of job in y.

Is ignored.

Informational Data:

;anything

Rest of the line are COMMENTS.

A line is terminated by carriage return (CR) or a line feed (LF).

Pn=x,y

POINT "n" at position x,y. Is ignored.

Plot Data:

Fx,y

FLASH on position x,y.

Mx,y

MOVE to position x,y.

Dx,y

DRAW to position x,y.

Cx,y,mx,my[,i]

DRAW ARC from the current position to x,y.

The centre of the arc is mx,my.

"i" specifies the direction of the arc:

i = CW : clockwise direction

i = CCW : counter clockwise direction (default)

These Commands are Not Supported:

Vx,y,"text",width:space,fontname,(vector text expansion)[,options]

VECTOR TEXT

"x" and "y" are the start position of the first letter in the text.

"text" can be any string, just like in the normal DPF text aperture.

"width" is the horizontal offset between the staring points of two consecutive char-
acters, in this case it should be a mono-spaced font. If width is 0 then a "space"
parameter defines the white space between two characters.
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"fontname" is the name of the font (no pathnames allowed) and it is searched on
UFNTDIR. The vector text expansion section defines the actual draws of the text, so
that you don't need the font file to visualise the DPF file.

"options" are mirror, rotate and scale like for normal DPF apertures.

Nn[,name="value"]*

Netlist data:

"n" stands for net number.

"name" is a normal ASCII string, no special characters allowed.

"value" is an ASCII string.

If the value contains special characters (like';',','), the value should be declared between
double quotes.

Remarks

n The net number is modal.

n The netlist data is generated automatically by the netlist generation program or
the design rule check program.

Gn[,options]*

Group data:

"n" stands for group number.

"options" are the same as for netlist data.

Aperture Definitions:

Aa [ =def [,options ]]

Selects an aperture with a number "a". The number "a" is a positive number.

If "=def" is specified, the aperture is (re) defined. Options can only be specified when a
definition is specified.

Possible definitions are:

n Circle aperture

C*IRCLE,d

"d" indicates the diameter of the circle.

n Square aperture

S*QUARE,s

"s" indicates the size of the square.

n Rectangle aperture

R*ECTANGLE,sx,sy

"sx" indicates the size of the rectangle x-direction.

"sy" indicates the size of the rectangle y-direction.

n Donut aperture

D*ONUT,douter,dinner,kind

"douter" indicates the outer diameter of the donut.

"dinner" indicates the inner diameter of the donut.

"kind" indicates the type of the donut:

rr  (round donut)
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ss  (square donut)

sr  (square-round donut)

n Box aperture

BO*X,sx,sy,corners=xcutoff[:ycutoff]

"sx" indicates the size of the box in x-direction.

"sy" indicates the size of the box in y-direction.

"corners" indicates the shape of the corners of the box: R*OUNDED,
S*TRAIGHT,A*NTIQUE or C*UT.

"xcutoff" indicates the size of the corners in x-dimension.

"ycutoff" indicates the size of the corners in y- dimension (defaults to xcu-
toff if not specified).

n Octagon aperture

OCTAGON,size

"size" indicates the size of the octagon.

n Thermal aperture

THE*RMAL,outer,inner,gap,ngap,startangle,kind

"outer"outer diameter (or size)

"inner"inner diameter (or size)

"gap"size of gap

"ngap"number of gaps

"startangle"angle of first gap in degrees

"kind"rr,rs,ss,sr (r=round and s=square)

n Text aperture

T*EXT,("text_string") [[ height ][ :width ]]

"text_string" indicates the string of text characters; note that the string must
be enclosed by quotation marks (").

1. if the string contains round brackets, enclose them within quotation
marks (").

2. if the string itself contains a quotation mark, specify it twice to dif-
ferentiate it from the start and stop quotation marks.

"height" indicates the text width.

The width of the text defaults to 84.21% of the text height. That means - in
case no text width is specified 84.21% of the text height is assumed.

n Contour aperture

CO*NTOUR [ ,ST*ROKE=st ]

A contour aperture is considered as a pen with size 0. This aperture is used
to draw contour lines. After the selection of a contour aperture you can add
an enumeration of contours described by means of move, draw and arc. If
there is an overlap of two contours, the common zone is masked out (white).

You can add the option "stroke" which results in a contour with a solid line
on the top of the contour. The stroke value is the width of this line.

n Complex aperture
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COM*PLEX,cdef

The definition of the complex aperture can be specified as:

1. Enumeration of contours: < cdef > == ( < contour > [ < contour > ... ] )<
contour > == Mx0,y0Dx1,y1...Dxn,ynDx0,y0Contour lines are defined
by normal DPF-commands: move, draw and arc. Each move defines the
start point of a contour; draw and arc define the other points of the con-
tour.

2. Keyword A followed by an aperture number of another complex aper-
ture: < cdef > == Ac"c" is the aperture number of the complex aperture.

n Block aperture

B*LOCK,blockdef

The definition of the block can be specified as:

1. Enumeration of DPF-commands enclosed between round brackets: <
blockdef > == (DPF-commands)

2. Keyword A followed by the aperture number of another block: < block-
def > == Ab"b" is the aperture number of the complex block

Remark:
All apertures (except contours) can be flashed. Circle, donut, square and rectangle apertures
can be used to draw lines and arcs.

Aperture Options

Options are separated by commas. Possible options are:

M*IRROR=m

m=X: to mirror along the x-axis.

m=Y: to mirror along the y-axis.

m=XY: to mirror along both x- and y-axes.

R*OTATION=r

"r" is an angle specified in degrees. A positive value indicates a counter clockwise rota-
tion; a negative value indicates a clockwise rotation.

S*CALE=s

"s" is a scale factor.

RE*VERSE

Plots white on back.

Aperture Options Which are Not Supported:

P*ATTERN=type [ :step [ :width ]]

type=V : vertical bars

type=H : horizontal bars

type=VH : both horizontal and vertical bars

type=L : diagonal bars with a top on the left

type=R : diagonal bars with a top on the right

type=LR : both left and right diagonal bars

type=C45 : 45 degrees circular dot pattern
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type=C90 : 90 degrees circular dot pattern

type=B : 90 degrees square dot pattern

"step" indicates a distance between two units (the default step is 10 mil)

"width" indicates a width of the unit (the default width is 5 mil).

A*TTRIBUTES=(name="value"[,name="value"[..]])

N*AME="value"
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CAM
The native CircuitCAMformat, CAM files are made to store the 2D graphic information of bare
PCBs. The following options are realized for CircuitCAM:

n Characteristics of plotters, milling, and drilling machines needed for PCB-production,
together with their tools/apertures and converters to/from these formats: Gerber, Excel-
lon, HP-GL, Sieb&Meyer, PostScript, IEC1182 (IPC-D350D).

n Basis graphic objects: circle, rectangle, path, closed-path, polygon with line- and cir-
cular arc-segments.

n Specification of the corner and end-type round, truncate, extend and a width for path
and closed-path.

n Complex graphic objects made from basis or other complex objects.

n Business information about the user, organization, time etc.

n Binary exchange format by default.

n Optional ASCII-exchange files with compression.

n Hierarchy structures of a main- and sub-layout.

n Differentiate between fabricated layers and logical levels.

n Support for the design-level and derived-level.

n Set operations union, difference, intersection and inverse on levels.

n Specification of the layer-structure and passages through them (via).

n Classification of electrical (DC) and dielectric layers.

n Support for physical nets and sub-nets.

The following options are outside the scope of the CAM format:

n Material characteristics of layers.

n External components soldered onto the PCB.

n Assembly of external components to the PCB.

n Hierarchy structures of mother- and daughter-board.

n Wiring.
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CAT
CircuitCAM template files have the same internal format as CAM files, but have the file exten-
sion ".cat". The purpose of CAT files is to provide default layers, configurations, pads, tools,
default jobs, etc., but usually no graphics. So the main layout is empty.
For example, if you use the same aperture and tool list regularly, you can create a template
file, which contains both lists. You will not need to import aperture and tool lists again for new
circuit boards.
Each CAM file is based on a CAT file. The name of this CAT file is kept in the Info section of
the CAM file. you can see this in the properties view of the CAM file

Figure 365. Properties of a CAM file, referring to the underlying CAT file.
In the case the underlying CAT file of a CAM file has changed, the CAM file can be updated
for the changes in the CAT file with the synchronize command.
Available template files are listed in the New submenu of the File menu.

Figure 366. File -> New menu item and list of templates

The default_insulate.cat file is used by any unspecified new operation, e.g.: when CircuitCAM
starts. The default CAT file is defined in the General Settings dialogue window, Default Tem-
plate Name field of the Directories page.
New CAT files are stored in a special sub-directory indicated in the General Settings dialogue
window, New Template Directory field of the Directories page.
To save the existing CAT file or to create a new one, select Save As from the File menu and
choose the Template (*.cat) line from the Save as type field:

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
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Figure 367. Save As dialogue window to save CAT files
During the Save of an actual document as a CAT file, the General settings are automatically
stored in the CAT file.
Pressing on the OK in the General Settings dialogue writes the General and Unit\Grid infor-
mation into underlying CAT file. The file name is taken from the active document. If there is
no any active document, this information is saved into default_insulate.cat file.
During the Open of a CAT file, some General settings assignments are reset according to
values of the CAT file. If CAT file does not have these data, then no changes are made. User
Information and Directories pages of the General settings will not be changed because the
CAT file does not keep such data.

Note: Any changes in General settings dialogues are automatically stored into the
Underlying CAT file. If the current CAM file was created on other PC, the saving may be not
possible because of different paths to the CAT file. In such case the warning massage “Invalid
name of underlying CAT file. General Settings Assignments are not saved” comes up.

When CircuitCAM is running and any document is closed or any CAM file(s) is opened, Gen-
eral settings and Unit\Grid information are neither changed, nor saved.

Note:When CircuitCAM starts (with or without any CAM file), General settings and
Unit\Grid information are retrieved and set from the registry.
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DXF
See the DXF - AutoCAD™ documentation at http://www.autodesk.com/techpubs/autocad/dxf/.
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Only the 2D geometry in DXF files is supported (not 3D).
Supported DXF versions are:

l AutoCAD 2000 DXF Reference - v.u15.0.02 ,

l AutoCAD Release 14 DXF Reference - v.u14.1.04.
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EESOF
EESof is an EDA System for High Frequency applications from Agilent Technologies, see
http://we.home.agilent.com/.
The Mask Files (extension.msk) can be imported into CircuitCAM.
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Excellon
Speaking of the Excellon format usually mean the part programming codes of the CNC-2, 4, 5,
6, or 7 Excellon machines. The actual CNC-7 documentation is available at http://ww-
w.excellon.com.
There are two slightly different command structures (format 1 and format 2) for Excellon mill-
ing and drilling machines. Since CircuitCAM does not support all Excellon commands, there
are no differences for these formats except the occasional switchover from mill to drill oper-
ation.
The length details in Excellon data (X, Y, A) are given without any decimal point in inches or
in millimetres with various digits after the decimal point. Either leading or trailing zeros are
also output. Length details can be absolute or incremental. The precise coordinate format is set
with the Gerber/Excellon dialogue box, also see excellon format properties dialogue.

Reading Production Data:

A... Radius for arcs.
F... Milling speed; is ignored
G00 Enable milling operation.
G01 Straight milling.
G02, G03 Mill arc clockwise, anti-clockwise.
G81 Switches the machine from mill to drill operation, format.
G05 Switches the machine from drill to mill operation, format 2..
G90 Absolute operating mode.
G91 Incremental operating mode.
G40, G41,
G42 Compensation.

G93 Zero point.
G... Other G commands produce a warning message.
M48...% Program header.

The Following Commands are Supported in Program Header (Until %):

Tnn[Cr]
Tool selection:

l nn – aperture number

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
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l C – aperture circle

l r – diameter
Sample:
T05C0.059055
Circular tool, nn=05, diameter r = 0.059055

INCH[,{LZ,TZ}]

Specify metric units for the plot data.

l LZ – leading zeroes omitted

l TZ – trailing zeroes omitted

METRIC[,{LZ,TZ}]

Specify metric units for the plot data.

l LZ – leading zeroes omitted

l TZ – trailing zeroes omitted

FM{L,T},n,m

Format statement.

l L – leading zeroes omitted

l T – trailing zeroes omitted

l n – N format

l m – M format
M71, M72 Imperial or metric length details.
M25 Start of step and repeat.
M01 End of Step and Repeat macro.

M02XY[M70,M80,M90]

Macro offset.

l X,Y – offset values

l M70 – swapping of X and Y axes: X become value
Y and vice versa

l M80 – mirror image of X value: +X becomes –X

l M90 - mirror image of Y value: +Y becomes –Y
M08 End of Step and Repeat.
M0, M6, M9, M15, M16,
M17, M30, M47 Is ignored.

M... Other M commands generate a warning message.
S Spindle speed (rpm), is ignored.

R# Repeat hole (both forms R#X#Y# and X#Y#R# are sup-
ported).

X...Y... Coordinate details.
/, % Read past block to line end.
Line end End of a command unit.

Writing Production Data:

Start:

%

M70 or M71

G90 or G91
Tool selection and com-
pensation index: T#(#)

Start of a path: G01X...Y...M15
Line segment: G01X...Y...
Arc segment: 1. Arc Radius mode A#:
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G02 or G03 and then X#Y#A#

2. Arc Centre Offset mode I#J#:

G02 or G03 and then X#Y#I#J#

End of a path:
M17

G00

Flashing a tool:
perhaps, G05 to switch back from mill operation to drill
operation;
perhaps, T... to select another tool X...Y...

End: M30
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G-code
Common used numerical control (NC) programming language that is used in automation, it is
part of the computer aided engineering used for the 3-6 axes CNC machines. It is a basic lan-
guage which is defined by set of instruction (see below) according to the standard ISO-6983
that tells the machine where to move, which path and with what speed.

Example:
See G-Code Format Properties Dialogue for the example setup
This example shows a sample of the generated text for the G-Code file.

Figure 368. Example of drawn PCB.
This is what the ".NC" file look like according to standard ISO-6983 :
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Figure 369. G-Code example.
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Gerber X

The Extended Gerber format also called Gerber X carries addition information, which is miss-
ing in the simple Gerber format. The main important information is a complete definition of
apertures (see AD and AM commands below). In addition it may contain information about
layer name and the polarity of layers.
For further information see http://en.wikipedia.org/wiki/Gerber_format.
AD and AM commands:

%ADDnnMacro[,P1XP2XP3...]* %
Mass format macro aperture definition:
nn – aperture number

(370)           Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights
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Macro – the name of macro that must be previously
described by an AM command.
P1, P2, P3... – macro parameters.

%AMMacro*type, on/off, $1,$2...*
%

Mass format macro definition:
Macro – the name of macro
type – one of the seven primitives listed in Table C – 2
on/off – 1=ON (laser on, film exposed)

0=OFF (laser off, no exposure)
$1,$2,$3 – are position indicators and should be num-
bered sequentially in the order that the macro expects
the values to appear in the AD command. Parameters
are separated by X in the AD command.

%ASA{X,Y}B{X,Y}* %

Mass format axis select:
A{X,Y} – assign plot data coordinates to the plotter A
axe
B{X,Y} – assign plot data coordinates to the plotter B
axe.
default:  AXBY
also supported:  AYBX.

% IN Name* %

Mass format for image name:
Name – the name of image.
The command will generate message into the report
window.

% IOA±mB±n* %

Mass format image offset:

A±m – X offset value ±m
B±n  – Y offset value ±n.

% IR rotation* %
Mass format image rotation:
rotation – 0, 90, 180 or 270.

% LN Name* %

Mass format Layer Name:
Name – the name to be assigned to the layer.
If one LN command is used, the name from Import Dia-
logue Box is taken.
If few LN commands are used, a few layers are
created with the names supported by LN commands.

%MIA{0,1}B{0,1}* %

Mirror Image:
A{0,1} – mirror feature for data on the plotter A axis
(0 – disables, 1 – enables).
B{0,1} – mirror feature for data on the plotter B axis
(0 – disables, 1 – enables).

%MO{IN,MM}* %

Mass format specifies the units of the plot data:
IN – English units
MM – metric units.

% SFAnBn* %

Mass format Scale Factor:
An – scale factor for the plotter A-axis
Bn – scale factor for the plotter B-axis
Command SF enables you to specify, independently,
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scale factors for
the plotter A and B axes.

% SR[X count][Y count][I incre-
ment][J increment]

Mass format Step and Repeat:
X count – number of times to repeat the image in the X
axis
Y count – number of times to repeat the image in the Y
axis
I increment – distance in inches or millimetres between
the lower left corner of original/source object and the
lower left corner of newly created (repeated) object.
Distance is measured parallel to X axis.
J increment – distance in inches or millimetres between
the lower left corner of original/source object and the
lower left corner of newly created (repeated) object.
Distance is measured parallel to Y axis.
The image is created as one flash.
This flash is plotted according to SR parameter.
RULES for SR commands with LN and LPD/LPC: ( 
2001-11-27):

1. A new SR block is started only with SR, which
either number of repetition on X or on Y  is
greater than 1.If there are a few SR in the
sequence, only the last SR starts the next repe-
tition block. All SR in between are ignored.

2. The SR block is ended with:

a. SR command SR*%;

b. any new SR command:

if a new SR has at least one number of
repetition > 1;

if starts a new SR block (it goes from the
rule (1));

c. M02 command;

d. end-of-file.

3. LN (Layer Name) does not end SR, but all next
objects will be repeated on other layer.

% LPD*%
Layer Polarity Dark (default value) applies to all data
following the LP parameter until another LP parameter
is encountered.

% LPC*%
Layer Polarity clear (opposite parameter to LPD)
applies to all data following the LP parameter until
another LP parameter is encountered.

%OFA6nB6n*%
Offset the final image along X and Y axis. Default: 
%OFA0B0+%

The Following Commands are Not Supported:

AA (Aperture Assignment)
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AF (Auto Forms)
AP (Aperture Offset)
AR (Aperture Record)
AV (Aperture Velocity)
BD (Block Delete)
DL (Dash Line Specification)
IC (Input Code)
ID (Input Display)
IF (Include File)
IJ (Image Justify)
IPNEG (Image Polarity Negative)
KO (Knockout)
LS (Load Symbol)
NS, NF (Sequence Numbers)
OP (Optimal Stop)
PE (Perspective)
PF (Film Type)
PK (Park)
PO (Pen Offset)
RC (Rotate Symbol)
RO (Rotate Position Data)
SC (Single Step Mode)
SM (Symbol Mirroring)
SS (Symbol Scaling)
TR (Translation)
VL (Velocity Limit)
WI (Window Specification)

At Gerber(X) File Output, The Following Commands are Used:
Format statement; leading zeroes suppressed, absolute Coordinate values:

Configuration: %FS{L, T, D}{A, I}Xn,m*%
Units: %MO{IN,MM}* %
Layer name: % LN Name* %

Apertures definition:

%ADDnn{C, R, O, P} value1[X value2]*%

% AMMacro*type, on/off, $1,$2...* %

% ADDnnMacro [,P1XP2XP3...]* %
Tool selection: G54D..* or just D..* if the G-Code is disabled.
Start of a path: X...Y...D02*
Line segment: X...Y...D01*

Arc segment:

G75*

G02* or G03*

X...Y...I...J...D01*

G74*

G01*
End of a path: not applicable
Tool flash: X...Y...D03*
Filling of a Polygon
Area:

G36*

X...Y...D02*
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X...Y...D01*

. . .

G37*
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Gerber
The precise syntax of the Gerber format is given in the
Gerber FORMATPlot Data Format Reference Book
Tel.: (203) 644-1551; FAX: (203) 649-7157
The actual documentation can be found by the link:
http://www.maniabarco.com/transdown.asp
Gerber files can come in many forms, in theory. In practice, however, only a few forms are
possible for PCBs which are also supported by CircuitCAM.
In this way, only the word address format with ASCII coding can be edited. The other codes
(EIA RS-244-B, BCD, EDBCDIC, ISO and ASCII) and the binary format are not supported.
Also some commands of the Extended Gerber Format (Mass Parameter, Extended RS-274-D)
are supported. A typical Gerber file could be as follows:

G54D20* Tool 20 is selected.
G01X01Y00D01* A straight line is drawn to position x=1, y=0.
G54D10* Tool 10 is selected
D03* With this tool, there is a flash to the current position (flash).

G01X-1Y00D02* The current tool is moved to position x=0, y=0. In this case X-Y
data is incremental values

D03* The tool is flashed at the current position
Gerber files are divided into data blocks, which ends with "*" and in some cases with "$" too.
A simple line end is not considered the end of a data block; it may even be that a line end inter-
rupts coordinate data.
A data block can consist of commands N, G, X, Y, Z, I, J, K, W, C, T, U, V, D, M, in each
case followed by a number.

The Following Commands are Supported:
N nn Continuous numbering of data blocks is ignored.
G01, G10, G11, G12, G60 Line interpolation.
G02, G20, G21 Arc interpolation in clockwise direction.
G03, G30, G31 Arc interpolation in counter-clockwise direction.
G04 Commentary; is ignored to line end.
G36, G37 Filling of a Polygon Area.
G54 Tool selection. Is ignored.
G70 Coordinates are in inches.
G71 Coordinates are in millimetres

G74, G75
360 degree circle interpolation enabled and disabled. If
G74 is disabled, arcs to a maximum of 90 degrees only
can be described.

G90 Coordinates are given in absolute values
G91 Coordinates are given in relative (incremental) values
G55 Is ignored.
G-other codes There is an error message.
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Xm.n, Ym.n Coordinates in M.N format.
Im.n, Jm.n Centre point coordinates of an arc in M.N format.
D0 Is ignored.
D01 Enable tool.
D02 Disable tool.
D03 Flash tool.
D10-unlimited Select tool 10 to unlimited
D-other codes There is an error message
Z,K,W,U,V Not supported. There is an error message.
M0, M01, M03, M30 Are ignored.
M02 End of the file. Is ignored.
M-other codes There is an error message.
% Commentary; is ignored to line end

%FS{L, T, D}{A, I}{X,Y}n,
m*%

Mass format command to set:
L - leading zeroes suppressed
T - trailing zeroes suppressed
D - explicit decimal point
A - absolute coordinate values
R - relative coordinate values
X,Y – leading/trailing zeroes format (one for both X and
Y)
n -format N
m – format M

%ADDnn{C, R, O, P}
value1[X value2]*%

Mass format aperture definition:
nn - aperture number
C - Circle, diameter
R - Rectangle, width, height
O - Oval, width, height
P - Polygon, diameter, size

Also see Gerber format properties dialogue
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HP-GL
Hewlett Packard developed the HP-GL command language for its pen plotters. Later, it was
taken on by other plotter manufacturers and has today become the standard for pen plotters.
The current version of this command language is described in:

The HP-GL / 2 Reference Guide
a handbook for program developers
Hewlett-Packard Company, 1990
ISBN 0-201-56308-8
Addison-Wesley Publishing Company, Inc
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The number of available commands has constantly increased over time and today fills a whole
book. Almost all systems have restricted themselves to a few commands, which can also be
imported by CircuitCAM. This is done due to the reason that available plotters may support
only minimal set of commands.

SP n
Select Pen number n; valid values for n are 1 to 9 and 0.
Value 0 means put down one pen without taking a new
one.

PD Pen Down - head down on paper.
PU Pen Up - head up, away from paper.
PA { x, y} Plot Absolute - move to the given absolute positions x,y.
PR { x, y} Plot Relative - move to the given relative positions x,y.

AA x, y, a (, c)

Arc Absolute - draw an arc out from the current position
with Centre point x,y and angle a. A value of 360 forms
a full circle. With negative a values, the circle is drawn
in a clockwise direction and with positive values, in a
counter-clockwise direction. A chord angle C can also
be entered, which reduces a copy of the arc in line seg-
ments. CircuitCAM ignores this value.

AR x, y, a (,c) Arc Relative - similar to AA but the Centre point is
given relative to the current position.

AT xBulge, yBulge, xEnd,
yEnd, (c)

Absolute arc through 3 points: Current position, bulge
point and end point. A chord angle c can also be entered,
which produces a copy of the arc in line segments. Cir-
cuitCAM ignores this value

RT xBulge, yBulge, xEnd,
yEnd, (c)

Relative arc through 3 points: Current position, bulge
point and end point. A chord angle c can also be entered,
which produces a copy of the arc in line segments. Cir-
cuitCAM ignores this value

CI r (,c)
Circle - a complete circle is drawn around the current
position, which forms the Centre point. The value r
defines the radius.

EA x, y
Frame of an absolute rectangle. It is defined by two dia-
gonals opposite corner points: the current position and
the given absolute x,y position.

ER x, y
Frame of a relative rectangle. It is defined by two dia-
gonals opposite corner points: the current position and
the given relative x,y position.

RA x, y
Filled absolute rectangle. It is defined by two diagonals
opposite corner points: the current position and the given
absolute x,y position.

RR x, y
Filled relative rectangle. It is defined by two diagonals
opposite corner points: the current position and the given
relative x,y position.

FT fill_type
Filling type for areas (rectangles). Only the solid types 1
and 2 are supported, otherwise an error message is per-
formed.

LT Line Type. No parameter allowed for the continuous
line, otherwise an error message is given.

DF Default Values
IN Initialize
PW In this case the pen width is set to 0.35 mm.

PW width The Path width is set to the provided width. The value of
width is an integer number from 1 to 10.
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PW width, pen The Path width is set to the provided width. The pen
information is ignored.

BL, CA, CJ, CT, DJ, DT,
FS, IW, LT, NP, PT, PC,
PG, PS, SA, SL, VS and the
ESC symbol

All this data is ignored.

All other commands An error message is generated.

If your CAD system should use a command, which is not listed, then please ascertain the mean-
ing of the command. It could be an initialisation, a page selection or such like which is irrel-
evant to CircuitCAM. However, if important information lies behind the command, with the
result that the data input is incomplete, then please try to generate simpler HP-GL data with
your system.

The Following Commands are Used for HP-GL File Output:
Tool selection SP ...;
Path width PW ...;
Start a path PA ..., ...; PD;
Line segment PR ..., ...;

Arc segment
AR ..., ..., ...;

PA ..., ...;
End of a path PU;
Tool flash PA ..., ...; PD; PU;
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ISO 10303-210
ISO 10303 is the International Standard for Product data representation and exchange. AP210
of STEP is the Application Protocol for Electronic assembly, interconnect and packaging
design. CircuitCAM data can be converted to STEP-AP210 data, using IDA-STEP.
For more information and links see http://www.ida-step.net/components/import/circuitcam.
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Laser Mill Drill (LMD1)
LMD is a proprietary format in binary form. Its only purpose is to have an optimal connection
from CircuitCAM to BoardMaster to drive the mill/drill plotter. This format is used to Export
CircuitCAM data and Import from LMD to CircuitCAM format. The default file extension for
the format is "*.LMD".
An LMD-file is split into several Phase. A phase contains information for one manufacturing
step of one or more CircuitCAM-layers. By default the following phases are supported:

n DrillingPlated: Drilling information for plated through holes.

n DrillingUnPlated: Drilling information for unplated holes.

n MillingCompSide: Milling information for the component side.

n MillingSoldSide: Milling information for the solder side.

1Laser, Milling, Drilling

Copyright © DCT Co.,Ltd, since 2014 (LKSoftWare GmbH, 1992-2013). All Rights Reserved
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n RuboutCompSide: Further milling information for the component side.

n RuboutSoldSide: Further milling information for the solder side.

n Cutting: Milling or cutting the board frame.

Format Specification

LMD files have a binary format, it means that you can’t look to them with a usual text-editor.
Possible tools to “see” the contents of an LMD file are BoardMaster and CircuitCAM (re-
importing). In case you intend to write your own application to process LMD files, the binary
format specification is given here for the C programming language.

Note: that the specification may change for future versions of CircuitCAM and Board-
Master.

//-------------- Basis Type Definition ---------------

#define LMD_BLOCK_END 0

#define LMD_BYTE      1 // + unsigned 8-bit value

#define LMD_SHORT    2 // + signed 16bit integer

#define LMD_INT       3 // + signed 32 bit integer

#define LMD_LONG      4 // + signed 64bit Integer

#define LMD_FLOAT     5 // + 32bit real

#define LMD_DOUBLE    6 // + 64bit real

#define LMD_SSTRING   7 // + 0-terminated single-byte string

#define LMD_DSTRING   8 // + 0-terminated double-byte string
(unicode)

#define LMD_BINARY1   9 // + 1byte(=n) + (n/8)bytes;  (n==no.of
bits,round up)

#define LMD_BINARY4   10 // + 4bytes(=n) + (n/8)bytes;
(n==no.of bits,round up)

//-------------- Extended Type Definition ---------------

#define LMD_TYPE_DEF 11 // + byte(=new-type) + int (=parameter_
size)

//-------------- Extended Types -------------------------

//- All commands from 12 to 127 are reserved for extended types

//- All extended types have a fixed length (command + param-
eter_size)

//-------------- Predefine Extended Types ---------------

#define LMD_MOVE        12  // + float(=x) + float(=y)

#define LMD_DRAW        13  // + float(=x) + float(=y)

#define LMD_CIRCLE      14  // + float(=x) + float(=y) + float
(=r; r>0 CCW)
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// not used for V3.0 but maybe in
future

#define LMD_DRILL       15  // + float(=x) + float(=y)

#define LMD_TOOL_SELECT 16  // + int(=iTool)

#define LMD_ARC         17  // + float(cx)+float(cy)+float(ex)
+float(ey)+float(r)

// draw arc 0..+-355 degree.

// If start and end points are the same,

// draw a 360 degree circle

// ********* Scanner head extended types *********

// scanner head has its window (box), defined by points

// (-xmax,-ymax) and (xmax,ymax).

// Origin of the head is at (0,0)

// Position of the head is the point at which the origin (0,0)
is placed

#define LMD_HEAD_BOX    18  // + float(=xmax) + float(=ymax)

#define LMD_HEAD_POS    19  // + float(=x) + float(=y)

#define LMD_HEAD_NONE   20  // head position undefined, do not
use head

// for subsequent data

/**    2001-03-10

The scanner box sizes in LMD are now defined as full size; the
real scanner

window min and max corners are defined as follows :

lower left point (xpos - xbox/2, ypos-ybox/2)

upper right point (xpos-xbox/2, ypos+ybox/2)

where

xpos,ypos  is defined by LMD_SCANNER_POS

xbox,ybox  is defined by LMD_SCANNER_BOX

*/

// extension for 3D movements (2D+Height = 2.5D    2002-09-19

#define LMD_MOVE3D      21  // + float(=x) + float(=y) + float
(=z)

#define LMD_DRAW3D      22  // + float(=x) + float(=y) + float
(=z)

#define LMD_CIRCLE3D    23  // + float(=x) + float(=y) + float
(=z) + float(=r; r>0 CCW)

#define LMD_ARC3D       24  // + float(cx)+float(cy)+float(z)
+float(ex)+float(ey)+ float(ez)+float(r)

// draw arc 0..+-355 degree.

#define LMD_DRILL3D     25  // + float(=x) + float(=y) + float
(=z)
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#define LMD_MACRO_DEF   26  // + int(=macro-number-def, start-
ing with 1, 2 ...n )

//   + path + LMD_MACRO_END

#define LMD_MACRO_END   27

#define LMD_MACRO_CALL  28  // + int(=macro-number-ref, start-
ing with 1, 2 ...n )

//   + float(=x) + float(=y), off-
set values

/**

-------------- Block Types ---------------------------

- All commands from 128 to 255 are reserved for block types

- A block is terminated by LMD_BLOCK_END

- Blocks can be nested and have variable length

- Elements in the block are identified by the position in

the block. Order of elements in the block can not be

changed. New elements can be added just before end of

the block. Elements, which are not used any more, must
still

be present.

*/

//   -------------- Predefined Block Types -------------------

#define LMD_TOOL     128

//   + LMD_INT iTool for use in LMD_TOOL_SELECT

//   + LMD_BYTE for mode: 0:draw, 1=flash 2=flash+draw

//   + LMD_FLOAT: width

//   + LMD_SSTRING: tool-name

#define LMD_PHASE_HEADER   129

//   + LMD_SSTRING: phase-name

//   + LMD_SSTRING: layer-name

#define LMD_PHASE    130

//   + LMD_PHASE_HEADER()

//   + LMD_TOOL  { LMD_TOOL }

//   + { LMD_TOOL_SELECT() { LMD_DRILL() | path }

//   path ::= LMD_MOVE() { [LMD_CIRCLE()] LMD_DRAW() };

//Please note that this structure may change in future ver-
sions.

/** 

-------------- File-Structure -------------------

file ::= header body;

header ::= "LMD_Mill_Drill Version 3." subversion "\n" { 
string "\n"}\032";

subversion ::= "0"; // for the here predefined extended and
block-types
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string ::= sequence of ASCII >= " "; user defined strings.
E.g:

"Generated by: CircuitCAM V3.0 (36)"

"Source-file: c:\...\Tutor.cam"

"OutputJob: MySpecialJob"

"User: Muster Meyer"

"Organization: My Company"

"SerialNumber: 979999:99"

"Timestamp: 1997 7 18 12 0 0"

Bmaster may display these strings somehow (Property
DlgBox?)

body ::= { LMD_TYPE_DEF() } { basic_type | block };

basic_type ::= 1..9

block ::= (128..255) { basic_type | block } LMD_BLOCK_END;

--------------- Recommendations ------------------

The order in which things to be written to the file:

0) header

1) all extended type definitions (including LMD_MOVE,

LMD_DRAW, LMD_CIRCLE, LMD_DRILL and LMD_TOOL_SELECT

according to the subversion "0").

2) all tool definitions (it is also possible that the tool

is defined somewhere in the file - but before it is

referenced).

2.1) the scanner head box definition LMD_HEAD_BOX (if used
later).

3) The LMD_PHASE

3.1) The LMD_PHASE_HEADER
3.2) Sequence of LMD_TOOL_SELECT, LMD_HEAD_POS, LMD_HEAD_NONE and

drill, move, draw, circle

How BMASTER will interprets the blocks:

a) After the header and some LMD_TYPE_DEF there are on the
primary

level only LMD_TOOL and LMD_PHASE.

All other types (block, extended or basic) are skipped.

b) Inside the LMD_PHASE BMaster will find the phase-attrib-
utes in

LMD_PHASE_HEADER followed by the geometry.

c) Always identify the Type:

If it is an unknown block-type, skip elements until
block end.

If it is an unknown extended-type, skip the number of

bytes defined by LMD_TYPE_DEF.
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If it is a basic-type which role is unclear at this posi-
tion skip it.

Interpretation of scanner head data:

The LMD_HEAD_BOX must be defined before first LMD_HEAD_POS
appears.

By default at the beginning the LMD_HEAD_NONE is active.
After the

LMD_HEAD_POS appears the drill, draw, arc and circle data
are interpreted

as follows:

- if they fit into scanner head box, they are done on
scanner head

- if they not fit into box they are skipped

For data that appears after the LMD_HEAD_NONE the scanner
head is not used.

They are performed by the usual head.

<End of LMD file description>--------------------------------

*/
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ODB++
ODB++ is a data format for PCB artwork from Valor Computerized Systems Ltd. The elec-
tronic documentation is available at http://www.valor.com/.
The actual supported version is 7.1.
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Sieb & Meyer
We refer below to the documentation:

S&M commands
Format 5000
Issue: May 1991
from:
Sieb & Meyer Elektronik GmbH
Auf dem Schmaarkamp 21
21339 Lüneburg, Germany.

Milling and drilling machines from Sieb&Meyer work in the S&M internal format or in the
Excellon 1 or 2 formats. We look below at the specific features of S&M format.
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The length details in Sieb&Meyer data (X, Y, R) are always given with decimal point in inches
or millimetres, thus e.g.:
X40. Y50. G2 R15. F1.2
If the decimal point should however be missing at input, then - as with Gerber data - there is a
switch to M.N format with leading or trailing zeros. For this reason, the Gerber/Excellon dia-
logue box is also used for the format specification.
At input and output, no milling radius compensation is supported.

Reading Production Data:
CircuitCAM processes the following commands at input:

F... Feed speed, is ignored.
G1 Straight milling.
G2, G3 Arc milling.
G90, G91 Coordinate absolute, relative
M48....% Commentary (not original Sieb & Meyer))
M... Other M commands are ignored.
R... Radius for arc.
T... Tool selection.
X..., Y... Coordinates
(....) Commentary
% Jump to line end.
Line end End of a command block

Writing Production Data:
The following commands are used at Sieb & Meyer file output:

Tool selection T...
Path start X...Y...T...T0
Line segment X...Y...G1

Arc segment
X...Y...G2R...

X...Y...G3R...
Path end: X...Y...T0
Tool flash: X...Y...

No milling speed (F...) is given since CircuitCAM does not have any information ready about
this
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Scripts
Scripts (Batch Jobs)
Script Tasks
Configurable Geometry Engine
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5. Hotkeys
The table below presents the list of predefined Hotkeys for CircuitCAM commands. The user
can modify, assign new hotkeys in General Settings dialogue window, Keyboard panel.

Category Function Hotkey Affects/Activates
General Help about current contents F1

Toggle between CircuitCAM
views

Ctrl + Tab
or

Alt + F7
Switch between open views Alt + F6

Zoom in
Page Up

or
Mouse Wheel Up

Cursor position

Zoom out
Page Down

or
Mouse Wheel Down

Cursor position

Remove item(s) Delete Selected item(s)
Cancel/interrupt current

operation Esc

Pan the graphic view; up,
down, left, and right

Cursor keys; up,
down, left, and right

Set Anchor Point Ctrl + Shift + Left
Click

Close Alt + F4 Active window

File menu New document, based on
default template Ctrl + N

Open Ctrl + O
Save Ctrl + S Active document
Print Ctrl + P Active document

Edit menu Undo Ctrl + Z
Redo Ctrl + Y
Cut Ctrl + X
Copy Ctrl + C
Paste Ctrl + V
Remove Delete

Move Selected Space
Duplicate Selected Ctrl + Space

Set Cursor Ctrl + Shift + C
Set Cursor to Zero Ctrl + Shift + 0
Set Anchor Point Ctrl + Shift + A

Anchor to Centre Point Ctrl + Shift + Z
Anchor to Mass Point Ctrl + Shift + M

Set Zero Point Ctrl + Shift + N
Move Layer to Zero Ctrl + Shift + L
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Category Function Hotkey Affects/Activates
Select menu Select All Ctrl + A

Select next object according
to sequence Ctrl + Shift + Right

Select previous object
according to sequence Ctrl + Shift + Left

Select first object according
to sequence Ctrl + Shift + Up

Select last object according
to sequence Ctrl + Shift + Down

Modify menu Add Point/Segment Ctrl + T
Cut Point/Segment Ctrl + U

Delete Point/Segment Ctrl + D
Move Point/Segment Ctrl + M
Create or Move Arc Ctrl + E

Combine Ctrl + B
Close Ctrl + Shift + Q

Path to Polygon Ctrl + Shift + P
Combine to Polygon Ctrl + K
Convert to Polygon Ctrl + Shift + Y

Convert to Closed Outline
Path Ctrl + Shift + W

Denest all Cutouts Ctrl + Shift + I
Denest single Cutout Shift + J
Convert to Circle Ctrl + Shift + K
Draw to Flash Ctrl + Shift + D

Convert to One Flash Ctrl + Shift + H
Compare Shape Ctrl + Shift + S

Compare Bounding Box Ctrl + Shift + B
Compare Outline Ctrl + Shift + T

Denest Flashes/Instances Ctrl + Shift + E
Size Modification Ctrl + Shift + U
Step and Repeat Ctrl + Shift + R

Create Bounding Shape Ctrl + Shift + G
Create Outline Ctrl + Shift + O
Perfect Shape Ctrl + Shift + V

NC/Tool path
menu Create gap Ctrl + G

Reverse Ctrl + R
Move to next Ctrl + J

Move to previous Ctrl + I
Move to first Ctrl + F
Move to last Ctrl + L

Analysis menu Measure Ctrl + Shift+ X

View menu Zoom Window Alt + draw box with
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Category Function Hotkey Affects/Activates
mouse

Zoom In
Page Up

or
Mouse Wheel Up

Zoom Out
Page Down

or
Mouse Wheel Down

Overview Home
Previous Insert
Refresh F5

Full Screen Ctrl + Shift + Enter
Properties Ctrl + Q
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6. Epilogue
At the end, the whole team behind CircuitCAM wishes that this was a helpful

tour around the program.
We really wish that CircuitCAM will comply with all your design-

ing/production needs.
Any suggestions are more than welcome;

Please forward your notes to: info@lksoft.com
You are welcome to visit our website for more information.

http://www.circuitcam.com/
http://www.lksoft.com
www.dct-china.cn
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Glossary

A

ATE
Aperture Template Editor

B

BGA
Ball Grid Array

C

CAD
Computer Aided Design

CAM
Computer Aided Manufacturing

CSG
Constructive Solid Geometry

D

DIL / DIP
Dual in-line package
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DRC
Design Rule Check

DXF
AutoCAD text format

E

EMF
Enhanced Metafile for Windows

G

GMC
Geometry Manipulation Centre

L

LMD
Laser, Milling, Drilling

N

NC
Numerical Controled (machine)

P

PCB
Printed Circuit Board

PLCC
Plastic Leaded Chip Carrier

PNG
A bitmap image file format that supports lossless data compression

R

RF
Radio-frequency

S

SMD
Surface-mount devices
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SMT
Surface-mount technology

SOT
Small-outline transistor

STEP
STandard for the Exchange of Product model data, ISO 10303

W

WMF
Windows Metafile

Index

A

About 32
Activation; Offline 26
Activation; Online 22
Activation; Software Registration 21
Analysis; Menu 108
Anchor Point; Set Anchor Point 208
Aperture List 40
Aperture List; Examples 155
Arc 210
Area of Selected Objects 163
Area; Selection 203
ATE; Aperture Template Editor 356

B

Barco; Tools Properties 235
Barcode 218
Base Material 73, 339
Batch and Background Processing 167
Boolean Operations 187

Difference 188
Intersection 189
Paths off Area 193
Paths on Area 192
Union 188
XOR 191

Breakout Tabs 71
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C

CAM & CAT Documents 142, 364-365
Circle 175

Insert 210
Properties 199

Close; Exit Program 87
Configurable Geometry Engine 271
Context Menus

Graphic View 204
Jobs View 243
Layers View 224
Layouts View 294
Libraries 297
Tools View 230

Contour Routing 319
Convert to Circle 180
Copper Pouring 341
Create Gap 205
Create Package 299
Cursor; Set Cursor 208
Cutout 213

D

DataMatrix 343
Denest; Polygon Cutout 179
Denest; Polygon Cutout Hole 180
Directories; Installation 20
Directories; Settings 125
Diverse 234
Documents 111
DRC; Design Rule Check

PCB 347
Stencil 348

DXF; Tools Properties 235

E

Edit; Menu 96
Epilogue 387
Esc Key 141
Excellon; Import Assignments 47
Excellon; Tools Properties 232
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Export 152
Export Jobs 247
Export Layout Instance 153
Export Strategy 132
Export Tasks 250
Export Tasks Properties 251
Production Data 86

F

File Formats 350
Barco-DPF 359
CAM 364
CAT 365
DXF 366
EESOF 367
Excellon 367
G-code 369
Gerber 374
Gerber X 370
HP-GL 375
ISO 10303-210 377
LMD; Laser Mill Drill 377
ODB++ 382
Sieb & Meyer 382

File; Menu 95
Fixture Holes 339
Flash 175

Properties 200
Flash Attributes 237
Flash Rotations Toolbar 118
Fonts 218
Footprints 303
Footprints; Create 303
Full Screen Toolbar 118

G

G-Code; Tools Properties 235
General Settings 123
Gerber; Import Assignments 41
Gerber; Import Panel 149
Gerber; Tools Properties 374
GMC

Compare 314
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Glue Dots 312
GMC Toolbar 119
Library 315
Predefined Shapes 307
Shape Modification 309
Size Modification 311

GMC; Geometric Manipulation Centre 304
Graphic Manipulation

Add Point/Segment 176
Area of Selected Objects 163
Combine 177
Combine to Polygon 178
Compare Bounding Box 182
Compare Outline 183
Compare Shape 182
Convert to Closed Outline Path 179
Convert to Instance 182
Convert to One Flash 181
Convert to Polygon 178
Create Bounding Shape 184
Create or Move Arc 177
Create Outline 185
Cut Point/Segment 176
Delete Point/Segment 176
Denest Polygon Cutout 179
Denest Polygon Cutout Hole 180
Draw to Flash 180
Exchange with Flash 182
Move Point/Segment 177
Path to Polygon 177
Perfect Shape 186
Polygon to Path 187
Remove Holes 187
Step and Repeat 183

Graphic Objects 169
Graphic View 168
Grid/Unit Toolbar 117
Grid; Display Grid 170
Grid; Snap to Grid 170
GUI

Graphic View 168
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Main Menu 95
Analysis 108
Edit 96
File 95
Help 112
Insert 100
Library 106
Modify 102
NC/Tool Path 105
Select 98
Settings 108
View 110

Main User Interface 93
Message Log 122
Preview/World View 140
Properties Window 197
Status Bar 119
Toolbars 113

Flash Rotations Toolbar 118
Full Screen Toolbar 118
GMC Toolbar 119
Grid/Unit Toolbar 117
Insert Toolbar 115
Layer Toolbar 116
Relative Rotations Toolbar 118
Select Toolbar 114
Standard Toolbar 113
Zoom Toolbar 114

H

Help 139
Help; Menu 112
Holes; Remove Holes 187
Hotkeys 384
HP-GL; Tools Properties 234

I

IEC61182; Tools Properties 232
Import 146
Import; Assignments 89, 133
Import; Excellon Settings 129
Import; Extended Gerber 51
Import; Gerber Settings 128
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Import; Production Data 39, 146
Import; Simple Gerber 39
Insert

Arc 210
Cicle 210
Closed Path 212
Open Path 212
Pad 212
Polygon 214
Polygon Cutout 213
Rectangle 215
Rubout Area 215
Text 216

Insert Toolbar 115
Insert; Menu 100
Inserting Operations 209
Installation 20
Insulate Milling 323
Introduction 17

J

Jobs View 241
Context Menu 243
Toolbar 244

K

Keyboard Shortcuts 384
Keyboard Shortcuts; Customize 137

L

Laser Fill 79
Laser Insulate 81
Laser Scanner 317
Layer Properties 226
Layer Toolbar 116
Layers View 221
Layers View; Context Menu 224
Layers View; Toolbar 225
Layers; Active Layer 222
Layers; Move 57
Layers; Order 55
Layers; Rotate 60
Layouts View 293
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Layouts View; Context Menu 294
Layouts View; Toolbar 295
Libraries View 296
Libraries; Context Menu 297
Libraries; Library Components 297
Libraries; States of Libraries 297
Libraries; Toolbar 298
Libraries; Types of Libraries 296
Library; Menu 106
Line Drawing Modes 211
List Views 219
LMD 234

M

Main User Interface 93
Manipulation Operations 215
Markers 174
Measure 162
Message Log 122
Milling Contour 69
Milling Direction & Sequence 73
Modify; Menu 102
Mouse Precision 162

N

NC
I++NC Server 330
Machine Head 333
Machine Head Controls 338
NC Controls 334
NC Coordinates 337
NC Layers 332
NC Mode 329
NC Mode Layout 331

NC/Tool Path; Menu 105
New; Documents 145
New; Templates 145

O

Open; Documents 143

P

Package Recognition 302
Packages & Footprints 298
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Pad 212
Panning 172
Path

Properties 198
Perfect Shape 186
Pitch of Two Pads 162
Polygon

Insert 214
Properties 200

Polygon Cutout Hole; Denest 180
Polygon Cutout; Denest 179
Polygon; Polygon Operations 196
Postscript 233
Postscript Properties 233
Predefined Jobs; Default Template 35
Predefined Layers; Default Template 34
Predefined Libraries; Default Template 36
Predefined Tools; Default Template 35
Preview / World View 140
Print 156

Printer Calibration 159
Properties 197

Circle 199
Flash 200
Path 198
Polygon 200
Rectangle 199
Selection 201

Q

Quick Access 241

R

Rectangle 175
Insert 215
Properties 199

Relative Rotations Toolbar 118
Requirements; System Requriements 20
Reset; Layout 121
Reset; Settings 135
Reverse 205
Rotation & Mirroring 206
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Rubout Area 73
Insert 215

S

Save; Documents 151
Scaling 195
Scripts 261, 383

Add Script 262
Make Derived 267
Properties 263
Run Script 266
Script Commands 272
Script Tasks 268, 272

Select; Menu 98
Selection

Operations 346
Properties 201
Selection of Graphic Objects 202
Sequence 203
Single Object 202
Toolbar 114

Settings
Customize 135
General Settings 123
Menu 108
User Settings 31

Sieb & Meyer; Tools Properties 232
Size Modification 194
Size Modification Dialogue 194
Slection

Area 203
Standard Toolbar 113
Statistics 164
Status Bar 119
Stencil Frame Generator 244
Striping & Stripping 329
Swap Order 209
Synchronize 144

T

Template; Create Template File 87
Template; Synchronize Template File 144
Text 216
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Tool Compensation 318
Tool Edit Mode 240
Tool List; Translation File 45
Tool Path; Sequence 323
Toolbars 113
Toolbars; Customize 136
Tools 228
Tools List 232
Tools List; Properties 232
Tools Properties 236
Tools View 228

Context Menu 230
Toolbar 231

Transform; Export Transforms 255
Transform; Tools 238
Translation File 351
Translation File; Tool List 45
Tutor Example 36

U

Usage Guide 34
User; Information Panel 126

V

Variants; Program Variants & Releases 17
View; Menu 110
View; View Arrangement 120

Z

Zoom 170
In & Out 171
Preview/World View 140, 172
Previous Views 172
Selected 171
Toolbar 114
Zoom Window 171
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